IMPORTANT NOTICE

DISCLAIMER OF WARRANTY
Rational Software Corporation makes no representations or warranties, either express or implied, by or with respect to anything in this guide, and shall not be liable for any implied warranties of merchantability or fitness for a particular purpose or for any indirect, special or consequential damages.

COPYRIGHT NOTICE
Copyright © 1999 Rational Software Corporation. All rights reserved.

No part of this publication may be reproduced, stored in a retrieval system or transmitted, in any form or by any means, photocopying, recording or otherwise, without prior written consent of Rational Software Corporation. No patent liability is assumed with respect to the use of the information contained herein. While every precaution has been taken in the preparation of this book, Rational Software Corporation assumes no responsibility for errors or omissions. This publication and features described herein are subject to change without notice.

The program and information contained herein are licensed only pursuant to a license agreement that contains use, reverse engineering, disclosure and other restrictions; accordingly, it is “Unpublished — rights reserved under the copyright laws of the United States” for purposes of the FARs.

RESTRICTED RIGHTS LEGEND
Use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-7013(c)(1)(ii) (Oct 1988), FAR 12.212(a) 1995, FAR 52.227-19, or FAR 52.227-14, as applicable.

TRADEMARKS
Rational®, the Rational logo, Requisite®, ClearCase®, ClearQuest™, PureCoverage® Purify®, Quantify®, Rational Rose®, Rational Unified Process™, RequisitePro™, SoDA®, TestAccelerator™, TestFactory™, TestStudio™, Visual PureCoverage™, and Visual Qualify™ are trademarks or registered trademarks of Rational Software Corporation in the United States and in other countries. FLEXlm and GLOBE Trotter® are trademarks of GLOBE Trotter Software, Inc.

Microsoft, Windows, Windows NT, Microsoft Access, Visual Basic, Visual SourceSafe and Open Database Connectivity are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

All other products or services mentioned in this guide are covered by the trademarks, service marks, or product names as designated by the companies who market those products.

PATENTS
Rational is covered by one or more of U.S. Patent Nos. 5,193,180 and 5,335,344 and 5,535,329. Purify is licensed under Sun Microsystems Inc.’s U.S. Pat. No. 5,404,499. Other U.S. and foreign patents pending.

Printed in the U.S.A.
Contents

Preface

About this Manual ....................................................... xiii
Reading to Meet Your Needs ........................................ xiii
RequisitePro Conventions ........................................... xv
Using Online Help ..................................................... xvi
The Learning Project Tutorials ...................................... xvi
Rational Training and Consulting Services ....................... xvii
Contacting RequisitePro Technical Support ....................... xviii
  E-mail ............................................................... xix
  Telephone ......................................................... xix
Visit Our Web Site .................................................... xx

1 Fundamentals of Requirements Management

Applying Requirements Management ................................. 1-1
  Software and System Development in the Age of Process ...... 1-1
  Why Manage Requirements? ...................................... 1-2
  What is a Requirement? .......................................... 1-2
  What is Requirements Management? .............................. 1-3
  The Problems of Requirements Management .................. 1-4
  Requirements Management Skills ................................. 1-5
  Important Requirements Concepts ............................... 1-9
  Putting Requirements Management to Work .................... 1-12
Sources ............................................................... 1-15
Recommended Reading ............................................... 1-15

2 Overview: RequisitePro Concepts

Why Use RequisitePro? .............................................. 2-1
  Team Collaboration, User Satisfaction ......................... 2-1
  Change Happens – Manage it .................................... 2-2
Contents

Comprehensive Process Support .................................. 2-2
A Quick Tour of Key Concepts in RequisitePro ................. 2-2
  Requirement .................................................. 2-2
  Project ....................................................... 2-2
  Project Database ............................................. 2-3
  Project Version Control ....................................... 2-3
  Catalog ....................................................... 2-3
  The Tool Palette, Word Workplace, and Views Workplace ... 2-4
  Views ......................................................... 2-5
  Documents .................................................... 2-6
  Document Types and Requirement Types ....................... 2-7
  Requirement Attributes ....................................... 2-8
  Hierarchical Relationships ................................... 2-9
  Traceability Relationships ................................... 2-10
  Suspect Relationships ........................................ 2-11

3 Getting Started

  Launching RequisitePro ........................................ 3-1
  Using the RequisitePro Tool Palette ............................. 3-1
  Exiting RequisitePro ........................................... 3-2
  Using the Catalog ............................................. 3-3
    Adding a RequisitePro Project to Your Catalog ............. 3-3
    Removing a Project from the Catalog ......................... 3-4
  Using Projects ................................................ 3-5
    Opening a Project and Documents ............................ 3-5
    Closing a Project and Documents ............................ 3-6
    Accessing a Secure Project ................................ 3-8

4 Views

  Accessing Functions and Navigating in Views .................. 4-2
  Viewing Current Data ......................................... 4-2
  Traceability in the Views Workplace ........................... 4-3
  Hierarchy in the Views Workplace ............................... 4-3
5 Query and Search

Creating and Using Queried Views ................................. 5-1
Contents

Querying (Filtering and Sorting) Overview .............................................. 5-1
Working with Queries ................................................................. 5-2
Creating Queries ................................................................. 5-3

Searching for Requirements in the Database, Documents, and Views ...... 5-5
Using Go To to Search the Database for a Requirement ................. 5-6
Using Find Requirement to Search an Active Document or View .... 5-7
Shortcuts to a Document-Based Requirement from a View .......... 5-8
Reviewing a Project with Cross-Project Traceability .................. 5-8

6 Discussions

Understanding Discussions ............................................................. 6-1
Viewing Discussions ................................................................. 6-1
Responding to Discussions ......................................................... 6-1
Configuring E-mail for Discussions ........................................... 6-2
Creating Discussions ................................................................. 6-4
Viewing and Modifying Discussion Properties .............................. 6-6
Notifying Participants about a New Discussion .............................. 6-6
Reading Discussions ................................................................. 6-7
Responding to Discussions ........................................................... 6-8
Responding to Discussions in RequisitePro .................................. 6-8
Responding to Discussions Using E-mail .................................... 6-9
Displaying, Filtering, and Sorting Discussions ............................... 6-11
Displaying Discussions Associated with a Single Requirement ....... 6-11
Filtering Discussions .................................................................. 6-12
Sorting Discussions ................................................................. 6-14
Printing Discussions ................................................................. 6-14

Modifying Discussions ................................................................. 6-14
Viewing and Modifying Discussion Attributes .............................. 6-14
Creating and Modifying Discussion Participants Information ......... 6-15
Creating and Modifying a Discussion’s Requirement Information .... 6-17
Creating and Modifying a Requirement’s Discussion Information .... 6-19
Closing Discussions ................................................................. 6-20
Deleting Closed Discussions ....................................................... 6-20
7 Documents
Creating a Project Document .............................................. 7-1
Saving a Project Document ................................................. 7-2
Opening a Document After a Project is Open ....................... 7-3
Closing and Saving a Project Document .............................. 7-5
   Reviewing and Changes Before Closing a Document .......... 7-5
Changing the Location of a Project Document ...................... 7-6
Modifying Document Information ......................................... 7-7
Working With Microsoft Word ............................................. 7-7
   Saving a RequisitePro Document as a Word Document .... 7-7
   Managing Microsoft Word Documents ......................... 7-8
   Closing Microsoft Word ............................................. 7-8
Working With Documents Offline ........................................... 7-8
   Taking Documents Offline ........................................... 7-9
   Determining Whether a Document is Offline ...................... 7-9
   Modifying Offline Documents ....................................... 7-10
   Creating Requirements in Offline Documents ................. 7-10
   Deleting Requirements in Offline Documents ............... 7-11
   Bringing Offline Documents Back Online ....................... 7-12
   Bringing Documents Online Without Saving Changes ........ 7-13
   Reading Offline Documents ........................................ 7-14
   Using Word Master Documents ..................................... 7-15
8 Requirements
Creating Requirements ................................................... 8-1
   Creating a Requirement in a Document ......................... 8-2
   Creating a Requirement in the Database ....................... 8-7
Revising Requirements ................................................... 8-9
   Opening the Requirement Dialog Box ......................... 8-9
   Accessing Revision Information ................................. 8-10
   Recording Changes to Document-Based Requirements .... 8-11
Modifying Attribute Values ............................................... 8-12
Contents

Modifying Attribute Values from the Attribute Matrix ............... 8-12
Associating Requirements with New Types ............................ 8-13
Associating a Single Requirement with a New Type .................. 8-13
Associating Multiple Requirements with a New Type ............... 8-14
Relocating Requirements .............................................. 8-15
Cutting or Copying from a Document ................................ 8-15
Cutting or Copying from the Database ................................. 8-16
Rules for Relocating Requirements ................................. 8-17
Unmarking Requirements in a Document ............................... 8-18
Refreshing Requirement Color and Style in a Document ............... 8-19
Rebuilding Requirement Tags in a Document ......................... 8-19
Renumbering Requirements ........................................... 8-20

9 Hierarchical Relationships

Creating Child Requirements ............................................ 9-1
Creating Child Requirements in the Database ......................... 9-1
Creating Child Requirements in a Document ......................... 9-2
Creating Peer Requirements .......................................... 9-3
Changing Parent Requirements ........................................ 9-3
Assigning a New Parent to a Single Requirement .................... 9-3
Assigning a New Parent to Multiple Requirements .................. 9-6
Deleting Hierarchical Requirements ................................... 9-7
Suspect Relationships .................................................... 9-8
Displaying Suspect Hierarchical Relationships ....................... 9-8
Clearing Suspect Relationships ....................................... 9-9

10 Traceability Relationships

Creating Traceability in the Word Workplace ........................ 10-1
Creating a Traceability Relationship in a Requirements Document .. 10-2
Creating Traceability Using the Requirements Menu ................ 10-3
11 Import Wizard

Before You Begin .................................................. 11-1
Project Setup .................................................... 11-1
Import Logs ....................................................... 11-2
Importing Documents from Another RequisitePro Project ........ 11-2
About RequisitePro format .................................... 11-2
Converting All the Documents in a Project to Word .......... 11-3
Converting an Individual Document to Word .................. 11-4
Saving or Removing Bookmarks ............................. 11-4
Importing from Word ........................................... 11-5
Importing Word Documents and Requirements ................ 11-6
Importing a CSV File .......................................... 11-14
Requirement Numbers ......................................... 11-14
Preparing a CSV File for the Import Wizard .............. 11-15
Using the Import Wizard to Import a CSV File ........... 11-17
Exporting Requirements ....................................... 11-25
Exporting a View as a CSV File ............................. 11-25
Exporting a View as a Word Document ..................... 11-26

12 Project Creation

Creating a Project Using a Blank Project Database ............ 12-1
Recording Revision Information About the Project ........... 12-3
Creating a Project Using the Project Wizard .................. 12-4
Creating a Project Using an Existing Project as a Template 12-9
Converting RequisitePro Projects to the 4.0 Format ........ 12-10
13 Project Security

Setting Security .................................................. 13-2
Creating and Modifying Groups and Users. ...................... 13-2
  Creating a New Security Group .............................. 13-3
  Deleting a Security Group .................................. 13-4
  Adding a User to a Security Group ......................... 13-4
  Editing User Information .................................. 13-5
  Deleting a User from a Security Group .................... 13-5
  Moving a User to Another Security Group .................. 13-6
Assigning Permissions to a Security Group ................. 13-6
  Assigning Document Type Permissions to a Security Group 13-8
  Assigning Requirement Type Permissions to a Security Group 13-9
  Assigning Attribute Permissions to a Security Group .... 13-10
  Assigning Permissions to Attribute Values for a
  Security Group .................................................. 13-12

14 Project Management

Controlling User Access to a Document ...................... 14-1
  Locking and Unlocking Project Documents ................ 14-2
  Protecting Documents for Revisions ...................... 14-2
Creating Outlines ............................................. 14-3
Renumbering Requirements ................................ 14-4
Printing Project Summaries and Reports ................. 14-5
  Printing a Project Summary in RequisitePro ........... 14-5
  Using Rational SoDA with RequisitePro ................ 14-5
Archiving Projects ........................................... 14-6
  Archiving Projects with the Archive Command ......... 14-7
  Archiving Projects with ClearCase ...................... 14-8
  Archiving Projects with the PVCS Version Manager .... 14-10
  Archiving Projects with Visual SourceSafe ............. 14-14
Removing a Project’s Revision Information ............. 14-18
Removing Documents and Requirements from a Project Database 14-19
15 Project Information

Working with Document Types ................................. 15-1
Creating and Modifying Document Types .................. 15-2
Removing Document Types ................................. 15-3

Working with Requirement Types ..................... 15-4
Creating and Modifying Requirement Types .............. 15-4
Removing Requirement Types .............................. 15-6

Working with Requirement Attributes .................. 15-6
Creating and Modifying Requirement Attributes ........ 15-8

Working with Requirement Attribute Values ............. 15-10
Modifying Attribute Values ............................ 15-10
Removing Attribute Values ............................... 15-11

Setting Up and Modifying Cross-Project Traceability ... 15-12
Marking Requirement Types for Cross-Project Traceability 15-12
Connecting Projects ........................................... 15-14
Disconnecting Projects ...................................... 15-16

16 Integration with MS Project

Using RequisitePro and Microsoft Project .................. 16-1
Requirements ...................................................... 16-1
MSPT Requirement Types ..................................... 16-2

Starting the Wizard and Adding the MSPT Requirement Type 16-2
Creating Tasks from Requirements .......................... 16-4
Adding or Removing Traceability ........................... 16-6
Refreshing MSPT Requirement Information from Tasks. 16-13

Working with the MSPT Requirement Type ............... 16-14
Viewing the MSPT Requirement Type ...................... 16-14
Mapping Fields to Attributes for the MSPT Requirement Type 16-14
Microsoft Project Field IDs ............................... 16-15
Deleting Attributes for MSPT Requirement Types ........ 16-17

Appendix A: Keyboard Shortcuts and Mouse Actions

Dialog Box Shortcuts ........................................... A-1
Preface

Welcome to the Rational RequisitePro User’s Guide. This guide provides a complete reference for the features and options available in Rational RequisitePro (hereafter referred to as RequisitePro).

RequisitePro requirements management software from Rational Software Corporation integrates a powerful multi-user requirements database tool with Microsoft Word for Windows, enabling you to build a requirements database and requirements documents simultaneously.

About this Manual

Reading to Meet Your Needs

The RequisitePro User’s Guide is designed to meet the diverse needs and responsibility levels of various types of users. Users may perform different roles that vary depending on the RequisitePro project they access. The roles listed below describe typical user functions; however, they may not correspond directly to RequisitePro security groups. RequisitePro administrators can create any number of security groups with specific permissions for creating, updating, and deleting projects, documents, and requirements.

Requirements viewers read documents, query the requirements database, and participate in discussion groups. These are common activities for all RequisitePro users.

Requirements contributors perform the common activities of requirements viewers; however, they have additional permissions to modify requirements attribute values.

Requirements authors use standardized templates to write or revise requirements documents and add, delete, or revise requirements in the project database. The templates are created by the project managers.

Project managers create and manage all elements of a project – including security, document types and requirement types – and set up cross-project traceability.
The *RequisitePro User’s Guide* is organized to initially introduce activities that are common to all users who view and query requirements. It then moves to the skills needed for creating and managing requirements. Finally it addresses the advanced skills required for managing projects.

Refer to the following table which recommends reading based on your level of use in RequisitePro:

<table>
<thead>
<tr>
<th>Type of User</th>
<th>Recommended Chapters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16</td>
</tr>
<tr>
<td>Requirements Viewers</td>
<td>✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>Requirements Contributors</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>Requirements Authors</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>Project Managers</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
</tbody>
</table>

All readers should refer to Appendix A: *Keyboard Shortcuts and Mouse Actions*, Appendix B: *Customizing RequisitePro*, and the *Glossary*, which defines technical terms used in RequisitePro.
## RequisitePro Conventions

### Typographical Conventions Used Throughout this Manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capitalization</td>
<td>Signifies an item on a menu. For example, Open represents the <strong>Open</strong> command on the <strong>Project</strong> menu.</td>
</tr>
<tr>
<td>Italics</td>
<td>Used to emphasize a word, term, or file name (ex., <em>tlearn.rqs</em>).</td>
</tr>
<tr>
<td>Boldface</td>
<td>Signifies menu options and buttons in RequisitePro windows or dialog boxes.</td>
</tr>
</tbody>
</table>

### File Extensions Used in RequisitePro:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>.def</td>
<td>An outline’s definition file.</td>
</tr>
<tr>
<td>.doc</td>
<td>A Word document.</td>
</tr>
<tr>
<td>.dot</td>
<td>A Word template.</td>
</tr>
<tr>
<td>.hlp</td>
<td>A Windows application help file.</td>
</tr>
<tr>
<td>.txt</td>
<td>Plain text menu files used to add commands to Tool Palette menus.</td>
</tr>
<tr>
<td>.mnu</td>
<td></td>
</tr>
<tr>
<td>.rqs</td>
<td>A text file for project information.</td>
</tr>
</tbody>
</table>

See also *Appendix A: Keyboard Shortcuts and Mouse Actions*
Using Online Help

You can view online help within RequisitePro whenever you need assistance. To display the Help Contents:

- Click the Help button on the Tool Palette.
- Or, on the Tool Palette, click the Help menu, and choose Contents and Index.
- Or, press the F1 key.
- Or, click the Help button in any dialog box.

The Learning Project Tutorials

The Learning Projects are online tutorials designed to accelerate learning RequisitePro. If you are new to RequisitePro, we recommend that you begin by running the Learning Projects.

The first Learning Project presents traditional requirements management techniques and includes samples of a Product Requirements Document (PRD), a Software Requirements Specification (SRS), and a Test Plan (TST). You’ll be introduced to the Tool Palette and View Workplace, and learn how to navigate through the system.

The second Learning Project provides an example of a use-case approach to requirements management, with supporting actors and use-case document examples. Both projects contain exercises that highlight RequisitePro functions. Exercises are sequential, but are not duplicated.

To run the Learning Projects,

1. On the Tool Palette, click the Help menu, and choose Contents and Index.
2. At the Contents tab, double-click Getting Started.
4. Double-click What are the Learning Projects?
5. The first Learning Projects help topics are displayed. Online help will lead you to the Learning Projects online tutorial.
Rational Training and Consulting Services

Rational University's course in Requirements Management provides training in eliciting and managing the changing requirements of a project. Topics include:

- Problem analysis
- Product feature definition and specification
- Methods to define requirement attributes and maintain traceability for use in scope management
- Change management and impact analysis

RequisitePro Tool Training is a one-day tutorial on how to use the tool in an effective requirements management process. This course covers in-depth implementation and usage of RequisitePro, including terminology, configuration, and setting up the repository, as well as other tips and techniques.
Contacting RequisitePro Technical Support

At Rational Software Corporation, we are committed to helping you meet your requirements management goals. We welcome your comments on our products and services. If you have product suggestions or recommendations, please contact our Technical Support staff or your Rational account manager.

Rational Software Corporation offers telephone and e-mail support to customers with an active maintenance contract. If your maintenance contract has expired, please contact your Rational account manager.

Potential customers using evaluation copies of RequisitePro should contact their Rational account manager instead of Technical Support for assistance.

Answers to most questions can be found in online help or in this manual. The RequisitePro Readme file contains late-breaking updates. Consult these resources for answers to questions before contacting Rational Technical Support.

If you cannot find the information you need, contact Rational Customer Support.

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>800-433-5444</td>
<td>303-544-7333</td>
<td><a href="mailto:support@rational.com">support@rational.com</a></td>
</tr>
<tr>
<td>Europe</td>
<td>+31-23-569-4310</td>
<td>+31-23-569-4302</td>
<td><a href="mailto:support@europe.rational.com">support@europe.rational.com</a></td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>+61-2-9419-0111</td>
<td>+61-2-9419-0123</td>
<td><a href="mailto:support@apac.rational.com">support@apac.rational.com</a></td>
</tr>
</tbody>
</table>

To find the version number and other information about your RequisitePro product, click the Help menu on the RequisitePro Tool Palette and then click About RequisitePro.
E-mail

Please help our Technical Support staff deliver quality customer service by providing complete information. The Techsup.doc file, which is located in the RequisitePro installation directory and is also available by clicking Contacting Technical Support on the Help menu, contains a Customer Information Form. You can use this form to document problems, questions, or suggestions and to detail your company and system information. The form can be copied into your e-mail message.

Attach your error.log file (located in the ReqPro installation directory in the bin folder) if you are getting an error message. Add any files, screen captures, and other information you feel are relevant.

Telephone

When contacting Rational for support, please be near the computer with the Rational product installed, and be ready to provide the following information:

- Your Rational license number
- The RequisitePro version number
- The operating system and version number (for example, Windows NT 4.0 SP3)
- The version number of any other product that relates to the problem: Microsoft Word, MS Project, Visual SourceSafe, PVCS, ClearCase, etc.
- A description of the problem, the steps that led to the problem, and any error messages displayed

The Technical Support staff might also ask for information about your system, such as:

- The directory location of your RequisitePro executable file (ReqPro.exe) and the location of any other product that relates to the problem (filename.exe)
  (For example, C:\Program Files\Rational\RequisitePro 4)
- System information: The CPU speed, the amount of RAM installed, the amount of free space available on your hard drive
- The network protocol vendor and version number
Visit Our Web Site

For more information about Rational Software Corporation, its products, services, and current new releases, visit our Web site at http://www.rational.com.

You can also select the following Web pages directly from the Help menu (by pointing to the Rational on the Web menu option):

- Rational Home Page
- RequisitePro Home Page
- Technical Support
CHAPTER 1

Fundamentals of Requirements Management

This chapter is an excerpt from Rational’s white paper *Applying Requirements Management with Use Cases*. To review the full version of this or many other Rational white papers, please visit our Web site at http://www.rational.com/support.

Applying Requirements Management

If you are new to or somewhat familiar with requirements management and are interested in requirements process improvement, this paper offers a framework with which to develop your own approaches.

Software and System Development in the Age of Process

For most software and system development teams, the 1990s have been process-intensive when compared to the more freewheeling days of the past. Standards for measuring and certifying effective software development process have been introduced and popularized. Many books and articles on software development process and related material on business process modeling and re-engineering have been published. Increasing numbers of software tools have helped define and apply effective software development process. The global economy's dependence on software accelerated in the decade, enabling development processes and improving system quality.

So how do we explain the high incidence of the software project failure today? Why are many, if not most, software projects still plagued by delays, budget overruns, and quality problems? How can we improve the quality of the systems we build as our businesses, national economies, and daily activities become increasingly dependent on them?
The answers, as always, lie in the people, tools, and processes applied to our profession. Requirements management is often proposed as a solution to the ongoing problems of software development, yet relatively little attention has been focused on improving the practice of this discipline.

This paper presents the elements of an effective requirements management process and highlights some of the obstacles to its successful implementation.

**Why Manage Requirements?**

Simply put, system development teams who manage requirements do so because they want their projects to succeed. Meeting their project’s requirements defines success. Failing to manage requirements decreases the probability of meeting these objectives.

Recent evidence is supportive:

- The Standish Group’s CHAOS Reports from 1994 and 1997 established that the most significant contributors to project failure relate to requirements.

- In December 1997, Computer Industry Daily reported on a Sequent Computer Systems, Inc. study of 500 IT managers in the U.S. and U.K. that found 76 percent of the respondents had experienced complete project failure during their careers. The most frequently named cause of project failure was “changing user requirements.”

Avoiding failure should be sufficient motivation to manage requirements. Increasing the probability of a successful project and other benefits of managing requirements may be equally motivational. The Standish Group’s CHAOS report further established that managing requirements well was the factor most related to successful projects.

**What is a Requirement?**

The first step towards understanding requirements management is to agree on a common vocabulary. Rational defines a requirement as “a condition or capability to which the system [being built] must conform.” The Institute of Electronics and Electrical Engineers uses a similar definition.
Well-known requirements engineering authors Merlin Dorfman and Richard H. Thayer offer a compatible and more refined definition that is specific - but not necessarily limited - to software:

“A software requirement can be defined as:

- A software capability needed by the user to solve a problem or achieve an objective.
- A software capability that must be met or possessed by a system or system component to satisfy a contract, specification, standard, or other formally imposed documentation.”

What is Requirements Management?

Since requirements are things to which the system being built must conform, and conformance to some set of requirements defines the success or failure of projects, it makes sense to find out what the requirements are, write them down, organize them, and track them in the event they change.

Stated another way, Requirements Management is:

- a systematic approach to eliciting, organizing, and documenting the requirements of the system, and
- a process that establishes and maintains agreement between the customer and the project team on the changing requirements of the system.

This definition is similar to Dorfman and Thayer’s and the IEEE’s “Software Requirements Engineering.” Requirements Engineering includes elicitation, analysis, specification, verification, and management. All of these activities are incorporated in the definition of requirements management presented here and taught by Rational Software. The difference lies mainly in the choice of the word “management” rather than “engineering.” Management is a more appropriate description of all the activities involved, and it accurately emphasizes the importance of tracking changes to maintain agreements between stakeholders and the project team.
The Problems of Requirements Management

So what might be difficult about a process intended to ensure that a system conforms to the expectations set for it? When put into practice on real projects, difficulties come to light. Figure 1 displays the results of a 1996 survey of developers, managers, and quality assurance personnel. It shows the percentage of respondents who experienced the most frequently mentioned requirements-related problems.

A more comprehensive list of problems includes:

- Requirements are not always obvious and have many sources.
- Requirements are not always easy to express clearly in words.
- There are many different types of requirements at different levels of detail.
- The number of requirements can become unmanageable if not controlled.
- Requirements are related to one another and to other deliverables of the process in a variety of ways.
- Requirements have unique properties or property values. For example, they are neither equally important nor equally easy to meet.
- There are many interested and responsible parties, which means requirements need to be managed by cross-functional groups of people.
- Requirements change.
- Requirements can be time-sensitive.

When these problems are combined with inadequate requirements management and process skills, and the lack of easy-to-use tools, many teams despair of ever managing requirements well. Rational Software has developed
the expertise to instruct teams in requirements management skills and process. In addition, Rational’s RequisitePro is an accessible tool for automating effective requirements management.

**Requirements Management Skills**

To resolve the problems mentioned above, Rational encourages the development of key skills. These skills are presented below in what appears to be sequential order, but in an effective requirements management process they are applied continuously in varied order. Here they are presented in the sequence one would likely apply to the first iteration of a new project.

**Key Skill 1: Problem Analysis**

Problem analysis is conducted to understand business problems, target initial stakeholder needs, and propose high-level solutions. These acts of reasoning and analysis find “the problem behind the problem.” During problem analysis, agreement is gained on a statement of the real problems and the stakeholders are identified. Initial solution boundaries and constraints are defined from both technical and business perspectives. If appropriate, the business case for the project analyzes return on investment that is expected from the system.

**Key Skill 2: Understanding Stakeholder Needs**

Requirements have many sources. They may come from anyone with an interest in the outcome of the project. Customers, partners, end users, and domain experts are some sources of requirements. Management, project team members, business policies, and regulatory agencies can be others. It is important to know how to determine who the sources should be, how to get access to those sources, and how to elicit information from them. The individuals who serve as primary sources for this information are referred to as “stakeholders” in the project.
If you are developing an information system to be used internally within your company, you may include people with end-user experience and business domain expertise in your development team. Very often you will start the discussions at a business-model level rather than at a system level. If you are developing a product to be sold to a marketplace, you may make extensive use of your marketing people to better understand the needs of customers in that market.

Techniques for eliciting requirements include interviews, brainstorming, conceptual prototyping, questionnaires, and competitive analysis. The result of requirements elicitation is a list of requests or needs that are described textually and graphically, and that have been given priority relative to one another.

**Key Skill 3: Defining the System**

To define the system means to translate and organize the understanding of stakeholder needs into a meaningful description of the system to be built. Early in system definition, decisions are made on what constitutes a requirement, documentation format, language formality, degree of requirements, request priority and estimated effort, technical and management risks, and scope. Part of this activity may include early prototypes and design models directly related to the most important stakeholder requests.

The outcome of system definition is a description of the system that is both natural language and graphical. Some suggested formats for the description are provided in later sections.

```plaintext
Principle 55
WRITE NATURAL LANGUAGE BEFORE A MORE FORMAL MODEL
If you write the formal model first, the tendency will be to write natural language that describes the model instead of the solution system.

TO MAKE A LONG DISTANCE CALL, THE USER SHOULD LIFT THE PHONE. THE SYSTEM SHALL RESPOND WITH A DIAL TONE. THE USER SHOULD DIAL A “9”. THE SYSTEM SHALL RESPOND WITH A DISTINCTIVE DIAL TONE...

THE SYSTEM CONSISTS OF FOUR STATES: IDLE, DIAL TONE, DISTINCTIVE DIAL TONE, AND CONNECTED. TO GET FROM THE IDLE STATE TO THE DIAL TONE STATE, LIFT THE PHONE. TO GET FROM THE DIAL TONE STATE TO THE DISTINCTIVE DIAL TONE STATE, DIAL A “9.”

Note that in the latter example, the text does not help the reader at all.

```
Key Skill 4: Managing the Scope of the Project

The scope of a project is defined by its requirements. Managing project scope to fit the available resources (time, people, and money) is key to managing successful projects. Managing scope is a continuous activity that requires iterative or incremental development, which breaks project scope into smaller more manageable pieces.

Using requirement attributes, such as priority, effort, and risk, as the basis for negotiating the inclusion of a requirement is a particular useful technique for managing scope. Focusing on the attributes rather than the requirements themselves helps desensitize negotiations that are otherwise contentious.

It is also helpful for team leaders to be trained in negotiation skills and for the project to have a champion in the organization, as well as on the customer side. Product/project champions, whether on the project team or not, should have the organizational power to refuse scope changes beyond the available resources or to expand resources to accommodate additional scope.

Key Skill 5: Refining the System Definition

With an agreed-upon high-level system definition and a fairly well understood initial scope, it is both possible and economical to invest resources in more refined system definitions. Refining the system definition includes two key considerations: developing more detailed descriptions of the high-level system definition, and verifying that the system will comply with stakeholder needs and behave as described.

The descriptions are often the critical reference materials for project teams. Descriptions are best done with the audience in mind. A common mistake is to represent what is complex to build with a complex definition, particularly when the audience may be unable or unwilling to invest the critical thinking necessary to gain agreement. This leads to difficulties in explaining the purpose of the system to people both inside and outside the project team. Instead, you may discover the need to produce different kinds of descriptions for different audiences. This paper includes suggested formats for detailed natural language, formal text, and graphical descriptions. Once the description format is established, refinement continues throughout the project lifecycle.
Key Skill 6: Managing Changing Requirements

No matter how carefully you define your requirements, they will change. In fact, some requirement change is desirable! It means that your team is engaging your stakeholders. Accommodating changing requirements is a measure of your team’s stakeholder sensitivity and operational flexibility - team attributes that contribute to successful projects. Change is not the enemy, unmanaged change is.

A changed requirement means that more or less time has to be spent on implementing a particular feature, and a change to one requirement may have an impact on other requirements. Managing requirement change includes activities such as establishing a baseline, keeping track of the history of each requirement, determining which dependencies are important to trace, establishing traceable relationships between related items, and maintaining version control. As Figure 3 illustrates, it is also important to establish a change control or approval process, requiring all proposed changes to be reviewed by designated team members.

The Key to Managing Change
All Requests Go Through a Single Channel

Figure 3
Important Requirements Concepts

To apply requirements management skills to a project, certain requirements management concepts are useful for everyone on the project to understand. They include:

**Requirement Type.** The larger and more intricate the system, the more types of requirements appear. A requirement type is simply a class of requirements. By identifying types of requirements, teams can organize large numbers of requirements into meaningful and more manageable groups. Establishing different types of requirements in a project helps team members classify requests for changes and communicate more clearly.

Usually, one type of requirement can be broken down, or decomposed, into other types. Business rules and vision statements can be types of high-level requirements from which teams derive user needs, features, and product requirement types. Use cases and other forms of modeling drive design requirements that can be decomposed to software requirements and represented in analysis and design models. Test requirements are derived from the software requirements and decompose to specific test procedures. When there are hundreds, thousands, or even tens of thousands of instances of requirements in a given project, classifying requirements into types makes the project more manageable.

**Cross-Functional Teams.** Unlike other processes, such as testing or application modeling, which can be managed within a single business group, requirements management should involve everyone who can contribute their expertise to the development process. It should include people who represent the customer and the business expectations. Development managers, product managers, analysts, systems engineers, and even customers should participate. Requirements teams should also include those who create the system solution – engineers, architects, designers, programmers, QA personnel, technical writers, and other technical contributors.
Often, the responsibility for authoring and maintaining a requirement type can be allocated by functional area, further contributing to better large project management. The cross-functional nature of requirements management is one of the more challenging aspects of the discipline.

Traceability. As implied in the description of requirement types, no single expression of a requirement stands alone. Stakeholder requests are related to the product features proposed to meet them. Product features are related to individual requirements that specify the features in terms of functional and non-functional behavior. Test cases are related to the requirements they verify and validate. Requirements may be dependent on other requirements or mutually exclusive.

In order for teams to determine the impact of changes and feel confident that the system conforms to expectations, these traceability relationships must be understood, documented, and maintained. While traceability is one of the most difficult concepts to implement in requirements management, it is essential to accommodating change. Establishing clear requirement types and incorporating cross-functional participation can make traceability easier to implement and maintain.
Multi-Dimensional Attributes: Each type of requirement has attributes, and each individual requirement has different attribute values. For example, requirements may be assigned priorities, identified by source and rationale, delegated to specific sub-teams within a functional area, given a degree-of-difficulty designation, or associated with a particular iteration of the system. To illustrate, Figure 6 displays attributes for a Feature Requirement Type from a Learning Project in
Fundamentals of Requirements Management

Rational’s RequisitePro requirements management tool. As implied by the title of the screen, the requirement type and attributes for each type are defined for the entire project, ensuring usage consistency across the team.

In Figure 7, feature requirements are displayed for a specific project in RequisitePro. Note that even without displaying the entire text for each requirement, we can learn a great deal about each requirement from its attribute values. In this case, its priority and difficulty – which may be assigned by different team members – will help the team begin to scope the project to available resources and time, taking into account both stakeholder priorities and a very rough estimate of effort reflected in the difficulty attribute value. In more detailed types of requirements, the priority and effort attributes may have more specific values (e.g., estimated time, lines of code, etc.) with which to further refine scope. This multidimensional aspect of a requirement, compounded by different types of requirements - each with its own attributes - is essential to organizing large numbers of requirements and to managing the overall scope of the project.

**Change History:** Requirements, considered individually or in groups, have histories that become meaningful over time. Change is inevitable and desirable to keep pace with a changing environment and evolving technology. Recording the versions of project requirements enables team leaders to capture the reasons for changing the project, such as a new system release. Understanding that a collection of requirements may be associated with a particular version of software allows you to manage change incrementally, reducing risk and improving the probability of meeting milestones. As individual requirements evolve, it is important to understand their history: what changed, why, when, and even by whose authorization.

**Putting Requirements Management to Work**

Requirements management employs the key skills and concepts presented above to identify and resolve the problems successfully.
To build a system that truly meets customers’ needs, the project team must first define the problem to be solved by the system. Next, the team must identify stakeholders from whom business and user needs are elicited, described, and prioritized. From this set of high-level expectations or needs, a set of product or system features should be agreed upon.

Detailed software requirements should be written in such a form as can be understood by both the customers and the development team. We have found that using the language of the customer to describe these software requirements is most effective in gaining the understanding and agreement. These detailed software requirements are then used as input for the system design specifications as well as for test plans and procedures needed for implementation and validation. Software requirements should also drive the initial user documentation planning and design.
To facilitate this, the project team should:

1. Agree on a common vocabulary for the project.
2. Develop a vision of the system that describes the problem to be solved by the system, as well as its primary features.
3. Elicit stakeholders needs in at least five important areas: functionality, usability, reliability, performance, and supportability.
4. Determine what requirement types to use.
5. Select attributes and values for each requirement type.
6. Choose the formats in which requirements are described.
7. Identify team members who will author, contribute to, or simply view one or more types of requirements.
8. Decide what traceability is needed.
9. Establish a procedure to propose, review, and resolve changes to requirements.
10. Develop a mechanism to track requirement history.
11. Create progress and status reports for team members and management

These essential requirements management activities are independent of industry, development methodology, or requirements tools. They are also flexible, enabling effective requirements management in the most rigorous and the most rapid application development environments.
Sources


Recommended Reading

Order from IEEE Customer Service 445 Hoes Ln. P.O. Box 1331 Piscataway, NJ 08855-1331. (800) 678-4333.
CHAPTER 2

Overview: RequisitePro Concepts

This chapter covers key RequisitePro concepts. A complete glossary, RequisitePro terms, can be found in Appendix A.

Why Use RequisitePro?

Studies have shown that managing requirements is the most significant factor in delivering projects on time, on budget, and on target. RequisitePro helps projects succeed by giving teams the ability to manage all project requirements comprehensively, while facilitating team collaboration and communication.

Unlike conventional requirements management, RequisitePro combines both document-centric and database-centric approaches. By deeply integrating Microsoft Word with a multi-user database, RequisitePro organizes all your project requirements, providing traceability and change management throughout the project life cycle.

Team Collaboration, User Satisfaction

Requirements drive the entire project. RequisitePro’s integration with other industry-leading tools optimizes the flow of requirements data throughout the project, promoting reuse and consistency, and ensuring that what is designed, tested, documented, and delivered meets the users’ needs.

A product development team typically includes a large number of individuals with diverse roles, such as business analysts, project leaders, product marketing managers, development managers, QA managers, developers, testers and more. Giving each person on your team access to critical requirements information, and the ability to manage to those requirements, promotes team efficiency and effectiveness.
Overview: RequisitePro Concepts

Change Happens – Manage it

Change occurs in practically every development project, but it doesn’t have to consume project resources or throw the project off course. With RequisitePro, you can manage inevitable change to ensure your entire team is current as requirements evolve. Traceability features in RequisitePro let you establish and maintain dependencies between different requirements. As change occurs, these traceability relationships are flagged as suspect, so you can understand how change impacts the entire project. For each requirement a change history is maintained, capturing the who, what, when, and why of the change.

Comprehensive Process Support

Whether your team follows a rigorous requirements management process, such as IEEE, SEI CMM or UML-driven use-case approaches, or is just beginning to define a formal process, RequisitePro can help you meet your objectives of delivering precise, quality software. RequisitePro provides industry standard project templates and attributes, and it can also import existing documents and be customized to support existing projects.

A Quick Tour of Key Concepts in RequisitePro

This section provides an overview of RequisitePro 4.0 concepts and defines some terms that will help you get started.

Requirement

RequisitePro is a requirements repository that organizes requirements and provides traceability and change management throughout the project lifecycle. To talk about RequisitePro, we first have to decide what a requirement is.

Rational defines a requirement as “a condition or capability to which the system must conform.”

Later in this chapter we will discuss requirement types and attributes.
(For more information on requirements, refer to Chapter 8: Requirements.)

Project

A project is defined as “a requirements database and its related documents.” A project is usually created by a project manager, who determines the project structure and sets up security permissions for the project’s users.
While all project users are encouraged to view and query requirements and to participate in discussions, a limited group of users create and manage requirements within a project.

(For more information on projects, refer to the following chapters: Project Creation, Project Security, Project Management, and Project Information.)

**Project Database**

Each RequisitePro project has its own database, where all the requirements for a project are stored (with the exception of RequisiteEnterprise projects that use an Oracle or SQL Server database).

In the project database, requirements can be added, modified, or deleted. When requirements are changed in a document, the changes are updated in the database.

Often a project includes a variety of requirements documents, such as a product requirements document, a system requirements document, software and hardware specifications, user requirements, quality assurance procedures and test plans. Information from all project documents is stored in the project database. The database centralizes information, so that members of the project team can update requirements, manage priorities and test plans, and report the project’s progress in one shared repository.

**Project Version Control**

RequisitePro’s version control lets you trace change by archiving projects. Version control helps you keep a record of changes to project files during the development cycle. You can manage multiple versions of your projects, retrieving, modifying, and returning revisions to the archive in an organized and consistent manner. This is accomplished in RequisitePro with RequisitePro’s Archive command, PVCS Version Manager, Visual SourceSafe, or Rational ClearCase. (For more information, refer to Archiving Projects on page 14-6.)

**Catalog**

A RequisitePro catalog is a personal library of accessible RequisitePro projects. Each user’s catalog is unique. For example, a program director monitoring the progress of all the projects scheduled for completion this quarter could have an extensive catalog, while some users might have just one project cataloged at a time.
Overview: RequisitePro Concepts

Project managers store new projects in their file systems – typically in the RequisitePro Projects directory. When you create your personal catalog, you select projects from the file system for your own use. You can add or delete projects from your catalog as you need them.

(For more information, refer to Using the Catalog on page 3-3.)

The Tool Palette, Word Workplace, and Views Workplace

RequisitePro is composed of workplaces where distinct but interrelated work is done.

Tool Palette

When RequisitePro is started, the Tool Palette is displayed. Menus on the Tool Palette contain RequisitePro commands, and provide access to project information, document information, requirements information, discussions, and views.

The icon buttons below the menu bar are shortcuts to frequently used menu commands. When you position your mouse over a button, a ToolTip appears, describing the button's function. Use the first button on the Tool Palette to open RequisitePro projects and documents.

Word Workplace

The Word Workplace is the place within RequisitePro where requirements are created and modified in a document. The Word Workplace contains requirement specifications in the form of RequisitePro documents and Word documents.

The Word Workplace looks like a Word document, but the menu bar has been modified to include a RequisitePro menu that allows you to manage requirements. With a few exceptions, RequisitePro uses the same commands in the Word Workplace that are available in Microsoft Word. The Save As and Exit commands are disabled in the Word Workplace in order to prevent conflicts in handling RequisitePro documents. Use Project/Exit command on the Tools Palette to close the Word Workplace.
Views Workplace

The Views Workplace is a window to the database. Requirements, their attributes, and their relationships to each other are displayed and managed in views.

All Views Workplace commands are located in the menu bar at the top of the Views Workplace. As in the Tool Palette, icon buttons are available to access one command at a time.

Views

In RequisitePro, a view is accessed in the Views Workplace. Views present information about a project, a document, or requirements graphically in a table (matrix) or in an outline tree. Views display the attributes assigned to requirements, such as Status and Priority, or the relationships between different types of requirements. (For more information, refer to Chapter 4: Views.)

Three kinds of views can be created in the Views Workplace:

- The Attribute Matrix View displays all requirements of a specified type. The requirements are listed in the rows, and their attributes appear in the columns.
- The Traceability Matrix View displays the relationships (traceability) between two types of requirements.
- The Traceability Tree displays the chain of traceability to or from requirements of a specified type.
Overview: RequisitePro Concepts

Documents

A requirements document is a specification that captures requirements, describes the objectives and goals of the project, and communicates product development efforts. Each requirements document belongs to a particular document type, explained below.

RequisitePro manages requirements directly in the project documents. When you build a requirements document, RequisitePro dynamically links it to a database, enabling you to manage requirements by updating and saving the documents. When saved, revisions are available to team members and others involved with the project.

With RequisitePro’s version tracking, you can easily review the change history for a requirement, a document, or the whole project.

Documents are created in either Word or RequisitePro format. RequisitePro format makes proprietary modifications to the standard Word application that allows RequisitePro to exercise security controls over the document. As such, certain Word features are disabled, and that functionality is available instead.
through RequisitePro’s Tool Palette commands. For example, Word’s File...Open command is executed in RequisitePro as Project...Open, or Doc...Open, or Doc...Open Word Doc.

Not all documents are requirements documents. Documents do not have to contain requirements to be included in a project. Any Word document, no matter where it resides in the file system, can be associated with a project and will be available in the document list when a project is opened. (For more information, refer to Chapter 7: Documents.)

**Document Types and Requirement Types**

Document types and requirement types are two similar requirements management concepts and tools. They might be confused with one another because they perform such similar functions. Both serve as templates and define the appearance of two essential requirements management components, a document and a requirement. Where they differ is in their application.

**Document Type**

A document type identifies the type of document, such as a use-case or a software requirements specification, and helps ensure consistency across documents of the same type. A document type is a template that is applied to your documents. The template can include the default font for your document, the available heading and paragraph styles, and the default type of requirements for the document. Or it could encompass both formatting conventions and an outline that helps you organize your requirements information. (For more information, refer to Creating and Modifying Document Types on page 15-2.)

All documents of the same document type share the same file extension (for example, .prd). You determine document types when you create or modify your project. Then, when you create a document, you can associate it with a document type already defined in your project. The new document inherits the style and functional attributes associated with the document type, making it consistent with other documents of the same type.

RequisitePro provides standard document templates that can be used “as is” or customized according to your specifications. Once you have defined the appearance of the document and the information to include, you can use the document as a standard for your organization.
There are several benefits to using standards:

- The template can be used as an example of the type of information to include and can serve as a comprehensive “to do” list so no information is overlooked.
- Expectations and procedures are clearly presented so new authors and team members spend less time learning to build the necessary requirements documents.
- Authors familiar with the template can create new documents quickly.
- Readers familiar with the template can quickly locate and review information.

**Requirement Type**

A requirement type is a template for your requirements. Requirement types are used to classify similar requirements so they can be efficiently managed. When you define a requirement type, you define a common set of attributes, display style, and tag numbering.

You can create your own requirement types appropriate for your project. (For more information, refer to *Creating and Modifying Requirement Types* on page 15-4.)

**Requirement Attributes**

Requirements in RequisitePro are classified by their type and their attributes. In RequisitePro, an attribute provides information to manage a requirement. Attributes can provide crucial information to help a team plan, communicate, and monitor project activities from the analysis and design phases through the test and release phases.

Attribute information may include:

- The relative benefit of the requirement
- The cost of implementing the requirement
- The priority of the requirement
- The difficulty or risk associated with the requirement
- The relationship of the requirement to another requirement

RequisitePro provides several default requirement attributes, such as Priority (high, medium, low), Status (proposed, approved, incorporated, validated), Cost and Difficulty. These attributes are suggestions. You can create and
control attributes according to your needs. Whichever attributes you use, RequisitePro offers the flexibility to easily customize your project documents and databases to define, articulate, and manage the processes and culture of your organization.

(For more information, refer to Creating and Modifying Requirement Attributes on page 15-8.)

Hierarchical Relationships

Hierarchical requirement relationships are one-to-one or one-to-many, parent-child relationships between requirements of the same type. Use hierarchical relationships to subdivide a general requirement into more explicit requirements.

Hierarchical relationships are a type of change-managed relationship in RequisitePro. If a requirement is changed, the relationships with its children become suspect.

(For more information, refer to Chapter 9: Hierarchical Relationships.)

When working with hierarchical relationships, keep the following in mind:

• Parent requirements are upper-level, more general requirements; child requirements are lower-level, more specific requirements.

• Each child requirement can have only one parent, but a requirement can be both a parent and a child.

• The relationship between children of the same parent is a peer relationship.

• You create hierarchical relationships in the Word Workplace or the Views Workplace, using the Hierarchy tab in the Requirement dialog box. (In the Views Workplace, you can also use Requirement menu commands to create hierarchical relationships.)

• When you delete a parent requirement, you can choose to:
  - Delete the children and sub-level children as well.
  - Reparent the children and renumber them with the root tag of the new parent.
  - Promote the top-level children to parent (root) level; they will continue to parent their sub-level children. They will be assigned new tag numbers.
Overview: RequisitePro Concepts

Traceability Relationships

Traceability relationships are another type of change-managed relationship in RequisitePro. If either end-point of the connection is changed, the relationship becomes suspect.

Traceability links requirements to related requirements of same or different types. RequisitePro’s Traceability feature makes it easy to track changes to a requirement throughout the development cycle. Without traceability, each change would require a review of your documents to determine which, if any, elements need updating.

(For more information, refer to Chapter 10: Traceability Relationships.)

When working with traceability relationships, keep the following in mind:

• You can create a traceability relationship between requirements of the same or different types.

• You can create traceability relationships between requirements that exist in the same document, in different documents, or in the project database.

• You can create, view, and manipulate traceability relationships in the Word Workplace or in the Views Workplace.

• If you modify the text or selected attributes of a requirement that is traced to or traced from another requirement, RequisitePro marks the relationship between the two requirements “suspect.”

• Traceability relationships cannot have circular references. For instance, a traceability relationship cannot exist between a requirement and itself, nor can a relationship indirectly lead back to a previously traced from node. RequisitePro runs a check for circular references each time you establish a traceability relationship.

Note: You cannot create a traceability relationship between a parent and its own child, but you can create a traceability relationship between a parent requirement and a different parent requirement’s child.

Traced to/Traced from Overview

There can be only one traceability relationship between any two requirements. The difference between calling the relationship trace to and calling it trace from is perspective.

For example, you might create a software requirement (Requirement A) that calls for a new command to be added to a particular menu in your application. In addition, in another requirements document, you might create a test...
requirement (Requirement B) associated with that menu item. You would thus create a traceability relationship in which the test requirement (B) is traced from the software requirement (A)

In this example, both of these statements are true:

- A is traced to B
- B is traced from A

**Direct and Indirect Traceability Relationships**

There are two types of traceability relationships: direct and indirect.

In a direct traceability relationship, a requirement is physically traced to or from another requirement. For example, if Requirement A is traced to Requirement B, and Requirement B is traced to Requirement C, then the relationships between A and B and between B and C are direct relationships. The relationship between A and C is indirect (inferred). Indirect relationships are maintained by RequisitePro; you cannot modify them directly.

**Suspect Relationships**

A hierarchical relationship or a traceability relationship between requirements becomes suspect if RequisitePro detects that a requirement has been modified. If a requirement’s text is modified, all its immediate children and all direct relationships traced to and from it are suspect.

When you make a change to a requirement, the suspect state is displayed in a Traceability Matrix or a Traceability Tree. Changes include modifications to the requirement text, requirement type, or attributes.

For more information about parent-child relationships or traceability relationships that are marked suspect, refer to Suspect Relationships on page 9-8 and Suspect Relationships on page 10-8.
Overview: RequisitePro Concepts
CHAPTER 3

Getting Started

This chapter explains the basics of opening the RequisitePro application and using the catalog function.

Launching RequisitePro

Click the Start icon. Choose Programs, then Rational RequisitePro 4.0, then the RequisitePro icon.

Using the RequisitePro Tool Palette

The Tool Palette is the central interface for accessing and working with RequisitePro projects. When RequisitePro is launched, the Tool Palette appears:

- Menus on the Tool Palette contain RequisitePro commands and provide access to project information, requirements information, and views.
- The icon buttons below the menu bar are shortcuts to frequently used menu commands. When you position your mouse over a button, a ToolTip appears, describing the button’s function.
Exiting RequisitePro

When you exit RequisitePro, the application closes the current project, prompting you first to save any changes you made to the project’s requirements documents.

1. Click the **Project** menu on the Tool Palette and choose **Exit**.

   If you did not modify any requirements document, a dialog box appears, asking you to confirm that you want to exit. Click **Yes**.

   If you modified one or more requirements documents, and have not yet saved those changes, the **Document Changed** dialog box appears.

2. Do one of the following:
   - To save the changes you made without reviewing the changes, click **Yes**.
     If you made changes to a requirement’s text, the **Change Description** dialog box appears and asks you to enter the reason for the changes before saving.
   - To close the document and exit RequisitePro without saving the changes, click **No**.
   - To cancel the exit process, click **Cancel**.
   - To review changes to the document, click **Review Changes**.
     If you made changes to a requirement’s text, the **Change Description** dialog box appears and asks you to enter the reason for the changes.

The **Document Changes** dialog box appears, listing each modification to the document.
3. Do one of the following:
   • To save the changes you made, click Yes. RequisitePro saves the changes in the document and in the database.
   • To close the document and exit RequisitePro without saving the changes, click No.
   • To cancel the exit process, click Cancel.

Using the Catalog

Adding a RequisitePro Project to Your Catalog

A RequisitePro catalog is a library of accessible RequisitePro projects. Each user’s catalog is unique. All projects are stored in the file system. When you create a catalog on your PC, you select projects from the file system for your own use. You can add or remove projects from your catalog as you need them.

Before you can access a project, you must add it to the catalog on your machine:

1. Click the Project menu on the Tool Palette and choose Catalog. The Project Catalog dialog box appears.
2. Click Add. The Add Project dialog box appears:

3. Find the project to add to the catalog (it has a .rqs extension).
4. Highlight the project and click Open.
5. Click OK. RequisitePro adds the project to your catalog.
Removing a Project from the Catalog

Removing a project from the catalog does not delete the project files, but removes the project from the catalog listing. It remains in the file system and can be added to your catalog again.

To remove a project from the catalog:

1. Click the Project menu on the Tool Palette and choose Catalog.
   The Project Catalog dialog box appears:

2. Highlight the project to remove and click Remove. RequisitePro removes the project from the catalog.
   Note: You can retrieve a project you removed by clicking the Add button. (Refer to Adding a RequisitePro Project to Your Catalog on the previous page.)

3. Click OK to close the Project Catalog dialog box. If you click Cancel in the Project Catalog dialog box, the project is not removed from the catalog.
Opening a Project and Documents

When you open a project, you can open a document at the same time. Or, you can choose to open just the project without selecting a document. RequisitePro displays all documents associated with the project, regardless of where they are stored on the file system.

To open a project and a document:

1. Click the Project menu on the Tool Palette and choose Open, or click the Project button on the Tool Palette.
   The Open Project and Documents dialog box appears:

2. Highlight the project to open in the Select a Project list box.
3. When documents are created, they are assigned a document type. The Select Documents list displays documents by type. To see a different selection of documents, choose another document type from the Display Types drop-down menu.
4. Highlight the document to open in the Select Documents list box. You can use a multiple select action (Ctrl-click, Shift-click, or drag) to open multiple documents.
5. Select the user access options. If you want to be the only user who has access to the project and documents, mark the **Exclusive** check box. To open all selected documents in read-only mode, mark the **Read Only** check box.

6. Click **OK**.

Depending on the security set on the project, one of two dialog boxes appears:

- If security is set on the project, refer to *Accessing a Secure Project* on page 3-8.

- If no security is set on the project, but your user name has not been identified in the project, the Project Logon dialog box appears.
  
  1. Do one of the following:
     - Accept the displayed name; or
     - Click the down arrow and select a user name from the list; or
     - Type a new user name that will be added to the project.

  2. Click **OK**.

   The project opens, and the new name is added to the project.

### Closing a Project and Documents

The **Close** command closes a project and its documents and any open views.

1. Click the **Project** menu on the Tool Palette and choose **Close**.

   If you made no changes, the **Project Close** dialog box appears and prompts you to close the project and its documents or keep it open. Click **Yes** to close the project and its documents.

   If you modified but did not save a document, the **Document Changed** dialog box appears.
2. Do one of the following:
   • To save the changes to the document, click **Yes**. If you made changes to a requirement’s text, the **Change Description** dialog box appears and asks you to enter the reason for the changes before saving.
   • To close the project without saving the document changes, click **No**.
   • To cancel the close project procedure, click **Cancel**.
   • To review document changes, click **Review Changes**. If you made changes to a requirement’s text, the **Change Description** dialog box appears and asks you to enter the reason for the changes.

   The **Document Changes** dialog box appears, listing each modification to the document.

3. Do one of the following:
   • To save the changes to the document, click **Yes**.
   • To close the project without saving the document changes, click **No**.
   • To cancel the close project procedure, click **Cancel**.
Accessing a Secure Project

Project managers can enable security for a project, requiring users to log on and provide a password. The project manager sets up security and assigns a user name and password to each member of the team.

Logging on to RequisitePro

To log on and to access a secured RequisitePro project:

1. Click the Project button on the Tool Palette, or click the Project menu and choose Open. The Open Project and Documents dialog box appears.
2. Highlight a project in the list to open and click OK. If RequisitePro detects that security is enabled, the Project Logon dialog box appears:

   ![Project Logon dialog box]

3. Type your name in the Username text box and your password in the Password text box. Click OK. You are now ready to use the project.

Modifying Your Password, User Name, or E-mail Address

Once you are in a project you can modify your password, user name, or e-mail address. If you are a RequisitePro administrator or a member of a group with project security permissions, you also have the ability to change the password, user name or e-mail address for other users. See Editing User Information on page 13-5.

A valid e-mail address is necessary for receiving RequisitePro discussion messages via e-mail. For more information, see Configuring E-mail for Discussions on page 6-2.

1. Open a project and log on. The RequisitePro Tool Palette appears.
2. Click the Project menu and choose Security. The Edit User dialog box appears.
3. If you are a RequisitePro administrator or a member of a group with project security, the **Project Security** dialog box appears instead. Click the “Enable security for this project” check box. Select a user group and a user name, and click the **Edit** button. Then the **Edit User** dialog box appears:

![Edit User dialog box](image)

**To change your password:**

1. Type your password in the **Old Password** text box that appears in the dialog box (This step applies only to users who don’t have project security permissions).
2. Type your new password in the **New Password** text box. Passwords are case sensitive and limited to 14 alphanumeric characters.
3. Confirm the new password by typing it again in the **Verify** text box.
4. Click **OK**. Your new password is in place and ready for use.

**To change your user name (for users with project security permissions):**

1. Highlight your current name in the Username field.
2. Type a new user name. User names are limited to 20 alphanumeric characters and are not case sensitive.
3. Click **OK**. Your new name is in place and ready for use.

**To change your e-mail address:**

1. Highlight your current e-mail address in the E-mail field.
2. Type a new e-mail address.
3. Click **OK**. Your e-mail address is in place and ready for use.
Getting Started
Chapter 4

Views

RequisitePro views use tables or outline trees to display requirements and their attributes or the traceability relationships between different requirement types. RequisitePro includes powerful query functions for filtering and sorting the requirements and their attributes in views.

The Views Workplace is an environment for analyzing and printing requirements, whether they are document-based or database-only requirements. You can have multiple views open at one time. The Views Workplace provides scroll bars to view all requirements and attributes in the table or tree. The number of requirements in the current view appears in the lower right corner of the views window.

You can create three kinds of views in the Views Workplace:

• The Attribute Matrix view displays all requirements and their attributes within a specified type.

• The Traceability Matrix view displays the relationships between requirements of two types.

• The Traceability Tree view displays the chain of traceability through the project requirements.
Accessing Functions and Navigating in Views

- All Views Workplace commands are located in the menu bar at the top of the Views Workplace. Unless stated otherwise, this manual refers to the commands in the Views Workplace when working with views.

- To navigate in a view quickly, use the ARROW keys, the PAGE UP or PAGE DOWN keys, and the HOME and END keys. For more information, refer to Mouse Actions and Shortcuts in the Views Workplace in Appendix A.

- Use the right button on the mouse as a shortcut to commands that are specific to requirements and attributes. Move the mouse over the requirements and attribute labels and click the right button to access these shortcut menus. For more information, refer to Mouse Actions and Shortcuts in the Views Workplace in Appendix A.

- The full text of the selected requirement is displayed in the text pane at the bottom of the view. To resize a text pane, position the mouse on the upper border and drag upward.

Viewing Current Data

While a view is open, other users may add, delete, or modify requirements that are displayed in your view. These changes are not automatically reflected in your open view.

To update the data displayed in the view for requirements that were modified by other users, click the Refresh All command on the View menu (or click the Refresh button on the toolbar in the Views Workplace). The Refresh All command affects all open views and automatically updates the data in each view.

The Query Now command on the View menu in the Views Workplace reruns a view’s query criteria against the database and updates your requirement set. (For more information on queries, refer to Query and Search on page 5-1.) Requirements that have been deleted or no longer match the query are removed from the view. New requirements that match the query are added to the view. Query Now does not refresh the data for requirements that are already in your view.
Traceability in the Views Workplace

Note: If there are many requirements in the database, **Refresh All** can take some time to complete. If you just need to see a fresh requirement set, without updating the text and attributes for each requirement, use **Query Now**.

**Traceability in the Views Workplace**

The Traceability Matrix and Traceability Tree views display traceability relationships. Traceability relationships are displayed as suspect when you make a change to a requirement. For more information about traceability relationships between requirements, refer to *Traceability Relationships* on page 10-1.

- Arrows are used to indicate direct traceability relationships in the Traceability Matrix and Traceability Tree views. If the arrow points from A to B, then the following two statements are true: A is traced to B and B is traced from A.
- A requirements relationship is indirect if the relationship is derived by traversing the requirements relationships. An arrow outlined by a dotted line, lighter in color than a direct relationship arrow, indicates an indirect traceability relationship in the Traceability Tree and the Traceability Matrix.

**Hierarchy in the Views Workplace**

All views display hierarchical relationships, and you can use the Traceability Matrix and Traceability Tree to display hierarchical relationships that are marked suspect. For more information about hierarchical relationships between requirements, refer to *Hierarchical Relationships* on page 9-1.

- You can create hierarchical relationships in the Views Workplace by using Requirement menu commands or editing the requirement properties in the Hierarchy tab of the Requirement dialog box.
- When you modify a parent requirement, RequisitePro marks the relationships between the parent and all its immediate children as suspect.
- When you modify a child requirement, the relationship with its parent is not marked as suspect.
Views

- When a child requirement is assigned to a new parent, all hierarchical relationships between the new parent and its immediate children are automatically marked suspect. The relationships between the children and their children are not marked as suspect.
- In the Traceability Tree, you can manually mark a hierarchical relationship as suspect or clear a suspect relationship.

The Attribute Matrix

This view displays requirements and their attributes for a specific requirement type. Requirements are arranged in rows and listed by tag number. Attributes are arranged in columns. The Attribute Matrix displays both document-based and database-based requirements, but only database requirements can be created in this view.

Requirements

In this view, requirement tags and text are displayed on rows in the matrix. When requirement text exceeds the capacity of the row, RequisitePro marks the last word with ellipses (...), which indicate there is more text that is not displayed. The row height and width can be changed.
The Traceability Matrix

Attributes

Attribute labels are listed at the top of each column. Corresponding attribute values are listed beneath the attribute labels. Query information displays here as well. Columns can be resized.

Text Pane

The text pane displays the description of a requirement in its entirety. This field is located at the bottom of the matrix and is blank when a requirement is not selected. “Multiple requirements selected” appears in the text pane if you have selected more than one requirement. Graphics or OLE objects in requirements are displayed as small rectangular symbols. The default size of the text pane is two lines, but its height can be increased to as many lines as you need.

The Traceability Matrix

This view displays and manipulates the relationships between two requirement types. The requirements can be of the same type or different types. Use this view to create, modify, and delete traceability relationships and to view indirect relationships. The Traceability Matrix also shows traceability relationships that are marked suspect. If you display a Traceability Matrix of requirements of the same type, it shows hierarchical relationships that are marked as suspect.

In this view, a requirement is traced to or traced from another requirement. For example, requirement B is traced from requirement A if it was directly or indirectly derived from requirement A. If requirement A is the basis of several other requirements, Requirement A is traced to these requirements.

An arrow pointing from one requirement to another indicates that a direct traceability relationship exists between the requirements. A dotted line arrow indicates an indirect relationship.

Rows and columns can be resized. The intersection between a row and column is called a cell.
Views

Cells

- If the intersection is blank, no relationship exists.
- If an arrow points upward to a column requirement, the requirement is \textit{traced to} that requirement
- If an arrow points down toward a row requirement, the requirement is \textit{traced from} that requirement
- If a dotted line arrow is displayed, an indirect relationship exists.
- If an arrow with a red diagonal line through it is displayed, the traceability relationship is suspect.
- If a triangle with a red diagonal line through it is displayed, the hierarchical relationship is suspect.

Text Panes

The Traceability Matrix displays two text panes. These panes let you review the requirements in each area, so you can easily create, modify, and delete traceability relationships. The default size of each pane is set to one line and can be resized. The top text pane displays the complete text of the currently selected row requirement and the bottom pane displays the text of the currently selected column requirement. “Multiple requirements selected” appears in the text pane if you have selected more than one requirement.
The Traceability Tree

The Traceability Tree provides a graphical view of relationships to or from requirements of one specific requirement type, including direct, indirect and suspect traceability relationships. Although direct and suspect relationships are modified in this view, RequisitePro permits read-only access to indirect relationships.

In addition, the Traceability Tree displays hierarchical relationships and shows any parent-child relationships that have been marked as suspect.

Requirement text appears at the bottom of the view and associated attributes to the right of the view of the currently selected requirement.

When creating a Traceability Tree, you can choose one that displays all requirements traced to the requirements the tree is based on, or one that shows all requirements traced from the requirements the tree is based on.

Tree Pane

Select a specific requirement type on which to base the view. Traceability relationships for root-level requirements are indented and preceded by an arrow. Child requirements are indented below their parents and preceded by a triangle. The pane on the right side of the view displays requirement attributes.
Views

Note: To resize the tree pane, click the border between the tree and attribute panes. Press the left button on the mouse and drag it left or right to the desired size. This does not affect the length of the lines set in the Row/Column Sizing dialog box.

If the arrow points toward a branch-level requirement, the root is traced to this requirement.

If the arrow points away from the branch-level requirement, the requirements on the branches are traced from the requirement.

If an arrow with a red diagonal line is displayed, the traceability relationship is suspect.

If a triangle with a red diagonal line is displayed, the hierarchical relationship is suspect.

Attribute Pane

This pane displays the attributes associated with the currently selected requirement. To display the attributes of a particular requirement, click the requirement in the tree pane. This is a read-only text box and cannot be edited.

If you have more than one requirement selected, the pane displays the attributes for the first requirement selected.

Text Pane

The text pane is located in the lower section of the Traceability Tree. To display the full text of a particular requirement, click the requirement in the tree pane. To adjust the height of the pane, click its upper border and drag the pane to the desired size.

“Multiple requirements selected” appears in the text pane if you have selected more than one requirement.
Working with Views

This section presents the fundamentals of working in the Views Workplace, including the following:

- Creating a view
- Saving a view
- Expanding and collapsing in the Views Workplace
- Opening a saved view
- Closing a view
- Renaming a view
- Duplicating a view
- Printing a view
- Deleting a view

Creating a View

1. Click the Window menu on the Tool Palette and choose Show Views, or click the Show the views workplace button on the Tool Palette. The Views Workplace opens.

2. Click the File menu in the Views Workplace and choose New View. The New View dialog box appears:

3. Select a view type to display.
Views

4. Select a requirement type to display in the view. The Traceability Matrix requires both row and column requirement types.

5. Click OK. The view is displayed.

Note: The Traceability Matrix displays more than one requirement type. The Attribute Matrix displays a single requirement type, and the Traceability Tree displays a single requirement type at the root level. Only requirements associated with the selected requirement types appear in the view.

Expanding and Collapsing in the Views Workplace

The Expand All and Collapse All commands on the View menu are used to expand and collapse hierarchical relationships in all views and traceability relationships in the Traceability Tree. An expanded view shows the root requirement and all its sub-level requirements. Collapse the view to show just the root level requirements.

The Expand All command expands all relationships in a view. When you select this command in a Traceability Tree, a requirement that has a traceability relationship with a root requirement appears as a branch of the root requirement. This command also expands all parent requirements, displaying all children, in all views.

The Collapse All command collapses all relationships in a view. When you select this command in a Traceability Tree, a requirement that has a traceability relationship with a root requirement is no longer displayed. This command also collapses all parent requirements, hiding all children, in all views.

To expand the Traceability Tree or hierarchical relationships:

• Click the View menu and choose Expand All.

To collapse the Traceability Tree or hierarchical relationships:

• Click the View menu and choose Collapse All.

Saving a View

When you save a view, the layout of the view and the query criteria are also saved. The data within the view is not saved as part of the view, but is part of the database instead. Thus, when you open a saved view, current information is displayed in a saved view format.
Note: The saved view is not a snapshot of requirement information for a particular date. The way to save the results of a query is to print the view. For more information on queries, refer to Query and Search on page 5-1.

A view must be active in the Views Workplace to be saved. To make an open view active and display the view in the active color, click the title bar of the view or select it from the Windows menu.

To save a view:

1. Click the File menu and choose Save View As.
   Or, click the Save button on the toolbar in the Views Workplace.
   The Save View As dialog box appears:

2. Click the Name text box and type a name of up to 64 characters.
3. Make the view available to all users (Project-wide availability) or for your own use (Personal) by marking the corresponding button.
4. RequisitePro populates the following fields, which cannot be edited:
   • The Author text box displays the name of the RequisitePro user who saved the view.
   • The Date text box displays the date the view was saved.
   • The Time text box displays the time the view was saved.
5. Click OK to save the view.

RequisitePro organizes views by view type in the Previously Saved Views list box in the Open View dialog box. When a view is saved, it is added to this list.
Opening a Saved View

To display a saved project-wide or personal view:

1. Click the File menu and choose Open View. Or, click the Open a previously saved view button on the Views toolbar. The Open View dialog box appears:

2. Choose a project-wide or personal view by marking the corresponding button. A list of saved views appears.

3. Highlight the desired view from the list. The author, date of creation, and time of creation appears below the list.

4. Click OK. RequisitePro displays the selected view.

Closing a View

1. From the File menu, choose Close View.

Note: If the Prompt to save option is activated (the check box is marked in the Tools/Options dialog box), and you have changed any of the view’s properties, a dialog box appears asking if you want to save the view. Click Yes or No.

2. RequisitePro closes the view.
Renaming a View

Renaming can be used to change the name of an open view window. You might want to give a view a longer, descriptive name before you print the view, so that the new name appears on the printed page. You can still retain the original name in the file system. Renaming a view does not save the renamed view to the database until the view is saved again.

1. Click the View menu in the Views Workplace and choose Rename. The Rename View dialog box appears.

2. Type a new name for the view in the Name text box and click OK.

Note: Use the Save option on the File menu to save the renamed view.

Duplicating a View

Duplicating a view opens another window with the same view properties as the active window. This is especially useful for creating copies of the view with different sorting and filter options.

To duplicate a view:

- Click the View menu and choose Duplicate.
- RequisitePro renames the view with the suffix 2; for example, “Product Requirement Description View2.”
Printing a View

In the Views Workplace, you can print any active view. When you print a view, you can choose to print the entire matrix or selected items.

To print an open view:

1. If you want to print only a selected requirement or relationship, click the requirement(s) or relationship(s) in the matrix. (Use a multiple select action to select multiple requirements or relationships.)

2. Click the File menu and choose Print.
   The Print dialog box appears.

3. If you are printing selected requirements or relationships, click Selection.

4. Make any other necessary changes to the Print dialog box, and then click OK.

   Note: Use the Print button on the Views Workplace toolbar to print directly to the default printer. In this case, the entire view is printed using the default printer selections.
Deleting a View

A personal view can only be deleted by the person who created it. A project-wide view can be deleted by the person who created it or by the project manager.

To delete a view:

1. Click the File menu and choose Delete View. The Delete View dialog box appears.

2. Choose a project-wide or personal view to delete by clicking the corresponding button. A list of saved views appears.

3. Highlight the desired view from the list. The author, date of creation, and time of creation appear below the list.

4. Click OK. RequisitePro deletes the selected view.
Customizing Views

Customizing a view defines its look and content. You can:

• adjust the size of rows and columns;
• filter and sort data according to query criteria;
• select specific view properties to display.

Once a view is defined, it can be saved for future use. Saving a view saves the view properties that were customized. When a saved view is opened, it displays in the state in which it was saved.

Adjusting Row Height

Adjusting row height affects all rows in the view.

1. Click the View menu and choose Row/Column Sizing. The Row/Column Sizing dialog box appears:

   ![Row/Column Sizing dialog box]

2. Type the number of lines to display for each requirement. The maximum number of lines depends on a monitor’s display resolution.

3. Click OK. The view is modified according to your specifications.

   Shortcut: Click and hold the mouse on any border in the requirement area, then drag the row up or down according to the desired height. If the row height is already set at one line, RequisitePro will not let you drag the row up to less than one line. The Traceability Tree does not have a shortcut.
Customizing Views

Adjusting Column Width

1. Click the View menu and choose Row/Column Sizing. The Row/Column Sizing dialog box appears, as shown above.

2. Type the number of pixels (in the Attribute Matrix) or lines (in the Traceability Matrix) to display for each requirement or attribute. Parameters for column widths in different views follow.
   - **Attribute Matrix**: To set a different width for each column, drag the column to the desired width. To set an equal width for all columns, use the View menu, Row/Column Sizing dialog. The maximum screen height varies based on your screen’s resolution.
   - **Traceability Matrix**: RequisitePro determines the maximum width based on your screen’s resolution.
   - **Traceability Tree**: The column width is represented by the amount of indentation or each branch. RequisitePro dynamically changes the maximum number of pixels allowed in these columns according to the width of the requirement pane and the size of the view. Any change to the column width affects all of the columns in this view.

3. Click OK to commit these changes.

   **Shortcut**: Click and hold the mouse on any border in the attribute label area or the requirement area (the gray area at the top of each column) in an Attribute or Traceability Matrix. Drag the width left or right to the desired size. The Traceability Tree does not have a shortcut.
Resizing and Arranging Views

Use the menu commands or the buttons on the toolbar in the Views Workplace to define the size and arrange the order of a view.

Creating Cascaded Views

This feature overlaps views. Each view is displayed to the right and slightly below the preceding view. If many views are open, RequisitePro may overlap the first cascade of views with a second cascade until all open views are arranged.

Click the Window menu and choose Cascade. RequisitePro cascades the views.
Creating Tiled Views

This view arranges open views next to each other without overlap.
Click the Window menu and choose Tile. RequisitePro tiles the views.

Arranging Icons

This feature arranges the icons for all minimized views from left to right, beginning at the bottom left corner of the Views Workplace.
- Click the Window menu and choose Arrange Icons.
- RequisitePro arranges the minimized views.
Displaying View Properties

Use the Properties command to display properties associated with an active view. Each view displays distinct properties. These properties affect how the view appears and not the information contained therein.

1. Click the View menu and choose Properties. Click the following properties to display them in the view. If they are marked on the menu with a check mark, they appear in the active view.

   • Attribute Matrix:
     1. **Show Buttons** displays a button to the left of requirements and any hierarchical relationships. The button is used to expand or collapse the requirement.
     2. **Show Discussions** displays a red triangle to the right of the requirement text, indicating there are one or more discussions associated with a requirement.
     3. **Show Text** displays the first line of the requirement text.

   • Traceability Tree:
     1. **Show Buttons** displays a button to the left of requirements and any traceability and hierarchical relationships. The button is used to expand or collapse the requirement.
     2. **Show Discussions** displays an icon indicating there are one or more discussions associated with a requirement.
     3. **Show Lines** displays lines in the Traceability Tree that connect relationships.
     4. **Show Images** displays traceability relationships with arrows.
     5. **Show Root Images** displays an arrow at the root of hierarchical requirements.
     6. **Show Text** displays the first line of the requirement text.
     7. **Show Trace To** and **Trace From** display arrows in the direction of either trace to or trace from relationships, depending on your selection.
• Traceability Matrix:
  1. **Show Buttons** displays a small box or button to the left of requirements with children.
  2. **Show Discussions** displays an icon indicating there are one or more discussions associated with a requirement.
  3. **Show Text** displays the first line of the requirement text.
  4. **Show Trace To** and **Trace From** display arrows in the direction of either *trace to* or *trace from* relationships, depending on your selection.

**Saving View Properties as Default**

The **Save As Default** command saves a view layout and any properties displayed as the default when opening views of that type. This command is available for all view types. To save a view and its displayed properties as the default for views of that type:

- Click the **View** menu and choose **Properties**, then **Save As Default**.
- RequisitePro saves the view, layout, and properties for views of that type.

**Note:** Use the **Reset Default** command to reset any view properties that have been changed back to the saved default settings.
Creating and Using Queried Views

Once you have created a view, you can save it as is, or you can refine the view by querying (filtering and sorting) its information in a variety of ways.

You can filter requirements in views by limiting the values of one or more attributes or by limiting traceability. You can query requirements displayed in rows in an Attribute Matrix or Traceability Matrix, columns in a Traceability Matrix, or root requirements in a Traceability Tree.

Querying (Filtering and Sorting) Overview

Filtering restricts the information being displayed. Sorting determines the order in which information is displayed. For example, in an Attribute Matrix, you may want to view only those requirements assigned to you (filter criteria) and order requirements information from highest to lowest priority (sort criteria).

You filter and sort requirements by applying query criteria to the attributes. These criteria limit the values of the attributes and/or limit the traceability relationships. You can create a singular attribute query, so that you can see the results of each query criteria. Or you can create a multiple attribute query that filters and sorts all at once.

Note: RequisitePro does not automatically update views after you have queried. If other users have been changing data while a view is open, you can use Query Now or Refresh All to reflect those changes in your open view. Refer to Viewing Current Data on page 4-2 for more information.

You cannot query hierarchical requirement relationships that are suspect.
Filtering
Filtering data is a process by which you can limit the amount of information displayed in a view in the Views Workplace. You specify the criteria for filtering the information. You can filter requirements by specifying distinct criteria for any or all of their attributes. For example, instead of displaying all requirements, you might apply a filter such that only requirements having a high priority are displayed.

Sorting
By default, the sort order in a view is ascending by requirement tag. When you create a query that includes multiple query criteria, you can sort the criteria to determine the order in which the requirements are displayed in a view. You can also modify the sort order after you have created a query. For example, you might sort requirements by priority, high to low. Then, within priority, you might sort by date.

Working with Queries
Use the Query command to extract data from the database and present it for use in any of the three views. You can save, open, edit, print, and export queried views.

Queried views range from simple to complex. When querying most attributes in a view, you choose one requirement type at a time. If you base a query on the Trace to or Trace from attributes, you have the ability to select more than one requirement type for targets.

You control the query. To ensure the information in a queried view is current, especially if other users are working in the database being queried, refresh the database with new data (use the Refresh command on the View menu or click the Refresh button on the toolbar in the Views Workplace), then reapply the query criteria.

- By default, the Attribute Matrix view displays all attributes for any requirement type and all requirements of that type. You can display only the most necessary attributes when querying this view.
- The Traceability Matrix view displays two requirement types and the interrelationships between them.
Creating and Using Queried Views

Note: When an Attribute Matrix view or a Traceability Matrix view is queried, a filter and/or a sort is applied to the row and/or column requirements in the view.

- The Traceability Tree view displays all requirements of one type (root) and all requirements related to/from them.
  
  When a Traceability Tree view is queried, the filter and/or sort criteria are applied to the root requirements in the view.

Creating Queries

1. In the Views Workplace, open an Attribute Matrix, Traceability Matrix, or Traceability Tree view (For more information on views, refer to Chapter 4: Views.)
2. Click the View menu in the Views Workplace.
   
   The command displayed in the View menu depends on the active view:
   
   - To query row requirements in an Attribute or Traceability Matrix, select Query Row Requirements.
   - To query column requirements in a Traceability Matrix, select Query Column Requirements.
   - To query the root requirements in a Traceability Tree view, select Query Root Requirements.

   The Select Attribute dialog box appears.

   ![Select Attribute dialog box](image)

   Note: Both requirement attributes you have created and system attributes created by default in RequisitePro are included in the list.
3. Select the attribute that you want to use to query, and click OK.
The **Query Requirements** dialog box appears. Depending on the type of attribute you selected (list-type or entry-type), the box contains a specific set of criteria for you to define.

4. For list-type attributes, select one or more values.
   For entry-type attributes, mark an option (i.e. *includes*, *equals*) and type in the value.

5. Enter a Sort Order: **None**, **Ascending**, or **Descending**.

6. Enter When Traced criteria, if applicable. The When Traced option is only available when traceability attributes *trace to* or *trace from* are queried.
   For hierarchical requirements, traceability queries automatically include the parent if the child participates in a traceability relationship.

7. Click **OK**. The **Query [Row/Column/Root] Requirements** dialog box reappears.

8. To add other query criteria, click **Add** and repeat steps 3 through 7.
   Note: The logical operator *and* is assumed between multiple attributes.

9. Click the **Retain Hierarchical Display** check box to include the parents of child requirements that match the filter criteria, even though the parents do not match.

Note: The query engine ignores hierarchical relationships, unless you mark the **Retain hierarchical display** check box. (For more information on parent-child requirements, refer to *Hierarchical Relationships* on page 9-1.)

10. When the query is built, click **OK** in the dialog box. RequisitePro updates the view with the query results.

Note: To run the query again, click the **View** menu and click **Query Now**. (For more information on **Query Now**, refer to *Viewing Current Data* on page 4-2.)
Searching for Requirements in the Database, Documents, and Views

Modifying Queries

After you have created a query, you can make changes to the query criteria. With the view open, do the following:

1. To open the **Query [Row/Column/Root] Requirements** dialog box (depending on your displayed view), click the View menu and choose **Query Row Requirements**, **Query Column Requirements**, or **Query Root Requirements**.

2. Select the query criteria you want to modify and click **Modify**.

3. The **Query Requirements** dialog box appears. (The dialog box that appears depends on whether the attribute is a list-type or entry-type.) Follow steps 4-10 above in *Creating Queries*.

Deleting Queries

1. In the Views Workplace, click the View menu and choose **Query Row Requirements**, **Query Column Requirements**, or **Query Root Requirements**.

   The **Query [Row/Column/Root] Requirements** dialog box appears (depending on your displayed view).

2. In the **Query Criteria** list, select the query criteria you want to delete.

   Note: The order of this list determines the order in which RequisitePro filters and sorts the criteria. Be aware that deleting a query from the list may affect the results of subsequent queries.

3. Click **Remove**. Click **OK** to close the dialog box.

Searching for Requirements in the Database, Documents, and Views

RequisitePro provides two methods for finding requirements:

- The **Go To** command does a global search of the database, quickly finds a requirement, and displays it in its location (document or database).

- The **Find Requirement** searches for a requirement in the active view or document.
Using Go To to Search the Database for a Requirement

1. Click the **Requirement** menu on the Tool Palette and choose **Go To**. The **Go To Requirement** dialog box appears:

2. Select the requirement type from the **Requirements of Type** list box. If you do not know the requirement type, select **All Requirement Types**.

3. Select the location of the requirement from the drop-down list in the **Located in** edit box. Choose **All locations**, **Database only**, or a specific document from the list.

   Note: Click the **Find** button to open the **Find Requirement** dialog box, which you can use to locate a specific tag number and/or requirement text.

4. Highlight the requirement and click **OK**. RequisitePro performs one of the following operations:

   - If the requirement is in an unopened document, RequisitePro opens the document and highlights the requirement.
   - If the requirement is in an open document, the Word Workplace appears with the document active and the requirement highlighted.
   - If the requirement is in the database only, the **Requirement** dialog box appears so you can examine or modify its description, attribute values, or traceability relationships.
Using Find Requirement to Search an Active Document or View

1. Do one of the following:
   • From a document, click the Requirement menu on the Tool Palette and choose Find.
   • From a view, click the Requirement menu on the Tool Palette and choose Find. Or, click the Find requirement button.

   The Find Requirement dialog box appears:

   ![Find Requirement Dialog Box]

2. Type the text of the requirement in the Text Search field.

3. The next step is to establish a search parameter. The dialog box offers three different ways to search for text:
   • Mark the Match case check box for a case-sensitive search.
   • Mark the Use * as wildcard check box for a wildcard search. The asterisk matches 0 or more characters.
   • Mark the Find whole words only check box for an exact word match.

4. Mark the Up or Down button to specify a direction to search the view or document.

5. Click Find Next to launch the search. RequisitePro searches the current view or document for the requirement that satisfies the parameters established in the dialog box.
   • If the requirement is found, RequisitePro highlights the requirement and displays it in context.
   • If the search is performed in a view and all requirements in the view are not expanded, RequisitePro expands the requirements in the view to display the results of the search.
   • If the requirement is not found, RequisitePro returns to the requirement from which the search began.
Shortcuts to a Document-Based Requirement from a View

When you are working in the Views Workplace, you can switch to the Word Workplace to read the document-based requirement in context or to modify it. In the Views Workplace, highlight the requirement to display and do the following:

- Press the right button on the mouse and choose Go To from the shortcut menu that appears, or
- Double-click the requirement.

Note: This shortcut works only if the default Double-click to go to document option is marked in the Tools/Options dialog box.

RequisitePro opens the Word Workplace and highlights the requirement in the document.

Reviewing a Project with Cross-Project Traceability

Sometimes, when you open a project, RequisitePro connects to an external project and displays both projects. In this case, the projects have been connected to one another, and cross-project traceability relationships may exist. You can review the requirements in both projects and their change-managed relationships in the Views Workplace.

Cross-project traceability creates traceability relationships between requirements that reside in different projects. This feature establishes connectivity among projects that were divided into subprojects or projects that relate to each other or share a set of requirements. (For more information on cross-project traceability, see Setting Up and Modifying Cross-Project Traceability on page 15-12.)

Results of Cross-Project Traceability

Once cross-project traceability relationships are established, the following can occur:

- External requirement types can be queried for display in views.
- If a requirement that is traced to requirements in other projects is deleted, RequisitePro updates the other projects to reflect the change. If the traceability relationship in the external project cannot be deleted, the relationship is updated when connectivity is established between the projects.
Searching for Requirements in the Database, Documents, and Views

• If a requirement modification causes the relationship to become suspect, and the requirement is traced to or traced from requirements in other projects, RequisitePro updates the projects to reflect the suspect link. If the traceability relationship in the external project cannot be modified, the relationship is updated when connectivity is established between the projects.

• If a link between an internal and external requirement is marked as suspect, cleared as suspect, or created or removed by the user, RequisitePro updates both the internal and external projects to reflect the change.

• RequisitePro checks for circularity when external relationships are created. The circular check references internal requirements and first-level external requirements.

Displaying External Requirements
Requirements in the current project are distinguished from requirements in external projects by the project prefix. External requirements appear as follows:

• The Traceability tab in the Requirement dialog box displays only the relationships that are related to the current project. The General tab displays external requirement information as read-only.

• The Find Requirement dialog box displays a list of requirement types for the current project and each externally mapped project.

• The New View dialog box displays requirement types from the current project and any external projects. If the Attribute Matrix view is selected, only the internal requirement types are available for selection. A full Attribute Matrix view of external requirements is not provided because of performance considerations.

• The Attribute Matrix displays all internal and external traceability relationships in the Trace-to-from columns.

• The Traceability Matrix displays all internally and externally mapped requirements of a single requirement type in the rows and columns.

• The Traceability Tree displays all internal and external requirements traced to or traced from a requirement. The first level cross-project traceability level displays. So, if an internal requirement is traced to an external requirement, the external requirement is displayed in the tree. Other requirements the external requirement traces to do not appear.
Displaying Requirement Relationships in Exported Views

Requirements in exported views with cross-project traceability appear as follows:

- An exported CSV file indicates that a traced to/from requirement exists as displayed in the view.
- An exported Word file indicates a traced to/from requirement exists as displayed in the view.

For more information on exported views, refer to Exporting Requirements on page 11-25.
CHAPTER 6

Discussions

Discussions let you address comments, issues, and questions to a group of participants that you define. Discussions can be associated with one or more specific requirements, or refer to the project in general. A discussion item is either the initial discussion topic or a response. A participant can respond to either the initial discussion text or to another response.

Understanding Discussions

Viewing Discussions

All project users can read discussion items in RequisitePro, whether they are discussion participants or not. Any participants who have an e-mail address specified in their user information can read discussion items via e-mail. See Configuring E-mail for Discussions on page 6-2 for more information.

When a user opens a project, RequisitePro displays an icon on the Tool Palette status bar to indicate that there are new discussions or responses associated with that project or its requirements.

Responding to Discussions

When a user responds to the discussion, the response is added to the project in RequisitePro. In addition, the response is sent to all participants who have an e-mail address specified in their user information.

If you are the discussion author or a project manager, you can restrict the discussion to participants. In this case, all project users can still read discussion items, but only participants can respond to the discussion.


**Configuring E-mail for Discussions**

RequisitePro offers the capability of communicating with a group of discussion participants regarding comments, issues, and questions related to one or more requirements, or related to the project in general. When enabled for e-mail, this feature will automatically generate an e-mail copy of any discussion item you enter (a new discussion or a reply) and send it to all discussion participants with valid e-mail addresses.

Discussion e-mail is enabled and configured in several ways:

- Enter an e-mail address in Project Security on the Project menu.
- Configure an outbound e-mail service on the Tools menu.
- Configure inbound and outbound mail for all users with e-mail addresses using the Rational E-mail Reader application.

**Entering E-mail Addresses in Project Security**

All RequisitePro users can add or edit their own e-mail addresses within RequisitePro; however, only project managers with administrator permissions can add or edit other users’ information.

See the procedure *Modifying Your Password, User Name, or E-mail Address* on page 3-8 for information on entering your own e-mail address in Project Security. Administrators can use the same procedure for entering or modifying all users’ e-mail addresses.

**Configuring Outbound E-mail for Discussions**

Use the E-mail Setup option to configure an e-mail service for your outbound e-mail to other discussion participants. When you initiate or reply to a discussion item from within the RequisitePro Discussions dialog box, this feature automatically sends copies of the discussion items to the RequisitePro database and to all participants with valid e-mail address in their RequisitePro user information.

Note: This configuration option is not required if your system administrator has configured inbound and outbound e-mail using the Rational E-mail Reader. The Rational E-mail Reader application offers full e-mail integration with RequisitePro, allowing participants to reply to the discussion items using their e-mail, as well as from within RequisitePro.
To configure your outbound e-mail:
1. On the Tool Palette, click the Tools menu and choose E-mail Setup. The E-mail Setup dialog box appears.
2. Click the Enable E-mail Notification check box to automatically generate outbound e-mail (messages from you to other discussion group participants) when you create or reply to a discussion item in RequisitePro. Clear the check box to disable outbound e-mail messages.
3. Click the down-arrow at the E-mail Provider field and select the e-mail protocol that is used on your LAN:
   • SMTP/POP3
   • MAPI
4. For SMTP/POP3, type the following:
   • your SMTP server name
   • your e-mail address, such as “yourname@yourcompany.com”
   • your name as it should appear in discussion group notices
5. For MAPI, type your MAPI profile.
6. Click OK.

Configuring E-mail Using the Rational E-mail Reader

The Rational E-mail Reader offers full e-mail integration with RequisitePro by associating an e-mail handler with each RequisitePro project. Initial discussion items and replies are automatically stored in the RequisitePro database and sent to discussion participants via e-mail. Participants can reply to the discussion items using their e-mail, as well as from within RequisitePro. This configuration is typically performed by a system administrator.

Prior to configuring an e-mail handler for a specific Rational product, the E-mail Reader requires that the administrator identify an e-mail protocol (SMTP/POP3 or MAPI). Your RequisitePro administrator can then configure inbound and outbound e-mail for a specific RequisitePro project. The enabled e-mail allows discussion participants to read and reply to discussion items via e-mail. Discussion participants must have an e-mail address specified in their RequisitePro user information in order to receive discussion-related e-mail.
Creating Discussions

You can create a new discussion at any time.

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button on the Tool Palette (whether it shows there are new discussions or not).

   The Discussions dialog box appears:

2. Click Create. The Discussion Properties dialog box appears:

3. Click the General tab.

4. Enter a subject (required). The subject should be brief, but descriptive enough to inform other users of the discussion’s contents.
5. Enter text. The text you enter will become the first item in the discussion. Open the discussion by raising an issue, making a comment, or asking a question.

6. Click the **Participants** tab. Add users and groups. (See *Creating and Modifying Discussion Participants Information* on page 6-15.)

7. Click the **Requirements** tab and add requirements. (See *Creating and Modifying a Discussion's Requirement Information* on page 6-17.)

Note: If you have filtered or displayed only discussions associated with specific requirements, those requirements are automatically listed on the **Requirements** tab. (See *Displaying, Filtering, and Sorting Discussions* on page 6-11.)
8. Click **OK**.
The discussion is opened and the message is sent to all participants who have an e-mail address specified in their user information. An icon on the Tool Palette also notifies users that there is a new discussion associated with that project.

**Viewing and Modifying Discussion Properties**

**To view discussion properties:**

1. Click the **Project** menu on the Tool Palette and select **View Discussion**. Or, click the **Show Discussions** button.
The **Discussions** dialog box appears
2. Select a discussion and click the **Properties** button.

Note: Only the originator of the discussion and an administrator can modify a discussion’s properties.

The **Discussion Properties** dialog box lets you do the following:

- Use the **General** tab to view the discussion subject and text, or enter subject and text when you are creating a new discussion.
- Use the **Attributes** tab to view the discussion’s author, the date and time the discussion was created, and the discussion’s current priority and status. Only the priority and status can be modified.
- Use the **Participants** tab to view or modify listings of the discussion’s participants, divided by users and groups, and whether or not the discussion is restricted to participants.
- Use the **Requirements** tab to determine which requirements are associated with a discussion. Note that a discussion does not need to address any requirements specifically. However, if a specific requirement is addressed, it should be associated using this tab.

**Notifying Participants about a New Discussion**

When you create a new discussion, you do not have to do anything to notify participants about the discussion, provided that you have:

- entered a subject and topic text in the **Discussion Properties** dialog box at the **General** tab, and
- specified participants in the **Discussion Properties** dialog box at the **Participants** tab.
Reading Discussions

Note: In a new discussion, the discussion author is automatically included as a participant.

After you have completed these two tasks and clicked OK in the Discussion Properties dialog box, RequisitePro adds the discussion to the project and sends an e-mail message to each participant for whom an e-mail address has been specified in the participant’s user information. The message contains the subject and text you entered at the General tab.

Participants can also read the discussion and its responses in RequisitePro. When a user opens a project, RequisitePro displays an icon on the Tool Palette to indicate that there are new discussions or responses associated with that project and/or its requirements.

Reading Discussions

The Discussions dialog box helps you keep track of which discussion items you have read and which you have not.

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button.
   The Discussions dialog box appears.

2. In the discussions list, click a discussion.
   An expand/collapse indicator is displayed to the left of discussions with responses. Unread discussion items are shown as bold text. Items you have read are shown as normal text.

3. Click an item to read it. The item’s text displays in the lower portion of the dialog box.
   After approximately 5 seconds, RequisitePro changes the item from bold to normal text, indicating that it has been read. If you select another item before approximately 5 seconds elapse, RequisitePro leaves the previously selected item bold, indicating that it is still unread.

4. To manually mark an item as read or unread, right-click the item and select Mark Read or Mark Unread on the shortcut menu that appears.
Discussions

Responding to Discussions

You can respond to a discussion either in RequisitePro or in your e-mail application.

Note: If you are not a discussion participant, you can respond to the discussion only if the Restrict To Participants check box is cleared in the Discussion Properties dialog box at the Participants tab. Only the discussion author and members of the Administrators group can modify this option.

Responding to Discussions in RequisitePro

To respond to a discussion using the Discussions dialog box in RequisitePro:

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button.

   The Discussions dialog box appears:

2. In the discussions list, click a discussion or response to a discussion. The discussion text appears in the lower portion of the Discussions dialog box.

3. Click Reply.
Responding to Discussions

The **Discussion Response** dialog box appears:

![Discussion Response dialog box]

The default subject is “RE: [previous discussion item's subject].” You can change the subject.

4. Enter the text of your response.
   
The text automatically wraps at the end of each line you type. You can use Ctrl-C to copy selected text from another application or document, and Ctrl-V to paste it into the response text box. Text formatting, such as bold and underline, is not available in the **Discussion Response** dialog box. You cannot attach files to the response.

5. Click **OK**. The **Discussions** dialog box is displayed again. RequisitePro updates the associated project and discussion, and then sends your response to all participants who have an e-mail address specified in their user information.

**Responding to Discussions Using E-mail**

You can respond to a discussion using your e-mail application. Depending on whether your system administrator has enabled inbound e-mail using the Rational E-mail Reader, one of two conditions apply:

- If inbound e-mail is enabled, your reply is delivered to all discussion participants and stored in the RequisitePro database. It is then accessible from within RequisitePro.
- If inbound e-mail is not configured, your reply is delivered to the recipients you select, but it is not stored in the RequisitePro database.
To respond to a discussion using your e-mail application:

1. In your e-mail application, open the message containing the discussion item to which you wish to reply.
2. Select the reply option.
3. Use the default recipient provided.
   
   Note: If inbound e-mail is enabled, messages will arrive from an e-mail handler that is specific to a RequisitePro project. In this case, simply reply to the sender. If inbound e-mail is not enabled, you can reply to all recipients; however, in this case, your message will not be stored in the RequisitePro discussion. You can add recipients in either case.

4. Use the default subject provided. Do not modify the subject.
5. Enter the text of your response. Do not type below the line: “Text below this line is not included in the discussion response.” In addition, do not delete this line or anything below it.

   RequisitePro uses this line to indicate which text is your response and which text is already included in the discussion. If you delete the line, your reply includes both your new text and any text that was below the deleted line.

   Note: Attachments are not supported in discussions. Any attachments you include will not be added to the discussion in the RequisitePro database.

6. Send the e-mail message. The message is sent to RequisitePro, which updates the associated project and discussion, and then sends your response to all participants who have e-mail.

   Note: Discussion replies cannot be modified after they have been sent. This prevents conflicts when the reply text is included in another reply. If you want to add an explanation regarding your message, you can do so by creating another reply.
Displaying, Filtering, and Sorting Discussions

Displaying Discussions Associated with a Single Requirement

You can open the *Discussions* dialog box to display only the discussions associated with a specific requirement. Or, you can open the *Discussions* dialog box to display all open discussions.

To display only discussions associated with a requirement:

1. Select a requirement.
2. Open a discussion.
   - In the Views Workplace, select a requirement and then do one of the following:
     - Click the *Requirement* menu on the Tool Palette or in the Views Workplace and then choose *Discussions*.
     - Click the *Discussions* icon to the right of the requirement.
     - Right-click the requirement, and then click *Discussions* in the shortcut menu that appears.
     - In a Word document, select a requirement and then click the *Requirements* menu in the Word Workplace or the Tool Palette. Choose *Discussions*.

3. The *Discussions* dialog box appears, showing only those discussions associated with the specified requirement.

Note: To display all discussions, do one of the following:

- click *Filter*, clear the *Requirement* check box, and then click *OK*, or
- close the dialog box, click the *Project* menu on the Tool Palette and choose *View Discussions*.
Discussions

Filtering Discussions

You can specify which discussions you wish to view in the Discussions dialog box, based on text, requirement, users, priority, and status.

To filter discussions, do the following:

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button.
   
   The Discussions dialog box appears, showing all open discussions:

2. Click Filter. The Discussion Filter dialog box appears:

3. To display discussions containing specific text in their subjects, select the Subject Text check box, and then enter the text in the text box.
Use * (asterisk) in the text if you want RequisitePro to find discussions using the wildcard character * to match one or more characters in the search text. For example, if this check box is selected and you enter the text *document*, RequisitePro finds discussions containing document, documents, documented, undocumented, etc.

4. To display discussions with which one or more requirements are associated, mark the Requirement check box, and then enter the requirements by which you wish to filter (separated by commas) in the text box. For example, enter PR1, SR22, TST114 to include all discussions with which the requirements PR1, SR22, or TST114 are associated.

Note: Alternatively, click the adjacent ... button to open the Select Requirements dialog box, which you can use to select requirements by name.

5. To display discussions for which a particular user is a participant, select the Participant check box, and then select the desired user name in the list.

Note: You can select the name of a user who is a member of a group. RequisitePro will find discussions for which that group’s members are participants, including the selected user.

6. To display discussions with a specific priority, select the Priority check box, and then select High, Medium, or Low in the list.

7. To display open or closed discussions, select the Status check box, and then select Open or Closed in the list.

8. Filter by more than one option by repeating any of steps 3 - 7 above.

9. Click OK.

The Discussions dialog box is displayed again, showing only the discussions that match the filters set above. The filter settings are displayed next to the Filter button in the dialog box.
Discussions

Sorting Discussions

In the **Discussions** dialog box, you can change the sort order in which discussions appear.

1. On the Tool Palette, click the **Project** menu and choose **View Discussions**. Or, click the **Show Discussions** button.
   The **Discussions** dialog box appears.

2. In the discussions list, click the column heading by which you want to sort the discussions.
   For example, to sort discussions alphabetically by subject, click the **Subject** column heading.

3. To reverse the sort order, click the column heading again.

Printing Discussions

You can print discussion items. The printout shows the discussion item’s subject, text, author, and creation date and time. The printout also shows information about the associated discussion, including the discussion’s priority, status, requirements, and participants.

1. On the Tool Palette, click the **Project** menu and choose **View Discussions**. Or, click the **Show Discussions** button.
   The **Discussions** dialog box appears.

2. In the discussions list, click one or more discussion items. (Use a multiple select action to select more than one item.)

3. Click the **Print** button. A **Print** dialog box appears.

4. Click **OK**.

Modifying Discussions

Viewing and Modifying Discussion Attributes

The **Attributes** tab in the **Discussion Properties** dialog box shows the discussion’s author, the date and time the discussion was created, and its current priority and status. These properties can be modified by the discussion author and project administrators only.
To modify discussion attributes:

1. On the Tool Palette, click Project and choose View Discussions. Or, click the Show Discussions button. The Discussions dialog box appears.

2. Select a discussion, and then click Properties. Alternatively, click Create to create a new discussion.

3. Click the Attributes tab.

4. Click the down arrow at the Priority field and select a priority from the drop-down list.
   
   Note: You can only change a discussion’s priority if the discussion is open.

5. If you are modifying a discussion, change Status to Open or Closed. (You cannot change the status of a new discussion.)

Creating and Modifying Discussion Participants Information

The Discussion Properties dialog box, Participants tab lets you determine which users and groups are included in the discussion, and whether or not the discussion is restricted to participants.

Any user can view the Participants tab, but only the discussion author and project administrators can modify its options, with the following two exceptions:

- If the Restrict To Participants check box is cleared, you can add yourself to the Users list.
- Regardless of whether or not the Restrict To Participants check box is selected, you can remove yourself from the Users list.

Note: However, if you are a member of a group that participates in the discussion, you cannot remove yourself from the group. A RequisitePro administrator must remove you from the group.

The options in this dialog box can be modified only if the discussion is open.
Discussions

To modify participants information:

1. On the Tool Palette, click the *Project* menu and choose *View Discussions*. Or, click the *Show Discussions* button. The *Discussions* dialog box appears.

2. In the discussions list, click an open discussion and click *Properties*; or click *Create* to create a new discussion. The *Discussion Properties* dialog box appears:

3. Click the *Participants* tab.

4. To add a user, click *Add* below the Users list. The *Project Users* dialog box appears:

5. Select a user from the list, then click *OK*. (Use a multiple select action to select more than one user.)

   Note: For a new discussion, the discussion author is automatically included as a participant.
6. To add a group, click Add below the Groups list. The **Project Groups** dialog box appears:

![Project Groups dialog box]

7. Select a group from the list, then click **OK**. (Use a multiple select action to select more than one group.)

   **Note:** If a user is a member of a group and you add the group to the Groups list, you do not need to add the user individually to the Users list.

8. To remove users, click the user names in the Users list, then click **Remove** below the **Users** list.

9. To remove groups, click the group names in the Groups list, then click **Remove** below the **Groups** list.

10. To restrict the discussion to participants only, select the **Restrict To Participants** check box. Only participants will be able to respond to the discussion, although all users can read it in RequisitePro.

11. Click **OK** to close the dialog box.

### Creating and Modifying a Discussion's Requirement Information

The **Discussion Properties** dialog box, **Requirements** tab lets you determine which requirements are associated with a discussion. Note that a discussion does not need to address any requirement specifically. However, if a specific requirement is addressed, it should be associated using this tab.

Any user can view the **Requirements** tab, but only the discussion author and members of the Administrators group can modify its options. The options in this dialog box can be modified only if the discussion is open.
Discussions

To modify a discussion’s requirement information:

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button. The Discussions dialog box appears.

2. In the discussions list, select an open discussion and click Properties, or click Create to create a new discussion. The Discussion Properties dialog box appears.

3. Click the Requirements tab.

4. To add a requirement, click Add. The Select Requirements dialog box appears:

5. Select a requirement type from the Requirements of type list. Note: Requirements with pending tag numbers do not appear in this list.

6. Select a location from the “Located in” list.

7. Select a requirement from the list. (Use a multiple select action to select multiple requirements.)

8. To locate a specific requirement, click Find.

9. When you have finished selecting requirements, click OK.
The **Discussion Properties** dialog box reappears with the specified requirement shown in the Associated Requirements list:

10. To remove a requirement, click the requirement in the **Associated Requirements** list, then click **Remove**.

11. To display a requirement’s properties, click **Properties**. The **Requirement** dialog box appears, showing the selected requirement’s properties.

12. Click **OK**. To close the **Discussion Properties** dialog box, click **OK**.

**Creating and Modifying a Requirement’s Discussion Information**

You can view and create discussions from within the **Requirement** dialog box at the **Discussions** tab.

1. Do one of the following:
   - In the Word Workplace, select the requirement in an opened document. On the Tool Palette, click **Requirement** and choose **Properties**.
   - In the Views Workplace, select the requirement in a view. Click **Requirement** and choose **Properties**.
   
   The **Requirement** dialog box appears.

2. Click the **Discussions** tab. A list of all discussions associated with the requirement is displayed.

3. To create a new discussion associated with this requirement, click **Create**.

4. To read a discussion item, select the discussion, and then click **View**.
Discussions

5. To view the properties for a selected discussion, select the discussion and click Properties.

Note: If the requirement is not saved in the database yet, the Create, View, and Properties buttons are disabled, regardless of how you accessed the Requirement dialog box. Save the document containing the requirement, then open the dialog box again.

Closing Discussions

If you are the discussion author or a project administrator, you can close a discussion if it is no longer needed. Closed discussions are filtered out of the Discussions dialog box by default. A discussion must be closed before you can delete it.

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button. The Discussions dialog box appears.
2. In the discussions list, click the open discussion.
3. Click Properties. The Discussion Properties dialog box appears.
4. Click the Attributes tab.
5. Click the down arrow at the Status field and select Closed from the drop-down list.
6. Click OK. The Discussions dialog box reappears. When the discussion is selected, the Delete button is enabled, indicating that the discussion is closed and can be deleted.

Deleting Closed Discussions

If you are the discussion author or a project administrator, you can delete a closed discussion. A discussion must be closed before you can delete it.

1. On the Tool Palette, click the Project menu and choose View Discussions. Or, click the Show Discussions button. The Discussions dialog box appears.
2. In the discussions list, click a closed discussion.
3. Click Delete. A message appears, asking you to confirm the deletion.
4. Click Yes.
A RequisitePro requirements document is a Word file *created in* RequisitePro and integrated with the project database. Requirements created outside of a project document can be imported or copied into a project document.

When you create a new project document, RequisitePro associates the document with the project that is open. This association is used to update the database and synchronize the revision numbering of the project and document. The document’s name, location, document type, and revision information are stored in the project database.

**Creating a Project Document**

**To create a document in a project:**

1. On the Tool Palette, click the **Document** menu and choose **New**; or in the Word Workplace, click the **RequisitePro** menu, point to **Document**, and click **New**.

   The **Document** dialog box appears:
2. Type the name of the document in the **Name** field (64 characters maximum).

3. Type a brief description of the document’s purpose or contents in the **Description** field.

4. Type a file name in the **Filename** field. You do not need to give it an extension; RequisitePro assigns an extension according to the Document Type selected.

5. Click the **Show Tags** check box to display requirement tags in the new document. Clear this box to hide the tag text.

6. Type a location for the file in the **Directory** field, or click **Browse** to select a directory.

7. Click the down arrow at the **Document Type** list and select a document type to assign to the new document.

8. Click **OK**. The new document is open and ready to be edited.

   **Note:** The document must be saved for the requirements to be committed to the database.

---

**Saving a Project Document**

When a document is saved in RequisitePro, all modifications to the document properties, such as its logical name, revision number, label and change description, are saved to the project database. New requirements and changes made to existing requirements are committed to the database and are retained in the document. Requirements that were deleted from the document are deleted from the database.

**To save a project document:**

1. Do one of the following:
   - click the **Save the current document** button on the Tool Palette; or
   - click the **Document** menu on the Tool Palette, and choose **Save**; or
   - in the Word Workplace, click the **RequisitePro** menu, point to **Document**, and click **Save**.
Opening a Document After a Project is Open

If a requirement in the document was modified, the **Change Description** dialog box appears and prompts you to type a reason for the change:

1. Type an explanation of the modifications in the **Change Description** field.
2. Click the **Apply to all...** check box, if the change description applies to all requirements that were changed in the document.
3. Click **OK**.

**Opening a Document After a Project is Open**

**To open a project document:**

1. Do one of the following:
   - on the Tool Palette, click the **Open a project and documents** button, or
   - click the **Document** menu and choose **Open**, or
   - in the Word Workplace, click the **RequisitePro** menu, point to **Document**, and click **Open**.

   The **Open Project and Documents** dialog box appears.
Documents

The **Open Project and Documents** dialog box displays a list of projects available in your catalog. Beneath the Projects list box, a second list box displays the documents that are associated with project you select.

2. Select a project from the project list. A list of the project’s documents appears in the document list.

   Only one project can be open at a time. If you try to open another project and its documents while working in a project, RequisitePro prompts you to save any modifications, closes the current project and its associated documents before opening the new project and documents.

   **Note:** For more information on options for controlling access by other users when the project and documents are open, refer to *Controlling User Access to a Document* on page 14-1.

3. Select one or more documents to open and click **OK**. RequisitePro launches Word and opens the documents.
Closing and Saving a Project Document

To close a project document:

1. Click the Document menu and choose Close, or in the Word Workplace, click the RequisitePro menu, point to Document, and click Close. If modifications were made to the document that were not saved, the Document Changed dialog box appears:

2. Do one of the following:
   • To accept the modifications and save the document, click Yes.
   • To abandon the modifications and leave the document as is, click No.
   • To return to the document without closing, click Cancel.
   • To review changes to the document, click the Review Changes button. The Document Changes dialog box lists changes, as described below.

Note: If you changed one or more requirements in the document, the Change Description dialog box appears (whether you selected Yes or Review Changes above). You have the option to record reasons for changing each requirement.

Reviewing and Changes Before Closing a Document

When closing a document that has been modified, the Document Changed dialog box presents you the option of reviewing the changes.

To review modifications to a document:

1. Follow steps 1 and 2 above and click the Review Changes button.
   If you have changed one or more requirements in the document, the Change Description dialog box appears. You have the option to record reasons for changing each requirement.
   Then the Document Changes dialog box lists all modifications to the document.

2. Click OK to save the changes once you have reviewed them.
Changing the Location of a Project Document

New documents are stored in the project directory by default. Documents can be created in or moved to any directory on the file system. All documents associated with the project are included in your catalog regardless of where they are stored.

To change the location of a project document:

1. On the Tool Palette, click the Document menu and choose Properties, or in the Word Workplace, click the RequisitePro menu, point to Document, and click Properties.

   The Document dialog box appears. On the General tab, the document file name and location appear in the Directory edit box.

2. Click Browse to change the location of the file. The Browse for Folder dialog box appears:

3. Select a new location for the document. Click a folder to open it.

4. Click OK to accept the location and close the Browse for Folder dialog box.

5. Click OK to close the Document dialog box.
Modifying Document Information

To modify information in an open project document:

1. On the Tool Palette, click the Document menu and choose Properties, or in the Word Workplace, click the RequisitePro menu, point to Document, and click Properties. The Document dialog box appears.
   - On the General tab, you can change the name of the document, its description, and the directory in which it is stored. You cannot change its logical name or its document type.
   - On the Revision tab, you can enter a Change description. All other fields are populated by RequisitePro.
2. Modify the document’s information and click OK.
3. Click the Document menu on the Tool Palette again and choose Save.

Working With Microsoft Word

Saving a RequisitePro Document as a Word Document

RequisitePro includes an option to save a project document as a Microsoft Word document that is independent of the project. This allows you to attach the document to e-mail or share the document with someone outside of your work group.

When you choose this option, RequisitePro makes a copy of the active requirements document and saves it as a Word file. The resulting Word document retains the look and feel of the original requirements document and even includes bookmarks and tags used by RequisitePro to identify requirements.

To save a project document as a Word document:

1. On the Tool Palette, click the Document menu and choose Save As, or in the Word Workplace, click the RequisitePro menu, point to Document, and click Save As. The Save As dialog box appears.
2. Specify a destination for the new copy of the document.
3. Accept the default name in the File name field, or type a file name and .doc extension for the document.
4. Click Save.
Managing Microsoft Word Documents

While working in RequisitePro, you can create, open, modify, save, and close Word documents that are independent from RequisitePro. Use the standard menu options within Word to manage these Word documents.

**Note:** RequisitePro documents are associated with projects, managed from the Document menu on the Tool Palette or the RequisitePro menu in the Word Workplace, and saved in RequisitePro format by default.

Closing Microsoft Word

To close Word without closing RequisitePro, click the Window menu on the Tool Palette and choose Close Word.

Working With Documents Offline

Offline authoring lets requirements authors and project managers use a project document outside of RequisitePro (i.e., offline).

When you take a document offline, RequisitePro creates a copy of the document in the directory you specify. The original is still stored in RequisitePro, but it is changed to a read-only document. Other users can view the document in RequisitePro, but they cannot edit it until you bring it back online.

When you take a document offline, RequisitePro includes Microsoft Word macros in the document. These macros allow you to add and delete requirements in the offline document.

**Note:** You must have Microsoft Word 97 to include the Requisite Pro macros in the offline document. You can edit the document offline using Word 95 or later, but you will not have macros for creating and deleting requirements unless you use Word 97.

**Note:** Do not rename documents while they are offline. The original file name is necessary for recognizing the offline document within RequisitePro.

When you bring the document back online, RequisitePro replaces the read-only document with the modified document. Alternatively, you can elect to cancel the offline process. In this case, RequisitePro restores the original document, removing its read-only state, so all requirements authors and members of the Administrators group can again modify it within RequisitePro.
Taking Documents Offline

1. On the Tool Palette, click Document, and then click Offline Documents.
2. In the Display Types list, select a document type.
3. Click the document you want to take offline. (Use a multiple select action to select more than one document.)
4. Click Take Offline. The Take Offline Information dialog box appears:

   ![Take Offline Information dialog box](image)

   5. In the Reason text box, type a reason for taking the document offline.
   6. In the Location field, enter the directory path where you want to store the document. Or, click Browse to locate the directory.
   7. Click OK.

Determining Whether a Document is Offline

To check whether a document is offline:

- On Tool Palette, click Document, and then click Open.
- The Open Project and Documents dialog box appears. In the Select Documents list, offline documents are followed by the word “(offline).”

To learn more about an offline document:

- Click the document in the Select Documents list, and then click Offline Info.
- The Offline Information dialog box appears, showing the document name, the user who took the document offline, offline date and time, location, and reason the document was taken offline.
Modifying Offline Documents

You modify an offline document in the same manner as you would any other Microsoft Word document. All Word features and options are available for your use when editing a RequisitePro offline document. In addition, you can add and delete RequisitePro requirements in an offline document.

In order to enable the Word macros that create a RequisitePro menu in the offline document:

- Check the Tool/Option dialog box and clear the “Save as RTF” check box.
- Be sure to save all requirements documents in Word 97 format.

**Note:** You must have Microsoft Word 97 to include the RequisitePro macros in the offline document. You can edit the document offline using Word 95 or later, but you will not have macros for creating and deleting requirements unless you use Word 97.

When you open the offline document in Word, make sure that you enable the Word macros. These macros allows you to add and delete requirements in the offline document.

You can modify requirement text in an offline document. When you bring the document back online and open it in RequisitePro, RequisitePro prompts you to enter a reason for the changes to the requirement text.

**Note:** Do not rename documents while they are offline. The original file name is necessary for recognizing the offline document within RequisitePro.

Creating Requirements in Offline Documents

Mark requirement text in an offline document in the same way you would if the document were online. The RequisitePro macro stylizes the requirement text with a double underline and notifies you that a requirement was created. When you bring the document back online, RequisitePro gives the requirement a number and default attributes. You can then modify the requirement in the Requirement dialog box.

**To mark text as a requirement in an offline document:**

(You must have saved the document in Microsoft Word 97 to use this macro.)

1. Highlight the information to define the requirement.
2. Click the **RequisitePro** menu, and then click **Requirement**.
3. Click **Create**.
Deleting Requirements in Offline Documents

Delete a requirement in an offline document in the same way you would if the document were online. When you delete a requirement, RequisitePro does not remove the requirement text from the document, but it is no longer recognized as a requirement. RequisitePro removes the requirement color and style settings and replaces them with the document default style.

When you bring the document back online, RequisitePro notifies you regarding the requirements you have deleted, and asks you if you want to update the online document with the changes. If you decline, RequisitePro does not bring the document back online.

To delete a requirement in an offline document:
(You must have saved the document in Microsoft Word 97 to use this macro.)
1. In the offline document, click anywhere in a requirement.
2. Click the RequisitePro menu, and then click Requirement.
3. Click Delete (Unmark).
4. To undo a delete operation, click Edit, and then click Undo. Click Undo until the requirement is completely restored.

In an offline document, you can only delete one requirement at a time.
Bringing Offline Documents Back Online

If you are the offline author or an administrator, you can bring an offline document back online.

1. On the Tool Palette, click Document, and then click Offline Documents. The Offline Documents dialog box appears:

2. In the Offline documents list, select the document you want to bring back online. (Use a multiple select action to select more than one document.)

3. Click Bring Online. The Bring Online Information dialog box appears:

4. In the Description of Changes box, enter a description of the changes made to the currently selected document while it was offline (if any).

5. Click OK.
Bringing Documents Online Without Saving Changes

If you are the offline author or a member of the Administrators group, you can bring a document back online without saving any changes you made while it was offline.

1. On the Tool Palette, click Document, and then click Offline Documents. The Offline Documents dialog box appears:

![Offline Documents dialog box]

2. In the Offline documents list, select the document you want to bring back online without saving offline changes to them. (Use a multiple select action to select more than one document.)

3. Click Cancel Offline. A message appears, asking you to confirm the deletion of the offline changes.

   If you are bringing multiple documents back online, this message appears only once for all documents.

4. Select the Remove offline document files check box to delete the offline documents from the directory in which they were stored.

5. Click Yes. The online version of the documents are restored.
Reading Offline Documents

You can read a document that another user has taken offline. RequisitePro displays the document in read-only mode in the state it was in before the other user took it offline.

If you are the offline author or a member of the Administrators group, when you open the document in RequisitePro, you can choose to bring it back online or open it in the state it was in before it was taken offline.

To read an offline document:

1. On the Tool Palette, click **Document**, and then click **Open**. The **Open Project and Documents** dialog box appears.
2. Click the offline document in the Select Document(s) list that you want to open.
3. Click **OK**. The **Offline Document Open** dialog box appears, identifying the user who took the document offline:

![Offline Document Open Dialog Box]

4. Do one of the following:
   - If you are the offline author or an administrator, click **Bring Online** to bring the document back online, or **Open Read Only** to open it in the state it was in before you took it offline.
   - You cannot access the Bring Online button if you are not the offline author or an administrator.

   • If another user took the document offline, click **Open Read Only** to open the document for reading.
Using Word Master Documents

Using master documents in Microsoft Word can be very helpful for viewing and printing a collection of smaller subdocuments as one document. All subdocuments within the master document can be printed with consistent page numbering. Master documents are a feature of Microsoft Word. You should not attempt to create, import, or manage master documents from within RequisitePro.

Consider the following guidelines when using master documents:

- Archive the project before creating subdocuments. (For information on archiving projects, refer to Archiving Projects on page 14-6.)
- The master document should not be a RequisitePro document; the subdocuments can be RequisitePro documents. This prevents redundant requirements and broken traceability links.
- Do not edit requirement text in the subdocuments outside of RequisitePro.
- Do not edit the subdocuments in RequisitePro while viewing the master document in Microsoft Word.

To prepare RequisitePro documents to be used as subdocuments, save them in Word format:

1. In the RequisitePro Tool Palette, click the Project menu and choose Properties.
2. On the General tab of the Project dialog box, clear the check box Save documents in Requisite format.

Note: This removes all project security from these requirements documents and they can be modified outside RequisitePro, so only clear this check box when you are preparing subdocuments for viewing or printing from a Microsoft Word master document.

3. Open and save the documents in the project that you want to use as subdocuments.

Important: After viewing and printing the master document in Microsoft Word, open the Project dialog box again and select the check box Save documents in Requisite format. Open the subdocuments and save them. This reestablishes project security for those documents.

For more information on using master and subdocuments, refer to the Microsoft Word documentation.
A requirement is a condition or capability to which your project must conform. Requirements are written to be meaningful to the user of the system. Each requirement includes visible behavior and benefit. In RequisitePro, requirements are located in a requirements document or directly in the database. The Word Workplace is used to define requirements and the Views Workplace is used to analyze them.

If a requirement is located in a document, the requirement text can be modified in the document only. The requirement’s attributes and relationships can be modified in both the Views and Word Workplaces. Reviewers can read the information in context and add information that supports and justifies the requirements.

When a requirement is created in a document, RequisitePro places hidden text at the beginning of the description to hold the requirement’s tag. This hidden text is underlined with a dotted line. If information is typed in this tag area, it is formatted as hidden text and is visible only when Word’s Hidden Text feature is turned on. To reformat the text to normal, use Word’s Format...Font feature. The text of the requirement should be in normal text only.

Creating Requirements

All requirements that are created in RequisitePro are stored in the project’s database. Once created, a requirement can be modified, moved and copied, and deleted within the project and traced to and from other requirements in the same project or across projects.
When a requirement is created, RequisitePro stores the following information in the database:

- *The requirement’s description.* In a document, this may include any combination of text, graphics, or OLE objects. In the project database, the requirement description is limited to text.
- *Attribute values.*

### Creating a Requirement in a Document

When you create a requirement in a document, RequisitePro performs the following operations:

- The selected information is bracketed with bookmarks.
- The following information is associated with the new requirement:
  - *Requirement tag* identifier. A requirement tag is comprised of a prefix and a number
  - *Color and style format.* If the requirement type has color and style, the new requirement is formatted with these settings.
  - *Requirement attributes.* The new requirement is associated with the attributes established for the requirement type.
- For hierarchical relationships, the requirement is assigned a parent based on the parent you select in the Requirement dialog box, Hierarchy tab. (For more information on parent-child relationships, refer to *Hierarchical Relationships* on page 9-1.)

**Note:** The requirement and its attribute values are not saved to the project database until you save the document.

**To create a requirement in a document:**

1. Open a requirements document and type the text of the requirement in the document.
2. Highlight the information (text, graphics, OLE objects) that will become part of the requirement. (If you don’t highlight text, you will be prompted to enter text for the requirement.)
3. Do one of the following:
   - click the **Requirement** menu on the Tool Palette and choose **Create**, or
   - click the **Create requirement** button on the Tool Palette.
Creating Requirements

The Requirement dialog box appears:

4. Click the down arrow in the Type field and select a requirement type with which to associate the requirement. The Tag text at the beginning of the requirement text automatically includes the Pending tag.
5. Click OK.
6. Click the Document menu on the Tool Palette and choose Save. RequisitePro saves the document, updates the database, and assigns a requirement number to the requirement (in place of the Pending tag).

Using Fast Create

Use RequisitePro’s Fast Create feature to create a requirement without opening the Requirement dialog box.

1. Highlight the text in the document that will become the requirement.
   (If you don’t highlight text, the Requirement dialog box opens. Refer to To create a requirement in a document: on page 8-2.)
2. Press the Shift key and click the Create a requirement from highlighted text button on the Tool Palette.
   RequisitePro bypasses the Requirement dialog box and creates the requirement based on the default requirement type chosen for the requirements document.
Creating Multiple Requirements

Use the **Block Create** command to simultaneously create multiple requirements in a document. This feature allows you to select a block of text that contains many requirements and automatically generate RequisitePro requirements from that text. The Block Create command creates root requirements only.

RequisitePro uses three methods to distinguish individual requirements in the highlighted block of text:

- **Key words** – RequisitePro searches for a specific word, such as “shall” (the default), or any word you specify.
- **Text delimiters** – RequisitePro searches for text contained within specific text delimiters, such as `< >`, `{ }`, `[ ]`, `BEGINREQ ENDREQ`. You can designate text to become a requirement by surrounding the text with any delimiters you choose. We recommend you use a different character on each end of the text, such as open and close brackets `[ ]`.
- **Word style** – RequisitePro searches the text for specified style settings, such as “Heading 1” or “Body text.” The styles in your current document template are loaded into the Styles box.

To create multiple requirements from a block of text:

1. Create or open a requirements document and type the text of the requirements.
2. Highlight the information (text, graphics, OLE objects) that will become requirements.
3. Click the **Requirement** menu on the Tool Palette and choose **Block Create**.
Creating Requirements

The Requirement Block Create dialog box appears:

4. Click the down arrow at the Requirement Type field and select a requirement type with which to associate the block of requirements.

5. Click on one of the following options to indicate a method of distinguishing each requirement in the block of text:
   • **Keywords** – Type keywords in the Keywords field and click Add to add the keywords to the requirements criteria field. To make the keywords case sensitive, click the Case sensitive check box.
   • **Text delimiters** – Type a beginning and end delimiter in the indicated field and click Add.
   • **Word styles** – Select a style from the styles list and click Add.

   **Note:** The dialog box changes to include specific options for each of the above choices.
   You can use more than one criteria to differentiate the individual requirements. Add keywords, text delimiters, and Word styles to the search list by clicking each button in turn. Keep in mind that RequisitePro searches the document in the order listed above: keywords first, text delimiters second and word styles last.

6. Select a source, sentence or paragraph, from which RequisitePro will search for keywords to differentiate the requirements.
Requirements

7. When you have finished adding requirements criteria, click **Create**. RequisitePro checks the highlighted text for the selected criteria and reports any text that matches your criteria in the **Requirement Found** dialog box:

   ![Requirement Found dialog box]

   • Click **Yes** to accept the proposed requirement.
   • Click **No** to reject the proposed requirement.
   • Click **Yes to All** to accept all proposed requirements.

8. When all proposed requirements have been reviewed, the **Status** dialog box appears:

   ![Status dialog box]

9. Click **Close**.
Creating Requirements

Troubleshooting While Creating Requirements

If you experience problems while creating requirements in a project document, check for the following conditions to identify and solve the problem:

- **Verify the document is not locked.** From the Tool Palette, click the Document menu and choose Lock. If a check mark is displayed to the left of the Lock menu item, select Lock to remove the mark.
- **Verify the highlighted selection does not contain hidden text at the beginning or the end of the selection.** Because RequisitePro uses hidden text to delineate requirements, it prevents the creation of a requirement with hidden text at its beginning or end.
- **Verify the highlighted selection is not inside or overlapping another requirement.** Requirements cannot be nested or overlap one another.

Creating a Requirement in the Database

Requirements located in the database can be created, viewed, and modified in the Views Workplace. These requirements can only be created in an Attribute Matrix and cannot include graphical images and OLE objects.

When you create a requirement in the database, RequisitePro performs the following operations:

- The following information is associated with the new requirement:
  - **Requirement tag identifier.** A requirement tag is composed of a prefix and a number.
  - **Requirement attributes.** The new requirement is associated with the attributes established for the requirement type.
  - If you created the requirement as a child requirement of a parent, the currently selected requirement is assigned as the parent of the new requirement.

**To create a requirement in a database:**

1. Click the Window menu on the Tool Palette and choose Show Views, or click the Go to views workplace button on the Tool Palette.
2. In the Views workplace, click File menu and choose New View.
3. Select the Attribute Matrix view type and a requirement type.
4. Click OK. The Attribute Matrix appears.
5. Select a requirement. The requirement created will be a peer to the selected requirement (they will have the same parent). If multiple requirements are selected in the Attribute Matrix, the Create option is disabled.

6. Click **Create** on the **Requirement** menu in the Views workplace.

   The **Requirement** dialog box appears:

   ![Requirement dialog box]

   RequisitePro populates the **Type** and **Location** fields:
   - The new requirement inherits the requirement type displayed in the Attribute Matrix. Select another requirement type from the **Type** list to change the requirement’s type.
   - The **Location** text box indicates whether the requirement is located in a document or the database only. Because this requirement is located in the database only, the word “Database” is displayed.

7. Type the new requirement in the **Text** box.

   RequisitePro creates a requirement tag based on the requirement type’s prefix. A sequential number is assigned to the requirement based on the numbering scheme assigned to that requirement type.
Revising Requirements

Use the Requirement dialog box to view or modify requirement information, including attribute values, traceability relationships, hierarchical relationships, discussions, and change descriptions. (For more information, refer to Chapter 6: Discussions, Chapter 9: Hierarchical Relationships, and Chapter 10: Traceability Relationships.)

To modify the description of a requirement located in a document, the operation must be performed in the document. Requirement attribute values and traceability relationships can be modified in the Views Workplace. Even if a requirement resides in a requirements document, its attributes and traceability relationships can be modified in the Word Workplace as well.

Opening the Requirement Dialog Box

From a requirements document:
1. Place the cursor inside the text of the requirement.
2. Do one of the following:
   • Click the Requirement menu on the Tool Palette and choose Properties.
   • Or, click the Display properties button on the Tool Palette.

The Requirement dialog box appears.

From an Attribute Matrix:
1. Click the requirement to highlight it.
2. Do one of the following:
   • Click the Requirement menu in the Views Workplace and choose Properties.
   • Or, click the Display properties button on the Views Workplace toolbar.

The Requirement dialog box appears.
Accessing Revision Information

Use the Revision tab in the Requirement dialog box to record and monitor revision information about the requirement.

- RequisitePro automatically generates an internal revision number for the requirement in the Revision text box whenever a requirement is modified and saved. This text box is read-only.
- If a change has been made, click the Label text box to associate a logical name with a revision number. This step is optional. Any specific revision can be named in this text box, using any combination of 20 alphanumeric characters, such as Beta Release. The label is added to the requirement’s change history. Once applied, it cannot be changed or removed.
- Use the Change Description text box to record changes made to a requirement. This text box can contain up to 2,048 characters. This step is optional.
- The Date, Time, and Author text boxes are populated by RequisitePro and cannot be modified.
- Click the History button to display the requirement’s change history.
- Any modifications made to requirements are pending until the document is saved. When a requirement is committed to the database, its status changes from Proposed changes... to Last Saved.
Recording Changes to Document-Based Requirements

When you modify a requirement’s text, you must describe the reason for the change.

After you have modified the requirement’s text, make sure the cursor is still in the requirement and then do the following:

1. Click the Requirement menu on the Tool Palette and choose Annotate Change.
   The Change Description dialog box appears.
2. Type the reason for changes.
3. Click OK.

If you attempt to close a document that contains requirement changes without annotating the changes, RequisitePro displays the Change Description dialog box, scrolls to the requirement, and prompts you to record a rationale for the change.
Modifying Attribute Values

Attributes and their corresponding list of default values are defined by the requirement type of the requirement. Use the Attributes tab in the Requirement dialog box to assign values to the attributes for a requirement.

1. Open the Requirement dialog box by following one of the options on page 8-9.
2. Click the Attributes tab. The attributes for the requirement are displayed.

3. Enter attribute values:
   • For list-type attributes, select a value in the list.
   • For entry-type attributes, enter a value in the text box.

   Note: To move between fields, use the scroll bar or the Tab key.

4. Click OK.

Modifying Attribute Values from the Attribute Matrix

You can use shortcuts for changing attribute values in the Views Workplace.

1. In an Attribute Matrix, do one of the following:
   • double-click an attribute value; or
   • click the attribute value, and then press the space bar.

2. Enter attribute values:
   • For list-type attributes, select a value in the list.
   • For entry-type attributes, enter a value in the text box.
Associating Requirements with New Types

**Note:** Press Esc to deselect the attribute value cell and cancel the modification process.

3. To accept the new value, click outside the cell or press Enter.

**Note:** You can also use a multiple select action in an Attribute Matrix to select more than one attribute value. Right-click, and choose Select Attribute. The Set Attribute Value dialog box appears, allowing you to enter a value for all selected requirements.

### Associating Requirements with New Types

When you change a requirement’s type, several things can happen:

- Any attribute values associated with the requirement will be changed to the default attribute values of the new requirement type.
- If the requirement is a parent, the requirement type is also changed for all of its child requirements.
- If the requirement is a child, the requirement is moved to the root for the new requirement type, and the requirement no longer has a parent.

For more information on parent and child requirements, see Chapter 9, *Hierarchical Relationships*.

**Note:** If you are changing requirement type in the Views Workplace, and any of the requirements you want to change are document-based, the document must be opened in RequisitePro before you begin either of the following two procedures.

### Associating a Single Requirement with a New Type

1. Open the Requirement dialog box by following one of the options on page 8-9.
2. Click the **General** tab.
3. Click the down arrow in the **Types** field and select a new requirement type.
A dialog box appears, explaining the change process.

4. Click Yes. The requirement type is changed in the Requirement dialog box.
5. Click OK.

**Associating Multiple Requirements with a New Type**

1. In the Views Workplace, open an Attribute Matrix and use a multiple select action to select multiple requirements.
2. Click the Requirement menu and choose Change Requirement Type. A dialog box appears, explaining the change process.

3. Click Yes. The Change Requirement Type dialog box appears.
4. In the New Requirement Type list, click the down arrow and select a new requirement type.
5. Click OK.

The requirements and their children are removed from the Attribute Matrix. When you display a matrix of the new requirement type, the requirements and their children are added at the end of the matrix by default.
Relocating Requirements

You can move or copy requirements within the same requirements document, between documents, and between a document and the database. Requirements are moved by using RequisitePro’s Cut, Copy, and Paste commands. Do not use the Microsoft Word Cut, Copy, and Paste commands to move requirements.

Note: The Cut/Paste commands move the original requirements. The Copy/Paste commands create new requirements. If pasted in a document, new pending requirements are inserted. If pasted in a database, new requirements are created in the database.

Cutting or Copying from a Document

To cut or copy from a requirements document:

1. Place the cursor in a requirement.
2. Click the Requirement menu on the Tool Palette and choose Cut or Copy. RequisitePro cuts or copies the requirement (and its child requirements) from the requirements document.

Pasting the requirement in a document:

You can move or copy the requirement to a new position in the current document or to another requirements document.

1. Open or click the destination document and place your cursor in the location where you want to paste the requirement.
2. Click the Requirement menu on the Tool Palette and choose Paste. RequisitePro inserts the requirement (and its child requirements) in the specified location.

Pasting a cut requirement into the database:

You may want to remove a requirement from a document and locate it only in the database. You can paste a requirement into an Attribute Matrix view if it is based on the same requirement type as the cut requirement. A requirement cannot be pasted into a Traceability Matrix or a Traceability Tree view.

1. Open or create an Attribute Matrix view based on the same requirement type as the cut requirement.
2. From the Requirement menu in the Views Workplace, choose Paste. RequisitePro pastes the requirements into the database.
Cutting or Copying from the Database

In order to move a database-only requirement to a document, you can cut it from an Attribute Matrix and paste it into a requirements document.

- Use the RequisitePro Cut command to convert a database-only requirement into a document-based requirement.
- Use the RequisitePro Copy command to make a copy of a database requirement and paste it into a document. This option creates a new requirement when you save the requirements document. Copying a requirement duplicates its text and its attributes, but not its traceability relationships.

**Note:** For hierarchical requirements, RequisitePro copies the requirement as a peer requirement at the same level in the parent/child hierarchy. (For more information, see Hierarchical Relationships on page 9-1).

To cut or copy a requirement from the database:

1. In the Views Workplace, open an Attribute Matrix containing the requirement.
2. Select a requirement (must be a database-based requirement). (Use a multiple select action to select multiple requirements.)
3. Click the Requirement menu and choose Cut or Copy.

To paste the requirement into a requirements document:

1. Open the requirements document and click the location to paste the requirement.
2. Click the Requirement menu on the Tool Palette and choose Paste. RequisitePro inserts the requirement (and its child requirements) in the specified location.
Rules for Relocating Requirements

Consider the following rules when moving requirement using the RequisitePro Cut, Copy, and Paste commands:

<table>
<thead>
<tr>
<th>Requirement Location</th>
<th>Function</th>
<th>Requirement Destination Paste to Database</th>
<th>Paste to Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>Cut</td>
<td>Relocates the requirement to be a database-only requirement.¹</td>
<td>Relocates the requirement in the document.²</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Creates a new database-only requirement.</td>
<td>Creates a new document-based requirement.</td>
</tr>
<tr>
<td>Database</td>
<td>Cut</td>
<td>Not Applicable</td>
<td>Relocates the requirement to be document-based.³</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Creates a new database-only requirement.</td>
<td>Creates a new document-based requirement.³</td>
</tr>
</tbody>
</table>

¹ If you cut a requirement from a document and do not paste it into the database, it is removed from both the document and the database when you save the document.
² For parent-child requirement hierarchies: When pasting from a document to the same document, you can only cut and paste a root requirement or a leaf (the lowest-level child requirement). When pasting from a document to a different document, you can move a root requirement and all its children. For more information about parent-child requirements, refer to Hierarchical Relationships on page 9-1.
³ For parent-child requirement hierarchies: When pasting from the database to a document, you can only move a root requirement. For more information about parent-child requirements, refer to Hierarchical Relationships on page 9-1.
• Do not use Word’s Cut/Paste commands. We recommend you do not use Word’s Cut command to cut requirement text for two reasons. The risk of not capturing the entire requirement (including its bookmarks and tag) and accidentally deleting the requirement from the project database is greater in Word. In addition, a document-based requirement cannot be moved into the project database with Word’s Cut command.

• Using the buffer with the RequisitePro Cut command. Requirements you cut using RequisitePro’s Cut command go into a proprietary cut buffer. You should paste a requirement to its new location before cutting or copying another requirement. If requirements are in the buffer and you cut or copy another requirement, the first requirements are placed back in their original location in the database. If you want to cut or copy multiple requirements, you can do so in the Attribute Matrix only.

Note: The buffer used in RequisitePro is not the Windows Clipboard. Any information currently on the Windows Clipboard is preserved when you cut or copy a requirement in RequisitePro.

• Avoid losing OLE objects. If you move a requirement that includes an OLE object from a requirements document into the project database, the OLE object is lost. RequisitePro does not currently support OLE objects in its database. Because the loss of the object is considered a change to the requirement description, the requirement’s direct traceability relationships become suspect.

Unmarking Requirements in a Document

You can delete one or more document-based requirements without disrupting the text of the document in which they reside. The requirement text, graphics, and OLE objects are not removed from the document, but they are no longer recognized as a requirement by RequisitePro. The color and style settings of the requirement are removed and replaced with the document default style. When the document is saved, the requirement is deleted from the database.

To unmark a document-based requirement:

1. In the requirements document, click in the requirement text or highlight a contiguous block of requirements.

2. On the Tool Palette, click the Requirement menu, then click Delete (Unmark). To delete multiple requirements, choose Block Delete (Unmark) instead. A message appears, asking you to confirm the deletion.
Refreshing Requirement Color and Style in a Document

3. Click Yes. The RequisitePro formatting is removed and the requirement text is converted to the default text style.

4. Click the Document menu in the Tool Palette, and choose Save. The requirement is removed from the database.

Note: To undo an unmark operation, use the Edit/Undo option in Word repeatedly until the styling, bookmarks and tags reappear.

Refreshing Requirement Color and Style in a Document

A specific color and style distinguishes requirements that belong to a specific requirement type. For example, you might mark all requirements that belong to the requirement type feature with a dark green requirement color and a double underline style. This helps you easily recognize all feature requirements regardless of their location. Refreshing the color and styles of requirements is useful for restoring requirements to their proper state when their color and style have been overwritten.

To refresh requirement color and style in a requirements document:
1. Highlight the requirements to refresh.
2. Click the Document menu on the Tool Palette and choose Refresh Requirements. RequisitePro checks the color and style settings of the requirements in the document and, if necessary, resets them to the proper settings for the requirement type.

Note: To remove color and styling and convert the requirement back to plain text, see Unmarking Requirements in a Document on page 8-18.

Rebuilding Requirement Tags in a Document

When a requirement is created in a document, the requirement information is bracketed by bookmarks and assigned a requirement tag. Click the Show Tags checkbox in the Document dialog box to display this information.

Tags can be accidentally corrupted or deleted while editing a requirements document. Use the Rebuild Tags command to rebuild a requirement tag that is partially or completely deleted or corrupted. RequisitePro rebuilds the affected tags, then provides a list of rebuilt requirement tags.
To rebuild requirement tags in a document:
1. Highlight the requirement tags to rebuild.
2. Click the Document menu on the Tool Palette and choose Rebuild Tags. RequisitePro rebuilds the requirement's tags.

Renumbering Requirements

Use the Renumber Requirements command to renumber all requirements of a specified type in a project. This feature is useful to eliminate the “holes” in a numbering scheme that result when you delete or move requirements. You can renumber one or several requirement types in one operation.

Requirements are renumbered in the database and in requirements documents. Select which requirement type you want to renumber and the order in which you want the documents processed. Document-based requirements are renumbered in the order in which they appear in the document.

The project must be opened in exclusive mode to use this command. If security is enabled, you must have project structure permission to renumber requirements.

Note: If you refer to requirements by their tags, your external references may be no longer valid once the requirements are renumbered.
To renumber requirements:

1. Click the **Project** menu on the Tool Palette and choose **Renumber Requirements**. The **Renumber Requirements** dialog box appears:

2. In the **Requirement Type** list, select the requirement type that you want to renumber.

3. Click the **Renumber Requirements of this type** check box to mark the type.

   **Note:** To renumber requirements of more than one requirement type, repeat steps 2 and 3.

4. In the **Initial Requirement Number** text box, enter the initial requirement number that you want to set. The default number is 1.

5. To change the order of renumbering for database requirements and documents, select Database or a document name. Click the **Move Up** and **Move Down** buttons to put the database and documents in the order in which you want them to be processed. The requirements in the first item listed (the database or a document) are renumbered first, followed sequentially by the requirements in the second item, and so on.

   **Note:** A document appears in the Order of Processing list only if it contains requirements of the selected type.

6. Click **OK**.
Hierarchical Relationships

Hierarchical requirement relationships are parent-child relationships that reflect direct dependencies between requirements. In addition, these associations provide powerful tools for change management. With hierarchical requirements, you can support a requirement with a number of sub-requirements by establishing a parent requirement and creating child requirements of that parent.

Like traceability relationships (see Traceability Relationships on page 10-1), hierarchical relationships are a type of change-managed relationship in RequisitePro. If a requirement is changed, the relationships with its children become suspect. You can view and manage suspect relationships using a Traceability Matrix or a Traceability Tree in the Views Workplace.

Creating Child Requirements

A child requirement is any requirement that has a parent. Hierarchical relationships are created in a requirements document or in the database. Parents and children must reside in the same location, either as database-only requirements or in the same document. The parent requirement and all of its children must be of the same requirement type.

These relationships are created using the Hierarchy tab in the Requirement dialog box or directly into a requirements document using the tool bar.

Creating Child Requirements in the Database

1. In the Views Workplace, open the Attribute Matrix containing the requirement that you intend to be a parent.
2. Click the requirement. (You can only create a child for one requirement at a time.)
Hierarchical Relationships

3. Click the **Requirement** menu, and then click **Create Child**.

   **Note:** You can create a child in the database only if the currently selected requirement (which will become the child's parent) is a database-only requirement.

   The **Requirement** dialog box appears.

4. Click the following tabs to define the child requirement, and enter the appropriate information:
   - General
   - Revision
   - Attributes
   - Traceability
   - Hierarchy
   - Discussions

5. Click the **Hierarchy** tab. The parent requirement is pre-defined as the requirement you selected in step 2. (If you want to, you can change the parent.)

6. Click **OK**.

   RequisitePro creates the child requirement in the database. RequisitePro generates a requirement tag for the child requirement based on the parent requirement’s number.

### Creating Child Requirements in a Document

You can create child requirements in a requirements document by assigning a parent. The assignment is committed to the database when the document is saved.

1. In a requirements document, highlight the requirement that you intend to be a child requirement.

2. Click the **Requirement** menu on the Tool Palette and choose **Properties**. Or, click the **Display the properties...** button on the Tool Palette. The **Requirement** dialog appears.

3. Click the **Hierarchy** tab.

4. Select a parent from the **Parent** list box.

   **Note:** The default is the last parent selected in the document.

5. Click **OK**.
The requirement changes to a pending child requirement of the parent you selected. Click the Document menu on the Tool Palette, and select Save to save the new parent-child relationship in the database. RequisitePro generates a requirement tag for the child requirement based on the parent requirement’s number.

Creating Peer Requirements

Requirements have a peer relationship when they are at the same level in the requirement hierarchy. For example, two requirements are peer requirements when they are children of the same parent. All requirements at the root level are peer requirements of one another.

When a requirement is created, it is automatically placed at the same level as the requirement above it in the document or Attribute Matrix. Refer to Creating a Requirement in a Document on page 8-2 and Creating a Requirement in the Database on page 8-7.

Changing Parent Requirements

In a requirements document or an Attribute Matrix, you can assign single or multiple hierarchical requirements to a different parent. When you assign a requirement to a new parent, its entire sub-tree of children is also moved to that parent.

When children are assigned to a different parent, all hierarchical relationships between the new parent and its immediate children are marked suspect. The relationships between the children and their children are not marked as suspect. (See also Suspect Relationships on page 10-8.)

Assigning a New Parent to a Single Requirement

You can reassociate a hierarchical requirement with a new parent of the same requirement type using the Hierarchy tab in the Requirement dialog box.

Note: To change parents of document-based requirements in the Views Workplace, the document must be opened (and you must have the ability to edit it) before you begin the following procedure.
Hierarchical Relationships

To assign a new parent:

1. Do one of the following:
   - In the Word Workplace, click anywhere in the requirement text. On the Tool Palette, click the Requirement menu and choose Properties.
   - In the Views Workplace, open the Attribute Matrix and select the requirement. Click the Requirement menu in the Views Workplace and choose Properties.

   The Requirement dialog box appears.

2. Click the Hierarchy tab.

3. Select a parent from the Parent list.

4. If the parent is not displayed in the list, select <choose parent...>.
Changing Parent Requirements

The **Parent Requirement Browser** dialog box appears:

![Parent Requirement Browser](image)

5. Select a parent requirement from the list. To locate a specific requirement, click the **Find** button.

6. After selecting the parent requirement, click **OK**.

7. In the **Requirement** dialog box, click **OK**.

   The requirement changes to a child requirement of the parent you selected. New requirement tags are generated for the child requirement and its sub-tree of children, based on the new parent requirement’s number.

   **Note:** For document-based requirements, you must save the open document to commit requirements to the database.
Hierarchical Relationships

Assigning a New Parent to Multiple Requirements

In an Attribute Matrix, you can reassociate more than one hierarchical requirement with a new parent of the same requirement type. All selected requirements are assigned to the same new parent.

Note: If any of the requirements you want to change are document-based, the document must be opened (and you must have the ability to edit it) before you begin the following procedure.

1. In the Views Workplace, open the Attribute Matrix, and then select the requirements.
2. Click the Requirement menu, and then choose Change Parent. The Select New Parent dialog box appears:

3. In the New Parent list, select a parent.
4. If the parent is not displayed in the list, select <choose parent...>. The Parent Requirement Browser dialog box appears, as shown on the previous page.
5. Select a parent requirement from the list. To locate a specific requirement, click the Find button.
6. After selecting the parent requirement, click OK.
7. In the Select New Parent dialog box, click OK.

The requirements become child requirements of the parent you chose. A new requirement tag is generated for the child requirements and their sub-trees of children, based on the new parent requirement’s number.

Note: For document-based requirements, you must save the open document to commit requirements to the database.
Deleting Hierarchical Requirements

Go to the Word Workplace to delete document-based requirements. Go to an Attribute Matrix in the Views Workplace to delete requirements that are located only in the database.

When you delete a requirement that is traced to/from requirements that reside in other projects, the other projects are updated to remove the relationships. Unlike cut requirements, which are placed into a buffer for pasting within RequisitePro, a deleted requirement is completely removed from the database.

To delete a hierarchical requirement:

1. Do one of the following:
   - In the View Workplace, open the Attribute Matrix and click the requirement to delete. (Use a multiple select action to select multiple requirements.) Click the Requirement menu in the Views Workplace and choose Delete.
   - In the Word Workplace, open the document and highlight the requirement to delete. Click the RequisitePro menu in the Word Workplace, choose Requirement, then click Delete (Remove). Or, click the Requirement menu on the Tool Palette and click Delete (Remove).
     A dialog box appears, asking you to confirm the deletion.

2. Click Yes to delete the requirement.
   If the requirement has children, the Delete Requirement dialog box appears:

![Delete Requirement dialog box]

Note: If you are deleting multiple requirements in the Attribute Matrix, the Delete Requirement dialog appears for each parent requirement.
Hierarchical Relationships

3. Do one of the following:
   - Select the **Delete all child requirements recursively** option to delete the requirement and all its children. This option removes all traceability and hierarchical relationships.
   - Or, select the **Assign all child requirements to a new parent** option to delete the requirement and save its children. This option reassigns all children to a new parent you select in the list. When the children are reassigned, all hierarchical relationships between the new parent and its immediate children are marked suspect.

4. When you have made your selection, click **OK**.
   
   If you are working in the Views Workplace, the requirement is deleted immediately when you click the **Delete** button. If you are working in the Word Workplace, save the requirements document to commit the deletion to the database.

**Suspect Relationships**

A relationship between requirements becomes questionable or *suspect* if RequisitePro detects a requirement has been modified. In the Views Workplace, you can manually mark a hierarchical relationship suspect or clear a suspect relationship.

- When you modify a parent requirement, RequisitePro marks the relationship between the parent and all its immediate children suspect.
- When you modify a child requirement, RequisitePro does not mark the relationship between the child and its parent suspect, although the child’s relationship with other requirements is marked suspect.
- When children are reparented, all hierarchical relationships between the new parent and its immediate children are automatically marked suspect. The relationships between the children and their children are not marked as suspect.

**Displaying Suspect Hierarchical Relationships**

You can display suspect hierarchical relationships using the Traceability Matrix and the Traceability Tree views. In the Views Workplace, the suspect relationship is identified by a red diagonal line through the requirement icon.
Clearing Suspect Relationships

You can reset a parent-child relationship that has been marked suspect by manually clearing it in the Traceability Matrix or Traceability Tree:

1. Do one of the following:
   • In a Traceability Matrix, select one or more intersection points in the matrix where a traceability link has been created.
   • In the Traceability Tree, select one or more requirements to modify.
2. Click the Requirement menu in the Views workplace, and then select Clear Suspect.
Hierarchical Relationships
Traceability Relationships

In RequisitePro, traceability is a dependency relationship between two requirements. Traceability is a methodical approach to managing change by linking requirements that are related to each other.

Like hierarchical relationships (see *Hierarchical Relationships* on page 9-1), traceability relationships are change-managed relationships in RequisitePro. If either end-point of the connection is changed, the relationship becomes suspect.

RequisitePro makes it easy to track changes to a requirement throughout the development cycle, so you don’t need to review all your documents individually to determine which elements need updating. You can view and manage suspect relationships using a Traceability Matrix or a Traceability Tree in the Views Workplace.

This chapter addresses traceability between requirements in the same project. For information about cross-project traceability, see *Setting Up and Modifying Cross-Project Traceability* on page 15-12.

**Creating Traceability in the Word Workplace**

Use the *Requirement* dialog box or the *Requirement* menu on the Tool Palette to trace a requirement to or from other requirements in a document. A common traceability relationship is one in which one requirement is derived from another.
Creating a Traceability Relationship in a Requirements Document

To create a traceability relationship in a requirements document:

1. Place the cursor in the text of the requirement.
2. Click the Display properties button on the Tool Palette. The Requirement dialog box appears.
3. Click the Traceability tab.
4. Click the Add button adjacent to the To or From field. The Trace To Requirement or the Trace From Requirement dialog box appears.
5. From the Requirements of type list box, select the requirement type with which the requirement is associated.

6. If you know the location of the requirement (document or database), select it from the Located in list box. If not, select All locations.

7. Highlight a requirement to trace to or trace from in the list box and click OK. RequisitePro adds this requirement to the To or From field on the Traceability tab.

8. Click OK.

**Creating Traceability Using the Requirements Menu**

To create traceability using the Requirements menu:

1. In a requirements document, place the cursor in the text of the requirement.

2. Click the Requirement menu on the Tool Palette and choose Trace To or Trace From. The Trace To Requirement(s) dialog box or the Trace From Requirement(s) dialog box appears.

3. From the Requirements of type list box, select the requirement type with which the requirement is associated.

4. Select the location (document or database) of the requirement from the Located in list box if you know it, otherwise set the list box to All locations.

5. Highlight a requirement to trace to or trace from in the list box and click OK. RequisitePro creates a traceability relationship between the two requirements.

**Creating Traceability in the Views Workplace**

You can create traceability relationships in the Attribute Matrix, the Traceability Matrix, and the Traceability Tree. (For more information on navigating in the Views Workplace, refer back to Views on page 4-1)

**Creating Traceability Relationships in an Attribute Matrix**

1. Create an Attribute Matrix, or open an existing one and select a requirement.

Traceability Relationships

3. Click the **Traceability** tab.

4. Click the **Add** button adjacent to the **To** or **From** field. The **Trace To Requirement(s)** or the **Trace From Requirement(s)** dialog box appears.

5. From the **Requirements of type** list box, select the requirement type with which the requirement is associated.

6. Select the location (document or database) of the requirement from the **Located in** list box if you know it, otherwise select **All locations**.

7. Highlight a requirement to **trace to** or **trace from** in the list box and click **OK**. RequisitePro adds this requirement to the **To** or **From** field on the **Traceability** tab.

8. Click **OK** on the **Requirement** dialog box.
Creating and Deleting Traceability in a Traceability Matrix

To create a traceability relationship:
1. Open a Traceability Matrix and select the cell that intersects the two requirements for which you want to create a traceability relationship. (Use a multiple select action to select more than one cell.)
2. Click the **Requirement** menu in the Views Workplace, and then click **Trace To** or **Trace From**. An arrow displays in the cell, signifying the relationship.

To delete the traceability relationship:
1. Highlight the arrow in a Traceability Matrix cell. (Use a multiple select action to select multiple cells.)
2. Click the **Requirement** menu and choose **Remove Trace**, or press the Delete key on the keyboard. A dialog box appears asking you to confirm the deletion.
3. Click **Yes**.

To apply traceability to a row or column:
1. Select the rows or columns to fill in a Traceability Matrix.
2. Click the **View** menu in the Views Workplace, and then click:
   • **Select All Rows in Selected Columns**, or
   • **Select All Columns in Selected Rows**.
   
   For example, if you selected a column in step 1, click **Select All Rows in Selected Columns**. All of the rows are selected. The intersection cells of the selected column and all of the rows are also selected.
3. Optionally, use a multiple select action to clear the requirements you do not want to assign to the traceability state.
4. Click **Requirement**, and then click **Set Traceability**. The **Set Traceability** dialog box appears.
5. Select a **Traceability Function** from the list.
6. Click **OK**. For lengthy operations, the status bar shows the progress of the operation.
Creating Traceability Relationships in the Traceability Tree

There are two methods for creating traceability relationships in the Traceability Tree:

- Using drag and drop
- Using Requirement commands

Drag and Drop

1. Open a Traceability Tree and select the requirements (displayed by their tags) to or from which you want to create a traceability relationship. (Use a multiple select action to select more than one requirement.)

2. Press the Ctrl key and hold down the right mouse button, dragging up or down the Traceability Tree until the cursor is on the requirement with which you want to create a traceability relationship to or from the selected requirements, and then release the mouse button. A shortcut menu appears.

3. Do one of the following:
   - To delete the traceability relationship between the selected requirements and the requirements to or from which they were traced, and create a traceability relationship between the selected requirements and the requirement the cursor was on when you released the mouse button, click Move Here.
   - To maintain the traceability relationship between the selected requirements and the requirements to or from which they were traced, and create an additional traceability relationship between the selected requirements and the requirement the cursor was on when you released the mouse button, click Copy Here.
   - To cancel the operation, without moving, deleting, or creating any traceability relationships, click Cancel.

Tip: To copy or move a traceability relationship, you can also press the Ctrl key (to copy) or the Alt key (to move) and hold down the left mouse button, dragging up or down the Traceability Tree until the cursor is on the desired requirement, and then releasing the mouse button. Note that if you use this method to copy a traceability relationship, you are not given the option to cancel before the copy occurs. You are given the option to cancel when you use this method to move a traceability relationship.
Requirements Commands

1. Select the requirements (displayed by their tags) to or from which you want to create a traceability relationship. (Use a multiple select action to select more than one requirement.)

2. Click the **Requirement** menu, and then choose **Trace To** or **Trace From**. (The command available depends on the type of Traceability Tree in the active window.) The **Trace To Requirements** or **Trace From Requirements** dialog box appears.

3. Select the requirements in the list. (Use a multiple select action to select more than one requirement.)

4. Click **OK**.

Troubleshooting Failed Multiple Select Actions

In the Views Workplace, when you select more than one relationship or requirement in a view, and then perform an operation on the multiple selection (such as creating traceability or deleting), the operation may fail for one or more requirements or relationships.

For example, the operation may fail if you do not have rights to perform the operation on the requirements or relationships, or if some of the requirements are document-based and the operation is permitted only on database-based requirements.

RequisitePro notifies you of such failures, providing an exception log (separate from the error log file) that shows the requirements or relationships for which the operation failed, and the reason for the failure.

1. In a view, perform the desired operation on a selected group of requirements or relationships.
   - If the operation is successful, the modifications are shown in the view, and no dialog box appears.
   - If the operation fails for one or more requirements or relationships, or if you stop the operation before it is completed by pressing the Esc key, the **Exception Report** dialog box appears, providing the number of requirements or relationships for which the operation failed.

2. Click **Details** to learn more about the failed operation. The dialog box is expanded, showing the reason for the failure.

3. To copy the text in the text box, select the text and press Ctrl-C. You can then paste the text into a text document.
Traceability Relationships

4. Click **Close**.

## Suspect Relationships

A relationship between requirements becomes questionable or *suspect* if RequisitePro detects a requirement has been modified. If a requirement’s text is modified, all *direct* relationships *to* and *from* it are suspect.

You can define attributes that, when modified, cause traceability relationships to become suspect. You also can manually mark requirement relationships as suspect in the Views Workplace.

### Displaying Suspect Traceability Relationships

The *suspect* state is reflected in the **Requirement** dialog box’s **Traceability** tab, as well as in the Traceability Matrix and the Traceability Tree views. In the **Traceability** tab, RequisitePro displays the word *Suspect* next to the requirement in question. In the Views Workplace, the suspect relationship is identified by a red diagonal line through the traceability arrow.

The **Auto Suspect** command monitors a requirement’s change history and displays a suspect signal when requirements are changed. A suspect relationship in the Views workplace is represented by a red line running diagonally through the relationship.

### Clearing Suspect Traceability Relationships

You can reset a requirement relationship that has been changed to a suspect state by manually clearing it. The relationship is reset to its previous state, *traced to* or *traced from*. Suspect relationships are cleared in the Traceability Matrix view or Traceability Tree in the Views workplace.

**To clear one or more suspect relationships:**

1. Do one of the following:
   - In a Traceability Matrix, select one or more intersection points in the matrix where a traceability link has been created.
   - In the Traceability Tree, select one or more requirements to modify.
2. Click the **Requirement** menu in the Views workplace, and then select **Clear Suspect**.
Import Wizard

Use the Import Wizard to import requirements from a Word document or a comma-separated value (CSV) file into a project.

The import process is recommended for:

- Importing non-project documents into the active project.
- Importing new requirements into an existing project.
- Updating existing requirement attributes with new information.

The Import Wizard can import requirements and attributes into your project from several sources:

- Requirement documents created in other RequisitePro projects.
- Word documents created outside of RequisitePro.
- Any database that supports export of data in CSV format, such as SQL Server, Oracle, Excel, or Access.

Before You Begin

Project Setup

You will be importing an external document or CSV file into a RequisitePro project. If the project manager or RequisitePro Administrator has not already set up a project, you will need to create one now (refer to Project Creation on page 12-1). Minimally, the project must have at least one requirement type and one document type defined.
Import Logs

RequisitePro creates a log file each time you import a file. The log file is a written record of the import process. The log file records these operations: matching of requirement types, how conflicts were resolved, attribute mappings, the success or failure of search criteria, canceled operations, value errors, and whether or not the import was successful. The log file is saved in the directory where the project is stored, and is named import#.log, where # is a number representing sequential order of creation. If a log file is deleted, the next one created will receive the old number to fill in the gap.

Importing Documents from Another RequisitePro Project

To successfully import RequisitePro documents from one project to another, you must first save the documents in Word format. The resulting Word document retains the appearance of the original requirements document, including the bookmarks and tags that are used in RequisitePro.

About RequisitePro format

When the Save documents in RequisitePro format check box on the Project dialog box is marked, all documents within the project will be saved in RequisitePro format.

Documents saved in RequisitePro format cannot be modified and saved in Word outside of RequisitePro. This allows RequisitePro projects to be secure.
Importing Documents from Another RequisitePro Project

When this option is cleared, documents will be saved in Word format. Documents that are saved in Word format can be modified in Word outside of RequisitePro, and are not secure.

To ensure that the documents are once again brought under RequisitePro control after they are imported into a new project, mark the Save documents in RequisitePro format check box on the Project dialog box for that project. If security is not an issue for a particular project, you can clear the check box.

Converting All the Documents in a Project to Word

If you want to import all the documents from one project into another, they can all be converted to Word format at once.

To convert all documents to Word at once:

1. Open the project.
2. From the Project menu, click Properties.
   The Project dialog box appears:

   ![Project dialog box]

3. On the General tab, clear the Save documents in RequisitePro format check box.
4. Click OK. When the project is closed, all documents will be converted to Word format, but will remain in the RequisitePro system. The documents will retain their RequisitePro extensions.

The newly formatted documents are ready to import into another project. Follow the instructions in Importing from Word on page 11-5.
Converting an Individual Document to Word

To import a single document from an existing project:

1. Open the project:
   - On the Tool Palette, click the Project menu and select Open.
   - Or, click the Open project button.

   The Open Project and Documents dialog box appears:

2. Select a document and click OK. RequisitePro opens the document.

3. On the Document menu, click Save As. The Document Save As dialog box displays the file name with its extension changed to “.doc”:

4. Click Save. The document is converted from RequisitePro format to Word format.

   The file management system automatically saves the new Word document (*.doc) into the same folder as the project.

   The new Word document is ready to import into another project. Follow the instructions in the Importing from Word section, beginning on page 11-5.

Saving or Removing Bookmarks

Bookmarks in a RequisitePro document are requirement indicators. They appear as heavy square brackets, to distinguish them from the square bracket character normally found in Word. When you create a requirement in a RequisitePro document, RequisitePro automatically inserts bookmarks that surround and specify the text of the requirement.
Importing from Word

When a document is imported, the Import Wizard finds strings of text in the document (that is, the Wizard parses the document) and imports them into the project as requirements. In the import process, you define the criteria that the Wizard uses to parse the text. The criteria can be keywords, text delimiters, or Word styles.

If RequisitePro detects bookmarks in the document being imported, the Remove Bookmarks dialog box appears:

This dialog box appears after you have responded to the Document dialog box at the beginning of a Word import.

- Click Yes to remove bookmarks and include all the document’s text in the parsing process.
- Click No to leave the bookmarks in place. RequisitePro recognizes any bookmarks that were previously created in a RequisitePro document and brings that text into the new document as new requirements. The bookmarked text is ignored in the parsing process.

Importing from Word

Use the Import Wizard to import requirements from a Word document into a RequisitePro document, or to import a Word document in its entirety into a RequisitePro project.

The document you are importing must be in Word format. If your document was created in an application other than Microsoft Word, refer to the Microsoft Word documentation to save the file in Word format.

Turn off background options in Word (pagination, spelling, grammar check, etc.) before importing a Word document.

Note: If you are importing a Word document that uses a template other than Word’s normal.dot template or an existing RequisitePro outline, you should set up that template as a RequisitePro outline prior to
importing the document. RequisitePro will overwrite any unrecognized formatting with the normal.dot formatting. If you have customized the formatting within the Word document, you should save the document as a Word template and copy it to the RequisitePro outlines directory. Refer to the Microsoft Word documentation for help in creating Word templates. Refer to the RequisitePro online help topic “Creating outlines” for help in managing RequisitePro outlines.

Importing Word Documents and Requirements

To use the Import Wizard to import Word documents:

1. On the Tool Palette, click the Project menu and select Open. The Open Project and Documents dialog box appears.
2. Select the project into which you will be importing the Word document.
3. Click the Project menu and choose Import. The Import Wizard opens, and the Select a Source screen appears:

4. Click Microsoft Word Document to mark the option.
5. Type the path and name of the Word document you want to import, or click Browse to select a file.

   The Browse command displays the Open dialog box. Navigate to the desired document and click Open. (If the desired document is not found in the list, try changing the file type to All files.) The Open dialog box closes and the selected document is loaded into the Import Wizard.
6. Click **Next** to continue. The **Select Import Content** screen appears:

![Select Import Content](image)

7. Designate the import content by clicking the appropriate option. Select **Requirements and document**, **Requirements only**, or **Document only**.

Depending on your choice, you will take one of three paths. The following table demonstrates the trade-offs between the different import options:

<table>
<thead>
<tr>
<th></th>
<th>Requirements and Document</th>
<th>Requirements only</th>
<th>Document only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement definition</td>
<td>Automatic</td>
<td>Automatic</td>
<td>Manual</td>
</tr>
<tr>
<td>Requirement destination</td>
<td>New document</td>
<td>Database or New document or Existing document</td>
<td>New document</td>
</tr>
</tbody>
</table>
The Requirements and Document Import Option

If you select the Requirements and Document option on the Select Import Content screen, the Import Wizard imports the entire document and the requirements created by parsing the text. The Word document is imported into a new RequisitePro requirements document, and requirements are automatically generated in the new document. The Requirements and document option works well if your document already contains a well-defined requirement structure. The Import Wizard parses the document for requirements based on key words, text delimiters, or Word styles.

1. Select the Requirements and Document option on the Select Import Content screen and click Next. The Document dialog box appears:

2. Complete the following information:
   - Type the document Name (any length up to 64 characters).
   - Type the Filename (RequisitePro will assign an extension according to the Document Type selected).
   - Mark the Show Tags check box if you want to display requirement tags in your document.
   - Select a Document Type from the list.
   - Click the Revision tab to enter a change description or create a user-defined label (optional). Revision number, date, time, and author are generated by the system and cannot be edited here.

3. Click OK to continue.
Importing from Word

Note: If the document type you selected is associated with an outline (or template) that contains special formatting and text, the Outline has text dialog box appears. You must indicate if you want to preserve the text and formatting from the outline for this document type. Click Yes to retain the style settings and text from the document outline. Click No to import the basic Word document only.

The Requirement screen appears:

4. Select a type for the new requirements in the Requirement Type list. The Wizard provides a default requirement type by matching it to the document type you selected earlier.

Note: Occasionally, you may want to include requirements of multiple types in a single document. For example, any sentence containing the word “shall” could become a product requirement, and any sentence containing the word “will” could become a software requirement. As you create search criteria in the step below, you can use the Requirement Type list to select which requirement types you want to apply.

5. Mark one of three methods for differentiating or parsing the Word document. The Import Wizard finds strings of text in the Word document and imports them into the project as requirements.

Key word - Import Wizard searches the Word document for a specific word, such as “shall” (the default). Enter the key word and click Add.

Text delimiters - Import Wizard searches the Word document for text contained within specific text delimiters, such as < >, { }, [ ]. When you have entered both the starting and ending delimiters, click Add.
Import Wizard

**Word style** - Import Wizard searches the Word document for specified style settings, such as “Heading 1” or “Body text.” Select the appropriate styles and click **Add**.

**Note:** You do not need to limit the search to one criteria only. You can add keywords, text delimiters, and Word styles to the search list by marking each button in turn. Use **Remove** to delete a criteria from the search list.

6. Click **Next** to continue.
RequisitePro parses the document using the differentiation methods you selected. When a requirement is located, the **Requirement found** dialog box appears:

![Requirement found dialog box](image)

7. Indicate whether the text found is a valid requirement: Click **Yes** or **No** for each. Choose **Yes to all** to automatically accept all requirements found in the document. Each requirement is added to the **Requirements to import** dialog box:

![Requirements to import dialog box](image)
Each new requirement begins with a pending tag, followed by the initial text of the requirement.

8. When you are satisfied with your selection, click **Next** to continue.
   The Import Wizard displays the final **Status** screen:

9. Click **Commit** to accept the import or click **Cancel** to cancel the import in its entirety.
The Requirements only Import Option

Select Requirements only at the Select Import Content screen if you want to extract requirements from a document without importing the rest of the text. If your document already contains a well-defined requirement structure such as keywords, styles, or delimiters, this option automatically creates your requirements during the import process. The Import Wizard parses the document for requirements, based on key words, text delimiters, or Word styles. It creates requirements from the text it finds and leaves the rest of the document behind. You have flexibility in the location of the new requirements. You can create requirements in the current project (directly in the database), in an existing RequisitePro document, or in a new document.

1. Select the Requirements only option on the Select Import Content screen and click Next. The Select a Destination screen appears:

![Select a Destination screen](image)

2. Choose one of the following destinations for the imported requirements:
   - Select Current project database to import the requirements into the database of the open project.
   - Select New RequisitePro document to import the requirements into a new document you define. (The Document dialog appears and prompts you for information about the new document before proceeding to the next step.)
   - Select Existing RequisitePro document to choose from a list of existing project documents. (If the document you choose is not already open, RequisitePro opens it for you.)

3. Click Next to continue. The Requirement screen appears.
4. Follows step 4-9 above in *The Requirements and Document Import Option*.

**Note:** At step 7, when the “Requirements to import” dialog box appears, you have the following options:

- If you want to read the full text of the requirement, click the View button.
- To remove a requirement from the list, select it and click the Remove button. (It is saved in an Add requirements box.) Click Add to view the box.

**The Document only Import Option**

The Import Wizard imports the entire document into a new RequisitePro document without parsing the text. Choose **Document only** if your requirement structure is not defined or you want to manually create the requirements after importing. No requirements are created during the import process. It gives you the most flexibility in creating document-based requirements.

1. Select the **Document only** option on the Select Import Content screen and click **Next**. The **Document** dialog box appears.

2. Complete information about the new document. (See step 2 above in *The Requirements and Document Import Option* on page 11-8.)

**Note:** If the document type you selected is associated with an outline (or template) that contains special formatting and text, the **Outline has text** dialog box appears. You must indicate if you want to preserve the text and formatting from the outline for this document type. Click **Yes** to retain the style settings and text from the document outline. Click **No** to import the basic Word document only.

The Import Wizard displays the final **Status** screen.

3. Click **Commit** to accept the import, or click **Cancel** to cancel the import in its entirety.

**Note:** If you are importing a RequisitePro document from one project to another, this process includes an extra dialog box (Refer to *Saving or Removing Bookmarks* on page 11-4).
Importing a CSV File

RequisitePro can import requirements and attributes into your project from any database that supports export of data in CSV format, such as SQL Server, Oracle, Excel, or Access.

The CSV import process is recommended for:

• Importing requirements from a non-RequisitePro database into the active project.
• Updating existing requirement attributes with new information.

A CSV (comma-separated value) file is a data file consisting of fields and records, stored as text, in which the fields are separated from each other by commas. If the data in a field contains a comma, the field is further surrounded with quotation marks. Using a comma-delimited file format allows data to be shared between database systems that use different formats.

Requirement Numbers

When a new requirement is added to the database, it is assigned a new root requirement number. If a requirement has a tag or a number in the external CSV file, that number is not necessarily preserved. RequisitePro will recognize a hierarchical numbering scheme and will import lower-level requirements as children of a higher level requirement.

Requirements in a CSV file are renumbered when they are imported into the project database.
Preparing a CSV File for the Import Wizard

To import a CSV file from another RequisitePro project or a non-RequisitePro application, the first row of the CSV file must be a header row with a column heading for each column of data. RequisitePro uses the header to match column headings in the import document with attributes in the project.

Defining a Header for a CSV File

RequisitePro uses the following header format:

<Tag>, Requirement text, <Attribute 1>,<Attribute 2>, <Attribute 3>...

A sample CSV file with a correctly formatted header row.

1. To begin creating a header, type a tag that describes a requirement type, such as PR, SR, TST, or any other tag you created in your project, followed by a comma. The word tag can be added in the header, but is not required. For example, SR and SR tag are both acceptable.
   - The tag field in the header is used to set the default Requirement Type used in the import. If the tag field does not match any requirement type in the project, the Match Requirement Type screen appears, prompting you to choose one manually.
   - The first column in the CSV file must be the tag column. The tag column cannot contain any empty cells. If a cell is empty, type in any character to fill it.
   - If the tag column in the CSV file contains numbers, the numbers will not be preserved. Imported requirements will be added to the project’s requirements list and renumbered accordingly. Hierarchical relationships will be retained.

2. The literal string Requirement text must be the second field of the header, followed by a comma.
   - The second column in the CSV file must be the text of the requirements.
3. For the remaining fields in the header, type a heading for each column in the CSV file, separated by commas. The column headings in the header can be anything you like, but if you use names (i.e. labels) of attributes as they appear in your project you will save yourself some time later.

- RequisitePro will look at the header in the CSV file and try to match the column heading to an attribute in the project. During the import process you will be asked to review the attribute matching and make corrections.

- The columns under the attribute headings must contain attribute values.

**Generating a CSV Header to Copy**

As an alternate to typing the CSV header, you can copy a header from another CSV file to ensure correct formatting. Exporting an existing file to a CSV file provides a header that can be copied into your CSV file. (For more information, refer to *Exporting a View as a CSV File on page 25.*)

**To copy a CSV header:**

1. Open an **Attribute Matrix** view. The attributes listed across the top of the Attribute Matrix will become the column heading in the CSV file when the matrix is exported.

   **Note:** If no requirements are displayed in the Attribute Matrix window, you must create a dummy requirement. From the **Requirement** menu, choose **Create**. The **Requirement** dialog box appears. Type any text into the dialog box and click **OK**. The requirement type, by default, is the type selected for the Attribute Matrix.

2. Click the **File** menu and choose **Export**, then **Export to CSV**. The **Export to CSV** dialog box appears.

3. Choose a directory for your file and give it a name, and then click **Save**.

4. Use any text editor to open the CSV file you just created:

   ![CSV file header](image)

   The header is correctly formatted for the requirement type specified above in step 1.
5. Use the **Copy** command to copy the header.
6. Open the CSV file you plan to import, and create an empty row as the first row of the table. Use the **Paste** command to copy the header into your CSV file.

This creates a CSV header file for one requirement type. Repeat this process for each requirement type you plan to import.

### Using the Import Wizard to Import a CSV File

Catalog and open a project before importing a file.

1. On the Tool Palette, click the **Project** menu, or from the Views Workplace, click the **File** menu. Choose **Import**. The Import Wizard opens, and **Select a Source** screen appears:

![Import Wizard](image)

2. Complete the following information:
   - Click the **CSV** button to import requirements from a comma-separated value text file.
   - Type the name of the CSV file to import, or click **Browse** to select a file from the list. (The **Browse** command displays the **Open** dialog box. Navigate to the desired document and click **Open**. The **Open** dialog box closes and the selected document is loaded into the Import Wizard.)

3. Click **Next** to continue.
The **Match Requirement Types** screen appears:

![Match Requirement Types](image)

The Import Wizard, by default, selects the RequisitePro requirement type that matches the requirement types in the CSV file that you are importing. You can override the default selection.

4. Click **Next** to continue.

The **Match Attributes** screen appears:

![Match Attributes](image)

5. Click **Match Manually** to check that RequisitePro mapped the attributes correctly.
The **Match Attributes** dialog box appears:

6. Complete the following information:
   - If you want to change the mapping, click and hold the mouse while dragging a new line from an imported attribute to an existing attribute.
   - If RequisitePro could not make a match, the imported attribute will be listed but will have no line connecting it to an existing RequisitePro attribute. You can make the match manually if you recognize an attribute with the same meaning. Requisite Pro will ignore any attributes left unconnected. Only matched attributes are imported.
   - When you are satisfied with the attribute matching, click **OK** to return to the Wizard.

7. Click **Next** to continue.
The Select A Resolution dialog box appears:

When attribute values in the imported requirements conflict with the values in existing requirements, RequisitePro can resolve the conflict in one of two ways:

• add the imported requirements as new requirements in your document or database
• overwrite your existing attribute values with those in the imported CSV file.

Depending on your choice, you will take one of two paths: The Define new RequisitePro requirements Import Option on page 11-21 or The Update attributes of existing requirements Import Option on page 11-23.
The Define new RequisitePro requirements Import Option

The Wizard imports the text of the requirements as written in the CSV file. You can accept or delete the requirements before importing.

1. Select Define new RequisitePro requirements and click Next.

   The Requirements to Import screen appears:

   ![Requirements to Import screen]

2. Review requirements in the list and revise the list as needed:
   - Click View to read the full text of the requirement. The Edit Imported Requirements dialog box appears. Select a requirement from the list. The full text of the requirement displays in the text pane at the bottom of the dialog. To make changes to any of the list-type attribute values, double-click on the cell and select a new value from the drop-down list. To make changes to entry-type attribute values, select the value and type the new value. Click Accept for Import.
   - Click Remove to remove a selected requirement. (A requirement that was removed is not entirely deleted. It is moved into the Add requirements dialog box.)
   - Click Add to review a list of requirements you have removed. If you would like to add a requirement back into the list, select it and click OK.

3. Click Next to continue.
Import Wizard

The Select A Destination screen appears:

4. Choose a destination for the new imported requirements:
   - Select Current project database to bring the requirements into the database of the open project.
   - Select New RequisitePro document to create a new document (based on the document type of your choosing) and bring the requirements into the new document. The Document dialog box appears and prompts you to record the document name, filename, and document type.
   - Select Existing RequisitePro document to choose from a list of existing project documents. If the file you choose is not open, RequisitePro opens it for you.

5. Click Next to continue. The final Status screen appears:

6. Click Commit to accept the import or click Cancel to cancel the import in its entirety.
The Update attributes of existing requirements Import Option

The new imported requirement attributes overwrite the requirement attributes in the open project. The text of the imported requirements will not be imported. You can accept or delete the requirements before importing.

1. Select **Update attributes of existing requirements** and click **Next**. The **Requirements to Import** screen appears:

   ![Requirements to Import screen](image)

   The list box shows tag numbers, followed by the comment: [text will not be imported].

2. Review requirements in the list and revise the list as needed:
   - Click the **View** button to access the **Edit Imported Requirements** dialog box. Only tag numbers are displayed, as the text will not be imported. (To view the text of the requirements associated with the tag numbers, refer back to the Attribute Matrix in the Views Workplace.)
   - Click the **Remove** button to remove requirements from the list and store them in an **Add requirements** dialog box.

3. Click **Next**.
The Import Wizard displays the final **Status** screen.

4. Click **Commit** to accept the import, or click **Cancel** to cancel the import in its entirety.
Exporting Requirements

Requirements are exported from RequisitePro in the Views Workplace.

- An Attribute Matrix can be exported as a CSV file or as a Word document.
- A Traceability Matrix can be exported as a CSV file only.
- A Traceability Tree can be exported as a CSV file or as a Word document.

Exporting a View as a CSV File

As described above in Importing a CSV File on page 14, a CSV file is a data file consisting of fields and records, stored as text, in which the fields are separated from each other by commas. If the data in a field contains a comma, the field is further surrounded with quotation marks.

To export a view as a CSV file:

1. Open the Attribute Matrix, the Traceability Matrix, or the Traceability Tree that you want to export.
2. Click the File menu in the Views Workplace, choose Export, then Export to CSV.

   The Export to CSV dialog box appears:

3. Complete the following information:
   - Choose a location to save the exported file in the Save in drop-down list.
   - Type a name for the exported file in the File name text box.
   - Do not modify the .csv file selection in the Save as type text box.
4. Click **Save**.

RequisitePro exports the View as a comma separated value file (*.csv), which is readable by such applications as SQL Server, Oracle, Excel, and Access.

**Exporting a View as a Word Document**

**To export a view as a Word document:**

1. Open an Attribute Matrix or a Traceability Tree that you want to export.
2. Click the **File** menu, choose **Export**, and then **Export to Word**. The **Export to Word** dialog box appears.

![Export to Word dialog box]

3. Complete the following information:
   - Choose a location to save the exported file in the **Save in** drop-down list.
   - Type a name for the exported file in the **File name** text box.
   - Do not modify the .doc file selection in the **Save as type** text box.
4. Click **Save**.

RequisitePro exports the View as a Word document (*.doc), then opens Word and displays the exported View as a Word document table.

**Note:** When a Traceability Tree is exported to a Word document, RequisitePro creates a new document based on a template created especially for this export (**treexprt.dot**). You can modify this template and its styles to suit your needs. Heading styles 1-9 can be modified, but they must be retained.
Project Creation

Project managers create and manage all elements of projects. This chapter provides instructions for performing the following tasks:

- Creating a project using a blank project database
- Creating a project using the Project Wizard
- Creating a project using an existing project as a template
- Converting earlier versions of RequisitePro projects to the 4.0 format

Creating a Project Using a Blank Project Database

This feature is intended for use by knowledgeable users who want the most flexibility when creating a new project. To use this feature effectively, it is important that you know how to work with each of the tabs in the Project dialog box.

1. On the Tool Palette, click the Project menu and choose New. The New Project dialog box appears.
Project Creation

2. Select **Blank Project database** and click **OK**.
   The **Project** dialog box appears, with the **General** tab in front.

3. Click the **Name** text box and type a unique name of up to 64 characters, or accept the default name provided by RequisitePro. The first eight characters of the project prefix are used to identify the project if the project is used for cross-project traceability. RequisitePro automatically populates the **Creator** text box with your RequisitePro user’s name. This text box is read-only and cannot be edited.

4. In the **Directory** text box, specify a path for RequisitePro to store the project. Accept the default or click **Browse** and select a path in the **Browse for Folder** dialog box. The path should include the drive, the project directory, and the new project folder. The path cannot exceed 256 characters. Once the project is created, you cannot change this field.
   
   **Note:** You can later relocate a project by moving the project directory to another location in the file system. To access the project in its new location, users must add it to their catalogs.

5. In the **Database** field, click the down arrow to select a database for storing the project. If RequisiteEnterprise is installed on your PC, you have the option to create projects in Microsoft Access, Microsoft SQL Server, or Oracle.

6. If you select the Microsoft SQL Server or Oracle database, click **Properties** to configure your access to that database.
Note: For more information on configuring SQL Server or Oracle, click the Tools menu on the Tool Palette. Point to the Rational RequisiteEnterprise submenu and select the Oracle or SQL Server Configuration Reference command. For additional information, see the Rational Requisite Installation Guide.

7. If desired, clear the **Save documents in RequisitePro Format** check box. RequisitePro marks this check box by default. If this check box is marked, documents are secure; that is, they cannot be opened in Word outside of RequisitePro. If this check box is cleared, documents are not secure; that is, they are saved in Word format, and can be opened in Word outside of RequisitePro.

If the directory specified does not exist, the **Project** message box appears, prompting you to create the directory. Click **Yes** to create the directory.

8. Use the other tabs in the **Project** dialog box to create settings and record more information about the project. See Chapter 15, *Project Information*, for further instructions about using the tabs in the **Project** dialog box.

9. Click **OK** in the **Project** dialog box to create the project.

**Recording Revision Information About the Project**

Use the Revision tab in the Project dialog box to view information about the most recent revision of the project. Enter optional information about the most recent revision, and access the project’s revision history.

In the **Project** dialog box, click the **Revision** tab.

- The **Revision** text box contains the revision number. This read-only text box cannot be edited unless the project is checked in to Visual SourceSafe, PVCS Version Manager, or ClearCase, or is archived using RequisitePro’s **Archive** command. You can only override the revision number when the project is archived. The new revision number that you use must be greater than the existing number and must be expressed in an N.m format, for example, 2.5.

- The **Label** text box contains a descriptive name for the revision. This field is optional and only available if changes have been made to project properties.

- The **Date** text box is read-only and displays the date the project was modified.
Project Creation

- The **Time** text box is read-only and displays the time the project was modified.
- The **Change Description** text box displays changes made to the project. This field is optional and only available if changes have been made to project properties.
- The **History** button opens a dialog box that displays the change history of the project.

Creating a Project Using the Project Wizard

The Project Wizard simplifies the process of creating a project by guiding you through the procedure step-by-step.

1. On the Tool Palette, click the **Project** menu and choose **New**.
   The **New Project** dialog box appears.

2. Select **Use the project wizard** and click **OK**.
Creating a Project Using the Project Wizard

RequisitePro starts the Project Wizard and the Welcome screen appears.

3. Click Next.
   The Project screen appears.

4. Complete the information:
   • In the Name text box, type a name for the project, or accept the default name provided by RequisitePro.
   • In the Description text box, type a description of the project (this step is optional).
   • In the Directory text box, specify a location for storing the project. Accept the default or click Browse and select a path from the Browse for Folder dialog box.
Project Creation

- In the **Database** field, click the down arrow to select a database for storing the project. If RequisiteEnterprise is installed on your PC, you have the option to create projects in Microsoft Access, Microsoft SQL Server, or Oracle.
  - If you select the Microsoft SQL Server or Oracle database, click **Properties** to configure your access to that database.

5. Click **Next** to continue.

The **Document Type information** screen appears.

Note: If the directory specified does not exist, the **Project** message box appears, prompting you to create the directory. Click **Yes** to create the directory. Click **No** to close the message box without creating the directory.

6. Read the information on the screen, and click **Next** to continue.

The **Create the First Document Type** screen appears.

7. Complete the information:
   - In the **Name** text box, type a name for the document type, or accept the default provided by RequisitePro.
   - In the **Tag** text box, specify a tag to label requirements created in this document type, or accept the default provided by RequisitePro.
   - In the **Description** text box, type a description of the document type.
   - To indicate that any requirements created in the document must contain the work “shall,” mark the **Requirements must contain the word shall** check box.
Creating a Project Using the Project Wizard

Note: This step is optional. You can change “shall” to a different word once you have created the project and opened the document.

- Select an outline to be used with the document type. If you choose the default selection, None, RequisitePro uses the normal.dot Word template.

8. Click Next to continue.

The Defined Document Types screen appears.

9. Do one of the following if needed:
   - To add more document types, click Add, and repeat steps 5 and 6 above.
   - To edit a document type, click Edit. Complete the information in the Edit a document type screen and click Next.
   - To remove a document type, click Remove.

10. Click Next to continue.

The Document description screen appears.

11. Read the information in the pane and click Next to continue.
The Create the First Document screen appears.

12. Complete the information:
   - In the Description text box, type a description of the document.
   - In the Document Type list, select a document type.
   - To create a RequisitePro document from an existing Word document, type the document name in the Document to import text box, or click Browse to find the document.

13. Click Next to continue.

The Documents Defined screen appears.

14. Do one of the following:
   - To add more documents, click Add and repeat step 9.
   - To edit a document, click Edit.
Creating a Project Using an Existing Project as a Template

- To remove a document from the list, click **Remove**.

15. Click **Next** to continue.

   The **Congratulations** screen appears.

16. Click **Finish** to complete the process.

Creating a Project Using an Existing Project as a Template

When you use an existing project as a template, RequisitePro creates the new project using the same structure as the existing project. Document types, requirement types, view definitions, attributes, user and group permissions are all copied. Documents, requirements, history information, and traceability relationships are not copied.

1. On the Tool Palette, click the **Project** menu and choose **New**.

   The **New Project** dialog box appears.

2. Click **Use an existing project as a template**.

3. In the **Cataloged projects** list, select the name of the project to use as a template and click **OK**.

   RequisitePro opens the project, duplicates the project structure and opens the **Project** dialog box with the **General** tab displayed in front.

4. In the **Name** text box, type a name for the project, or accept the default name provided by RequisitePro.
Project Creation

5. In the **Description** text box, type a description of the project (this step is optional).

6. In the **Directory** text box, specify a location for storing the project. Accept the default or click **Browse** and select a path from the **Browse for Folder** dialog box.

7. In the **Database** field, click the down arrow to select a database for storing the project. If RequisiteEnterprise is installed on your PC, you have the option to create projects in Microsoft Access, Microsoft SQL Server, or Oracle.

8. Click **OK**. The project is cataloged and ready for use.

**Converting RequisitePro Projects to the 4.0 Format**

If you try to open a project created in RequisitePro 2.0, 2.1, 2.5, 3.0, or 3.1, the Project Conversion Wizard automatically displays and guides you through the database conversion.

**Note:** In RequisitePro 4.0, you cannot open projects that were created in versions of RequisitePro earlier than 2.0, including Requisite Baseline.

Prior to conversion, the project is archived in its original form in a backup subdirectory in the project directory. You can use this archive to open the project in the earlier version of RequisitePro. You cannot open 4.0 versions of projects in earlier versions of RequisitePro.

Conversion includes the following:

- Conversion to 32-bit format (versions 2.0 and 2.1).
- Conversion to allow for the new features in RequisitePro 4.0:
  - Offline authoring
  - Multiple value lists
  - Extended selection in views
  - Keyboard shortcuts and mouse actions to quickly select items in views
  - Discussion groups
  - E-mail setup for discussion groups
  - Custom menu options for external applications
  - Configuring RequisitePro
To convert to 4.0:

1. On the Tool Palette, click the **Project** menu and choose **Open**.

   The **Open Projects and Documents** screen appears.

   ![Open Projects and Documents Screen](image)

2. Select the project to open and click **OK**.

   If the project was created in an earlier version of RequisitePro, the **Project Conversion Wizard Introduction** screen appears.

3. Click **Next**.

   The **Project Archive** screen appears.

4. In the **Archive Location** text box, specify the location for the archived project.

   RequisitePro makes a copy of the project and its documents and stores it in the archive directory before converting the project to a RequisitePro 4.0 project.

5. If you started the conversion process from the command line, the **Project Selection** screen appears, prompting you for the location of the project to convert. In the **Selected Project** text box, specify a location for the project.

6. Click **Archive** to continue.

   RequisitePro archives the project.

   The **Project Conversion** screen appears.

7. Click **Convert** to convert the project.

   The Congratulations screen appears.

8. Click **Close** to complete the process.
Project Creation
CHAPTER 13

Project Security

Because RequisitePro allows multiple users to access the same project documents and database simultaneously, project security is crucial. It assures that all changes to requirements and documents are tracked properly.

You can enable or disable security in a project, depending on the needs of the group. With security enabled, users belong to groups. Project managers assign group-specific permissions. The permissions determine the amount or kind of access users have to projects. Security permissions are assigned at the group level, not the user level, and a user can be in only one group.

Any RequisitePro user can create a new project. When you create a new project, you are considered the project administrator and are automatically placed in the Administrators group. After you create the project, you (and other Administrators) can define other users and groups.

When you first create a project, security is not enabled. If you want to use project security, you must specify it in the Project Security dialog box.

If security is enabled, the Project Logon dialog box appears each time you or another user opens the project. The project manager who enabled security can assign passwords for other users.
Setting Security

To enable or disable security for a project:

1. On the Tool Palette, click the **Project** menu and choose **Security**. The **Project Security** dialog box appears.

2. Click the **Enable security for this project** check box. Mark the check box to enable security; clear the box to disable security.

3. Select groups and users by following the steps in the next section.

4. Click **OK**.

Creating and Modifying Groups and Users

RequisitePro provides three default security groups: **Deleted Users**, **Administrators**, and **Users**. Remember that all security permissions are assigned at the group level only, and a user can be in only one group.

- **Deleted Users**. This group contains users who have been deleted from other groups, have no permissions, and cannot log on to RequisitePro. This group is maintained by RequisitePro for project history.

- **Administrators**. Members of this group have full permissions to work in a project. They can change a project structure, create and modify data, and set and maintain security permissions. You can add and remove users from this group, but you cannot modify Administrators group permissions.

- **Users**. By default, members of the Users group can read documents and requirements, create views, and participate in discussions. You can modify Users group permissions.
Creating and Modifying Groups and Users

You can add and delete groups, add users to groups, move a user to a different group, and edit a user’s information, such as user name, password, and e-mail address.

Creating a New Security Group

To create a new security group:

2. Click Add below the Groups list box. The Group Permissions dialog box appears.
3. In the Name text box, type a name for the group.
4. Set the group permissions and click OK. For more information on setting and editing group permissions, see Assigning Permissions to a Security Group on page 13-6.
5. Click OK to save and close the Project Security dialog box.
Deleting a Security Group

If all users have been removed from a group, you can remove the group.

To delete a group:
2. In the Groups list box, select the group to delete.
3. Click Delete. RequisitePro prompts you to confirm the deletion.
4. Click OK.
5. Click OK in the Project Security to save and close.

Adding a User to a Security Group

To add a user to a group:
2. In the Users of Group list, select the group to add the user to, and click Add next to the Users of Group list. The Add User dialog box appears.

3. In the Username text box, type the user’s name (up to 20 alphanumeric characters, not case sensitive).
4. In the New Password text box, type the user’s password.
5. In the Verify text box, type the password again.

Note: Passwords are case-sensitive (for example, Mycomputer, MYCOMPUTER, and mycomputer are treated as different passwords). Passwords are limited to 14 alphanumeric characters.
6. In the E-Mail Address text box, type the user’s e-mail address. This e-mail address is necessary for participating in RequisitePro discussions via e-mail. For more information, see Configuring E-mail for Discussions on page 6-2.

7. Click OK. RequisitePro adds the new user to the group.

8. Click OK to save and close the Project Security dialog box.

**Editing User Information**

**To edit user information:**


2. In the Groups list, select the security group to which the user belongs.

3. In the Users of Group list, select the user name.

4. Click Edit next to the Users of Group list. The Edit User dialog box appears.

5. Edit the user name, password, or e-mail address.

6. Click OK.

7. Click OK to save and close the Project Security dialog box.

**Deleting a User from a Security Group**

When you delete a user from a security group, RequisitePro moves the user to the <Deleted Users> group. All records associated with the user are maintained. If you reinstate a user with the same name as a deleted user, RequisitePro prompts you to confirm whether it is the same person before RequisitePro reinstates the user.

**To delete a user:**


2. In the Groups list, select the group containing the user.

3. Select the user in the Users of Group list.

4. Click Delete below the Groups list. A dialog box appears, prompting you to confirm deletion of the user.
5. Click **Yes** to move the user from the current group to the *<Deleted Users>* group.
6. Click **OK** to save your changes and close the **Project Security** dialog box.

### Moving a User to Another Security Group

**To move a user to another security group:**

1. On the Tool Palette, click the **Project** menu and choose **Security**. The **Project Security** dialog box appears.
2. In the **Groups** list, select the group containing the user.
3. Select the user in the **Users of Group** list.
4. Click **Move**. The **Move User** dialog box appears.
5. Select the group to move the user to.
6. Click **OK**.
7. Click **OK** to save your changes and close the **Project Security** dialog box.

### Assigning Permissions to a Security Group

Each security group has its own set of unique permissions. All members of the group share the same permissions. The following list shows all possible permissions that can be assigned to a group:

- **Project permissions**: access the project, manage project structure, manage project security.
- **Document type permissions**: read, update, create/delete documents.
- **Requirement type permissions**: read, update, create/delete requirements.
- **Attribute permissions**: read, update attributes.
- **Attribute value permissions**: read, update attribute values.
Members of the Administrators group and groups with project security permissions can create group accounts, assign permissions to the groups, and add, move, edit, and delete users in groups.

**To assign permissions:**

1. On the Tool Palette, click the **Project** menu and choose **Security**. The **Project Security** dialog box appears.
2. In the **Groups** list, select the group.
3. Click **Edit** below the **Groups** list.
   - The **Group Permissions** dialog box appears.

![Group Permissions dialog box](image)

**Note:** The Administrators group has full permissions. You cannot edit this group’s permissions, although you can add and remove users from the Administrator’s group.

4. To assign project structure modification permissions to the group, mark the **Can manage project structure** check box. Groups with these permissions have complete access to all tabs and information in the **Project** dialog box for this project. To remove a group’s permissions, clear the check box.

**Note:** The **Can access project** check box is automatically checked and cannot be changed.
5. To assign project security permissions to the group, mark the **Can manage project security** check box. Groups with these permissions can change group and user permissions for this project. To remove a group’s permissions, clear the check box.

6. Assign document, requirement, attribute and attribute value permissions, as described in the following sections.

7. Click **OK**.

**Assigning Document Type Permissions to a Security Group**

**To assign document-type permissions:**

1. On the Tool Palette, click the **Project** menu and choose **Security**. The **Project Security** dialog box appears.

2. In the **Groups** list, select the group.

3. Click **Edit** below the **Groups** list. The **Group Permissions** dialog box appears.

4. In the **Document Types** list, select the document type for which you want to assign permissions.

5. Click **Edit Permissions** below the **Document Types** list. The **Document Type Permissions** dialog box appears.

6. Assign document permissions by marking the corresponding check box. Groups can have read, update, and/or create/delete permissions. To remove a permission assigned to a group, clear the check box that corresponds to the permission. If you do not want the group to have any permissions for this document type, clear all three selections.

   - **Read** permissions: Members of the group can view documents of this type. If **Read** is the only permission selected, members of the group cannot modify documents of this type.
• **Update** permissions: Members of the group can modify documents of this type. If **Update** is selected, **Read** is also automatically selected.

• **Create/Delete** permissions: Members of the group can create and delete documents of this type. If **Create/Delete** is selected, **Read** and **Update** are also automatically selected.

7. Click **OK** to save the modifications.

### Assigning Requirement Type Permissions to a Security Group

**To assign requirement-type permissions:**

1. On the Tool Palette, click the **Project** menu and choose **Security**. The **Project Security** dialog box appears.

2. In the **Groups** list, select the group.

3. Click **Edit** below the **Groups** list. The **Group Permissions** dialog box appears.

4. In the **Requirement Types** list, click the requirement type for which you want to assign permissions.

5. Click **Edit Permissions** below the Requirement Types list. The **Requirement Type Permissions** dialog box appears.
6. Assign requirement permissions by marking the corresponding check box. Groups can have read, update, and create/delete permissions. The Read check box is automatically selected and cannot be cleared. To remove one of the other permissions assigned to a group, clear the check box that corresponds to the permission.

- **Read** permissions: Members of the group can view requirements of this type. If Read is the only permission selected, members of the group cannot modify requirements of this type. This requirement-type permission is automatically selected, and the box cannot be cleared.

- **Update** permissions: Members of the group can modify requirements of this type.

- **Create/Delete** permissions: Members of the group can create and delete requirements of this type. If Create/Delete is selected, Update is also automatically selected.

7. If desired, select a requirement attribute and click **Edit Permissions** to assign attribute permissions to the security group. For more information, see the following section.

8. Click **OK** to save the modifications.

### Assigning Attribute Permissions to a Security Group

**To assign attribute permissions:**

1. Select the requirement type, as described in steps 1 through 5 in **Assigning Requirement Type Permissions to a Security Group** on page 13-9.

2. In the **Requirement Type Permissions** dialog box, select the attribute.

3. Click **Edit Permissions**.

   The **Attribute Permissions** dialog box appears.
Assigning Permissions to a Security Group

• **For list-type attributes**, the dialog box pictured below appears.

![Attribute Permissions Dialog Box](image)

The **Read** permission check box is automatically marked and cannot be cleared. To allow users to modify attributes of the selected type, mark the **Update** check box and refer to the section on page 12 for more information on assigning permissions to modify specific attribute values.

• **For entry-type attributes**, the dialog box pictured below appears.

![Attribute Permissions Dialog Box](image)

The **Read** permission check box is automatically marked and cannot be cleared.

4. Mark the **Update** check box to give members of the group permissions to modify the attributes. Clear the box to allow default **Read** permissions only.

5. Click **OK**.

6. Click **OK** in the **Requirement Type Permissions** and **Group Permissions** dialog boxes.
Assigning Permissions to Attribute Values for a Security Group

To assign permissions to attribute values:

1. Select an attribute, as described in steps 1 through 3 in Assigning Attribute Permissions to a Security Group on page 10.

2. Mark the Update check box in the Attribute Permissions dialog box for the list-type attribute.

   The attribute values in the list box and the Edit Permissions button are enabled.

3. Select an attribute value in the list and click Edit Permissions.

   The Attribute Value Permissions dialog box appears.

   ![Attribute Value Permissions dialog box]

   The Read permission check box is automatically marked and cannot be cleared.

4. Mark the Update check box to give members of the group permissions to modify the attribute value. Clear the box to allow default Read permissions only for the attribute value.

5. Click OK.

6. Repeat steps 3 and 4 to set or remove group permissions for other attribute values.

7. Click OK in the Attribute Permissions, Requirement Type Permissions, and Group Permissions dialog boxes.
This chapter provides instructions for the following tasks for managing projects:

- Controlling user access to a project and its documents
- Creating outlines
- Renumbering requirements
- Printing project summaries and reports
- Archiving projects
- Removing a project’s revision information
- Removing documents and requirements from a database

**Controlling User Access to a Document**

When opening projects and documents, you have several options for controlling access by other users when the project and documents are open:

- Exclusive access limits access to the project and documents to the user who opens the project. Exclusive access is needed to renumber requirements, change tag prefixes, change requirement color and style, remove an attribute, remove revision information and propagate a revision number.
- Read-only access lets a user open a project for viewing only.
- Document read-only access lets a user open a document for viewing only.

For information on setting up read-only or create/delete permissions for projects and requirements documents, refer to chapter 13, *Project Security* on page 13-1.
Locking and Unlocking Project Documents

When you lock a document, users cannot modify its text, graphics, or OLE objects. Locking a document does not prevent users with appropriate permissions from modifying the document properties, such as logical name or description, or requirement properties, such as attribute values and traceability relationships. When you lock a document, it remains locked until you or another user with update permissions unlocks it.

To lock a document:

- On the Tool Palette, click the Document menu and choose Lock.
- A check mark appears next to Lock.

To unlock a document:

- On the Tool Palette, click the Document menu and choose Lock.
- The check mark next to Lock is cleared. Read- and write-access is allowed to the document.

Protecting Documents for Revisions

When you protect a document for revisions, you can electronically distribute the document or make it available in a shared directory for reviewers to suggest changes. You can then merge the revisions in one document.

- On the Tool Palette, click the Document menu and choose Protect for Revisions.
- A check mark appears next to Protect for Revisions. You can now distribute the document to reviewers or place copies of it in a shared directory.

Note: You can also use RequisitePro’s offline authoring feature to edit a document in Word outside of RequisitePro. (See Working With Documents Offline on page 7-8.)
Creating Outlines

Outlines are templates that are useful for maintaining consistency across documents of the same type, such as software requirements specifications. Outlines can help you quickly create user-needs documents, specifications, and test plans.

Assign outlines to a document type in the **Documents Type** tab in the **Project** dialog box.

RequisitePro provides the following outlines:

- Products Requirements Outline
- Software Requirements Outline
- Stakeholder Needs Interview Outline
- Supplementary Requirements Specification
- Test Case Specification
- Test Design Outline
- Use Case Actors Document
- Use Case Glossary
- Use Case Specification
- Vision Requirements Outline

To create an outline:

1. Start Microsoft Word outside of RequisitePro.
2. Create a new template. (See the Word documentation for more information about creating templates.)
3. Move the new template and help file to the RequisitePro **Outlines** directory.

Note: Templates are automatically stored in the RequisitePro Outlines subdirectory. You can set a second location for additional templates, such as those shared on a network or used by a particular project: Use the **Options** command on the Tool Palette **Tools** menu to specify a secondary location for the outlines. Type the full path and subdirectory name in the **Outline Path** field, and click **OK**.

4. In a text editor, create a new text file containing the following three lines of information, separated by carriage returns (<CR>):
   - The outline's full name, up to 64 characters
• A description of the outline, up to 256 characters
• The Word template's DOS filename

For example:

Acme Enterprises Standard Software Requirement Specifications
Standard outline used for Software Requirements Specifications at Acme Enterprises
acme_srs.dot

5. In the **Outlines** directory, save the text file, using the same file name as the template and the extension .def (for example, **acme_srs.def**).

---

**Renumbering Requirements**

If the project is opened in exclusive mode, you can renumber all requirements of one or more specified types in the requirements document and database. This feature is useful to eliminate the “holes” in a numbering scheme that result when you delete or move requirements.

If security is enabled, you must have project structure permission to renumber requirements.

The requirements are renumbered in a document in the order in which they appear.

**To renumber requirements:**

1. On the Tool Palette, click the **Project** menu and choose **Renumber Requirements**.

   The **Renumber Requirements** dialog box appears.
2. In the **Requirement Type** list, select the requirement type for which you want to change the numbering.

3. Mark the **Renumber Requirements of this type** check box.

4. In the **Initial Requirement Number** text box, enter the initial requirement number that you want to set. The default number is 1.

5. To change the order of renumbering for documents and database requirements, select a document name or database in the **Order of Processing** list, and then click **Move Up** and **Move Down**. The requirements in the first item listed (the database or a document) are renumbered first, followed sequentially by the requirements in the second item, and so on.

   Note: A document appears in the **Order of Processing** list only if it contain requirements of the selected type.

   Note: You can select another requirement type and repeat the above steps to add more requirement types.

6. Click **OK**.

---

**Printing Project Summaries and Reports**

**Printing a Project Summary in RequisitePro**

1. On the Tool Palette, click the **Project** menu and choose **Print Summary**.

2. Verify that the correct printer is selected.

3. Click **OK**.

**Using Rational SoDA with RequisitePro**

RequisitePro is integrated with SoDA, Rational’s software documentation automation tool. RequisitePro is compatible with SoDA 3.5 for Word.

Using SoDA and RequisitePro, you can:

- Modify and generate SoDA reports and documents from an open RequisitePro project.
- Create a report that consolidates RequisitePro requirements information and Rose modeling information.
- Create a use case report that includes all use case requirements and Rose use case diagrams.
Before you begin the following procedure, make sure SoDA 3.5 for Word is installed and a RequisitePro project is open.

1. On the Tool Palette, click the **Project** menu and select **Generate SoDA Report**. The **SoDA** dialog box appears, showing a list of templates for use with RequisitePro.
2. Select a template from the list and click **OK**. SoDA for Word appears. The **SoDA** menu is active and the selected template is open.
3. Use the template to create a SoDA report from the open RequisitePro project. Refer to the SoDA documentation for more information about generating SoDA reports.

### Archiving Projects

RequisitePro provides four methods for archiving projects:

- The Archive command in RequisitePro
- Rational ClearCase
- Intersolv PVCS Version Manager
- Microsoft Visual SourceSafe

RequisitePro integrates with PVCS Version Manager and Visual SourceSafe by providing an interface directly into your archives. For projects archived with ClearCase, you must use the ClearCase interface to access non-tip revisions.

You must have PVCS Version Manager, Visual SourceSafe, or Rational ClearCase installed on your system to use one of these archiving options with RequisitePro. If you do not have one of these applications, you can use the Archive command in RequisitePro.

Since RequisitePro is a multi-user tool itself, it uses the above applications differently than version control tools are traditionally used. All users check out the projects into a shared location. Users only check in the projects to provide an archiving history, or snapshot view, to review over time.

**Note:** The archive features are not available for RequisiteEnterprise projects that use an Oracle or SQL Server database. Use your database administration tools to back up projects and documents in those databases.
Archiving Projects with the Archive Command

Using the Archive command in RequisitePro, you can store a project and make a backup copy of a project.

**To archive projects with RequisitePro’s Archive command:**

1. On the Tool Palette, click the **Project** menu and choose **Archive**.
2. Click **RequisitePro Archive**. The **Archive Project** dialog box appears:

3. Select the directory where you want the backup copy stored. Click **Browse** to open the **Browse for Folder** dialog box, where you can specify an existing directory.
   Once you have selected a directory, click **OK** to close the dialog box.
   Note: To create a new subdirectory, click at the end of the directory field and add a backward slash (\) followed by a new subdirectory name.

4. Enter a new revision number for the project. It must be greater than or equal to the current revision number (in the form xxxx.yyyy).

5. To apply the revision number to the requirement documents, mark the **Propagate to all documents** check box.
   Note: If security is enabled, you must have project structure permission to propagate the revision number. You must also have the project opened exclusively.

6. Enter a name for the archived version in the **Version Label** text box and a description for it in the **Change Description** text box.
Archiving Projects with ClearCase

Integrated with RequisitePro, Rational ClearCase only archives the tip revision of a project. To use ClearCase, you must set a ClearCase directory in the Option dialog box.

Setting Configurations to Use ClearCase

Before using Rational ClearCase, you must set a destination directory for project archives.

Warning: Before setting a destination directory, contact your ClearCase administrator, if you have one. Setting this directory will affect anyone using project archives.

1. In the Tools Palette, click the Tools menu and choose Options. The Options dialog box appears.
2. Type a destination directory in the ClearCase View field.
3. Click OK.

Adding Projects to ClearCase

When you add a project to ClearCase, the project files will be copied from their current location to the specified directory, where they are managed by ClearCase. You must have exclusive access to a project to add it to the ClearCase archive.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click ClearCase. The ClearCase dialog box appears.
3. Click Add. The Add Project to ClearCase dialog box appears.
4. In the listing of projects in your catalog, select the project, and then click OK. The Check in to ClearCase dialog box appears.
5. Enter the appropriate information for the project, and then click OK.
   Note: If security is enabled, you must have project structure permission to propagate a revision number.

Checking Projects into ClearCase

When you are finished working on a project, you can check it back into the ClearCase manager. For security purposes, only the user who checked the project out can check the project back in. When a project is checked in, the project’s revision number is incremented.
1. On the Tool Palette, click the Project menu and choose Archive.
2. Click ClearCase. The ClearCase dialog box appears.
3. In the RequisitePro Projects in ClearCase listing, select the project.
4. Click Check In. The Check in to ClearCase dialog box appears.
5. Accept the Revision number, or enter a new revision number for the project.
6. To apply the revision number to the requirement documents, mark the Propagate to all documents check box.
   
   Note: If security is enabled, you must have project structure permission to propagate the revision number.
7. Enter the appropriate information in the Version Label and Change Description text boxes.
   
   Note: The only information stored by ClearCase is the change description and label; the rest of the information is used by RequisitePro.

Checking Projects out of ClearCase
You check a project out of ClearCase to make revisions to it.
1. On the Tool Palette, click the Project menu and choose Archive.
2. Click ClearCase. The ClearCase dialog box appears.
3. In the RequisitePro Projects in ClearCase listing, select the project.
4. Click Check Out. The project is checked out for write-access. The status in the ClearCase dialog box changes from Checked In to Checked Out.
   
   Note: You can check a project back in without retaining the modifications you have made by clicking Unlock Project in the ClearCase dialog box.

Undoing Checked-out Projects in ClearCase
The undo feature (also called the unlock feature) is useful when you do not want to retain the modifications made to a project when you or another user checked it out, or if a project was inadvertently checked out. This feature
checks the project in exactly as it was checked out. The revision number is not
increased, and any modifications that were made to the project when it was
checked out are not saved.

1. On the Tool Palette, click the Project menu and choose Archive.

2. Click ClearCase. The ClearCase dialog box appears.

3. In the RequisitePro Projects in ClearCase listing, select the project.

4. Click Undo Checkout. A dialog box appears, asking you to confirm the
   procedure.

5. Click Yes. The project is checked in without retaining any changes made
   when it was checked out.

Viewing Non-tip Revisions in ClearCase

Integrated with RequisitePro, Rational ClearCase only displays the tip revision
of a project. You cannot view previous versions of a project (non-tip revisions)
in the RequisitePro ClearCase interface. Instead, you must open the version
manager through the ClearCase software itself.

Archiving Projects with the PVCS Version Manager

PVCS Version Manager manages project versions. You can use PVCS Version
Manager to check a project in and out, and to gain read-only access to earlier
versions of the project. In addition, PVCS Version Manager stores a backup
copy of your project.

Adding Projects to the PVCS Version Manager

When you add a project to the PVCS Version Manager, the project is removed
from your catalog. You must then check the project out from the PVCS
Version Manager to access it in RequisitePro.

1. On the Tool Palette, click the Project menu and choose Archive.

2. Click PVCS Version Manager.

3. Click Add.

4. Select the project from the listing of projects in your catalog, and then click
   OK.
5. In the Check in to PVCS Version Manager dialog box, enter the appropriate information for the project, and then click OK. PVCS removes the project from your catalog and stores it in the PVCS Version Manager archive. To use the project again, you must check it out of PVCS Version Manager.

Note: If security is enabled, you must have project structure permission to propagate a revision number.

Checking Projects Out of the PVCS Version Manager

You can only check out the most recent version of a project (tip revision) stored in the PVCS Version Manager for write-access. The project revision Status changes from In to Out, and the project is added to your catalog.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the Projects in PVCS listing.
4. Select the project revision in the Projects Revision listing.
5. Click Check Out (write) or Check Out (read).

You can only edit the most recent version (write-access).
6. Accept the default location or specify a directory location where you want the project stored.

Checking Projects into the PVCS Version Manager

For security purposes, only the user who checked the project out can check the project back in. You cannot check a project in that has not been modified. When you check a RequisitePro project into PVCS Version Manager, it is removed from your project catalog.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project from the RequisitePro Projects in PVCS listing.
4. Select the current revision in the Project Revisions listing.
5. Click Check In.
6. Accept or enter a new Revision number for the project.
7. Select the Propagate to all documents check box to apply the revision number to the requirement documents.
Note: To propagate the revision number, you must have project structure permission if security is enabled.

8. Type the appropriate information in the Version label and Revision Change description text boxes.

**Viewing Non-tip Revisions in PVCS**

You can view previous versions of a project (non-tip revisions) stored in the PVCS Version Manager in read-only mode. The project is copied and stored in the directory you select.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the Projects in PVCS listing.
4. Select the project revision in the Projects Revision listing.
5. Click Check Out (read).
6. Enter a directory location to store the project.

**Updating Projects in the PVCS Manager**

You can rapidly check a project in and out again and thus increment the revision number. The project revision status changes from “In” to “Out” and the project is added to your catalog. Use this option if you want the archived version of the project to be current, but still want the project checked-out for editing.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the RequisitePro Projects in PVCS listing.
4. Select the tip (most recent) revision in the Projects Revision listing.
5. Click Update.
6. Type the relevant information in the dialog box.
Unlocking Checked-out Projects in the PVCS Version Manager

The unlock feature is useful when you do not want to retain the modifications made to a project when it was checked out or when a project was inadvertently checked out. This feature checks the project in exactly as it was checked out. The revision number is not increased, and any modifications that were made to a project when it was checked out are not saved.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the Projects in PVCS listing.
4. Select the checked out revision of the project in the Project Revisions list.
5. Click Unlock.

Removing Projects from the PVCS Version Manager

You can delete the archived files and delete the subdirectory where the archived files were located. This does not delete the project, but removes it from PVCS Version Manager.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the Projects in PVCS listing.
4. Click Remove from PVCS.
Note: This command deletes the archived files from the directory and deletes the subdirectory where the archived files were located.

Viewing Project Components in the PVCS Version Manager

The components of a project consist of the project database and any documents that are associated with it. The file name, revision number, status, date checked in or out, and user are listed for each file in the project.

1. On the Tool Palette, click the Project menu and choose Archive.
2. Click PVCS Version Manager.
3. Select the project in the Projects in PVCS listing.
4. Select the project revision in the Projects Revision listing.
5. Click Components.
Archiving Projects with Visual SourceSafe

Visual SourceSafe manages project versions. You can use Visual SourceSafe to:
- Store a backup copy of your project
- Check a project in and out
- Gain read-only access to earlier versions of the project

Logging into Visual SourceSafe

Before you can use Visual SourceSafe to archive RequisitePro projects, you must log in through RequisitePro. You must log in even if you already have Visual SourceSafe open on your system.

To log in:
1. On the Tool Palette, click the Project menu and choose Archive.
2. Click Visual SourceSafe. The Visual SourceSafe Login dialog box appears.
3. Enter your user name and password.
   Note: Enter your Visual SourceSafe user name, not your RequisitePro user name. Note that they may be the same.
4. Specify the path for the srcsafe.ini file. Click Browse to specify a different location for the srcsafe.ini file.
   Note: This file is the .ini file in the root directory of your Visual SourceSafe database.
5. Click OK.

Adding Projects to Visual SourceSafe

When you add a project to Visual SourceSafe, RequisitePro removes the project from your catalog. To access the project, you must check the project out of Visual SourceSafe. When you check the project out, RequisitePro increments its revision number.

2. Click Add Project. The Add Project dialog box appears.
3. Select the project, and then click OK. If security is enabled, the RequisitePro Login dialog box appears.
4. Enter your RequisitePro user name and password, and click OK. The Check In dialog box appears.

5. In the RequisitePro Version text box, enter a new revision number for the project (equal to or greater than the value displayed). Use the integer and four-decimal format (for example, 12.1234). This step is optional.

   The default number is 1 plus the current revision number. If the revision number reaches x.9999, the first number (x) increments by 1, and the last number is reset to 0000.

   Note: If security is enabled, you must have project structure permission to propagate a revision number.

   Note: The VSS Version number appears in the VSS Version text box and cannot be changed.

6. Select Propagate to all documents if you want to apply the new revision number, version label, and change description to all documents. If you do not select this check box, RequisitePro applies the new number to the project, but not to its associated documents.

7. In the Version Label text box, enter a label that briefly describes the revision, up to 20 characters. This step is optional.

8. In the Change Description text box, enter a description of changes for the revision. This text is placed in the Comments of each item you check into Visual SourceSafe. This step is optional.

9. Mark the Keep checked out check box if you want the project to remain in the RequisitePro catalog and the files to remain on the file system when you check the project into Visual SourceSafe. If you clear this check box, the project files are removed from the file system and the RequisitePro catalog until you check them out of Visual SourceSafe.

10. Click OK.

**Checking Projects into Visual SourceSafe**

If a project has been previously checked out of Visual SourceSafe for write-access, you can check in the project. To perform this procedure, your user name must match the name of the user currently logged in to RequisitePro.


2. In the Project Revisions list, select the revision you want to check in.
3. Click **Check In**. If security is enabled, the **RequisitePro Login** dialog box appears.


**Checking Projects Out of Visual SourceSafe**

You can only check out the most recent version (tip revision) of a project for write or read-access. The project revision status changes from *checked in* to *checked out*, and the project is added to your catalog. Only one user can check out a project at a time.

1. Log in to Visual Source Safe as described on page 14. The **Visual Source Safe** dialog box appears.

2. In the **Project Revisions** box, select the tip revision of the project. If the project is not currently checked out, VSS displays revisions for the project and enables the **Check Out** button.

3. Click **Check Out**. The **Check Out** dialog box appears.

4. Specify the directory to which you want the project checked out.

5. To specify read-only privileges for tip revisions, select the **Read only** check box.

   This option is enforced for non-tip revisions, which can only be check out read-only. For tip revisions, checking out a project read-only retrieves the tip revision of the project, but does not check out the project in your name.

6. If you want to store all documents in the project directory, mark the **Check out remote documents to project directory** check box.

   This option is only applicable when documents reside in directories that are different than the project directory. This checkbox is selected by default for read-only tip revisions.

7. Click **OK**.

**Viewing Non-tip Revisions in Visual SourceSafe**

You can view previous versions of a project (non-tip revisions) stored in Visual SourceSafe. You view such projects in read-only mode. RequisitePro copies and stores the project in the directory you select.

2. In the RequisitePro Projects in VSS box, select the project.

3. In the Project Revisions dialog box, select the revision of the project.

4. Click Get. The Get dialog box appears.

5. Specify the directory to which you want the project checked out.

   Note: The Read only check box and the Check out remote documents to project directory check box are marked by default for non-tip revisions.

6. Click OK.

**Viewing Project Components in Visual SourceSafe**

The components of a project consist of the versions of the project file, the text files, and the documents that belong to the selected revision. The file name, version number, status, date checked in or out, and user are listed for each file in the project.


2. In the RequisitePro Projects in VSS box, select the project.

3. In the Project Revisions dialog box, select the revision of the project.

4. Click Components. The Project Components dialog box appears, where you can view the components of the project.

5. When you are finished viewing project components, click Close.

**Deleting Projects from Visual SourceSafe**

You can delete the archived files from Visual SourceSafe. This does not delete the project, but simply removes it from Visual SourceSafe.


2. In the RequisitePro Projects in VSS box, select the project to remove.

3. Click Remove Project. A message appears, asking you to confirm the deletion.

4. Click OK.
Removing a Project’s Revision Information

You can delete the change histories of the project, their revision numbers, the associated requirements documents, and all requirements created in the project. This helps keep the project database size smaller.

To remove revision information, you must have the project opened exclusively (for more information, refer to Opening a Project and Documents on page 3-5). Revision information stored in archived projects is not deleted.

To remove revision information:

1. On the Tool Palette, click the Project menu and choose Remove Revisions. The Remove Revisions dialog box appears.

   The Before Date text box in the Remove Revisions dialog box automatically populates with the current date.

2. To change the date, click the Before Date text box and modify the date as needed.

3. Click OK. RequisitePro displays a dialog box describing the deletions.

4. If you want to remove the revision information, click Yes. If you do not want to remove the revision information, click No.
Removing Documents and Requirements from a Project Database

Removing Documents and Requirements from a Project Database

When a document and its requirements are removed from the project database, the requirement formatting and the requirements are deleted (although the text remains) and the document can only be referenced outside RequisitePro as a Word document. The project must be opened exclusively to perform this operation (for more information about the exclusive option, refer to Opening a Project and Documents on page 3-5).

To remove documents and requirements:

1. Open the document in RequisitePro.
2. On the Tool Palette, click the Document menu and choose Remove. A confirmation dialog box appears.

3. To remove the document, click Yes. To cancel the operation, click No.
Project Management
Project Information

Project managers can modify information about a project, including:

- Document types
- Requirement types
- Requirement attributes
- Attribute values
- Cross-project traceability

Working with Document Types

You can create document types and modify existing document types. If you no longer need a document type, you can remove it.

A document type defines descriptive and operational information associated with a requirements document. The document type serves as a template for each requirements document you create of that type.

The document type defines the document’s file extension, such as .prd; all documents of the same document type share the same file extension. The document type identifies a default requirement type; each new requirement you create in the document will be based on the default requirement type unless you indicate otherwise. The document type also identifies an outline (or template) for the document, which controls its page layout, default text, paragraph styles, etc.
Creating and Modifying Document Types

1. On the Tool Palette, click the Project menu and choose Properties. The Project dialog box appears.

2. Click the Document Types tab.

3. Do one of the following:
   - To add a new document type, click Add.
   - To modify an existing document type, select the requirement type in the list, and then click Edit.

   The Document Type dialog box appears.

4. In the Name text box, type a unique name for the document type.

5. In the Description text box, type a description.
6. In the **File Extension** text box, type a file extension. Enter a three-character text string, or, if long file names are supported, a longer extension. The file extension is applied to all documents associated with the document type.

7. Select a requirement type in the **Default Requirement Type** list. The default requirement type is used to specify the type of requirement that is created when Fast Create is used.

8. In the **Name** text box below **Outline**, select an outline to associate with the document type. If you use the default selection, **None**, Word’s `normal.dot` template is used. If you select a new outline, the new outline applies to new documents only. Existing documents are not affected by the change.

9. Click **OK**. The new or modified document type appears in the list box.

10. Click **OK** in the **Project** dialog box.

### Removing Document Types

If no documents of a particular document type exist in a project, you can remove the document type.

1. On the Tool Palette, click the **Project** menu and choose **Properties**. The **Project** dialog box appears.
2. Click the **Document Types** tab.
3. In the **Document Type** list, select the document type you want to remove.
4. Click **Remove**.

---

**Working with Document Types**

6. In the **File Extension** text box, type a file extension. Enter a three-character text string, or, if long file names are supported, a longer extension. The file extension is applied to all documents associated with the document type.

7. Select a requirement type in the **Default Requirement Type** list. The default requirement type is used to specify the type of requirement that is created when Fast Create is used.

8. In the **Name** text box below **Outline**, select an outline to associate with the document type. If you use the default selection, **None**, Word’s `normal.dot` template is used. If you select a new outline, the new outline applies to new documents only. Existing documents are not affected by the change.

9. Click **OK**. The new or modified document type appears in the list box.

10. Click **OK** in the **Project** dialog box.
Working with Requirement Types

You can create requirement types and modify existing requirement types. If you no longer need a requirement type, you can remove it.

A requirement type defines descriptive and operational information associated with a requirement. A requirement type serves as a template for all requirements of the same type and is useful for ensuring consistency and classifying or grouping similar requirements in a project. Requirement types can specify: the initial numbering of the requirements; required terms, such as “must” or “shall”; a standard prefix, such as PR; and color and text formatting. Each requirement type has a unique set of user-defined attributes.

Creating and Modifying Requirement Types

1. On the Tool Palette, click the Project menu and choose Properties. The Project dialog box appears.
2. Click the Requirement Types tab.

3. Do one of the following:
   • To add a new requirement type, click Add.
   • To modify an existing requirement type, select the requirement type in the list, and then click Edit.
Working with Requirement Types

4. The **Requirement Type** dialog box appears.

5. In the **Name** text box, type or edit a name for the document type.

6. In the **Description** text box, type or edit a description.

7. To enable external traceability between requirements of this type in this project and other projects, select the **Allow External Traceability** check box.

8. To specify the starting number for the first requirement of the defined type, click the **Initial Requirement Number** text box and type a positive integer to start this sequence. RequisitePro automatically numbers requirements when they are created.

   The default value for this text box is 1. The initial number sequence can be modified any time before the first requirement of this type is created. Once the first requirement of this type has been saved, you must use the Renumber Requirements dialog box to change the sequence.

9. In the **Requirement Must Contain** text box, type a single word or phrase that must be included in every requirement of this type that is created. This field is optional and is not case-sensitive.

   **Note:** Exclusive access to a project is necessary to modify the values in the following three steps for an existing requirement type. These options can be modified at any time.

10. In the **Requirement Tag Prefix** text box, type or edit a tag prefix. Examples of tag prefixes are SR, PR and TST.
11. In the **Requirement Color** list, click the down arrow and select a color. The color is assigned to a requirement of this type when it is displayed in a document. The default color is blue.

12. In the **Requirement Style** list, click the down arrow and select a style. The style is assigned to a requirement of this type when it is displayed in a document. The default style for this text box is **Double Underline**. You can also select **Normal** (no styling) or **Small Capitals**.

13. Click **OK**. In the **Project** dialog box, **Requirement Types** tab, RequisitePro displays the new or edited requirement type with its tag prefix and logical name. For example, *TEST: Test Plan*.

14. Click **OK** to close the **Project** dialog box.

### Removing Requirement Types

You can remove a requirement type if there are no requirements of this type in the project and if document types do not reference it as a default. You must have the project opened in exclusive mode to remove requirement types.

1. On the Tool Palette, click the **Project** menu and choose **Properties**. The **Project** dialog box appears.
2. Click the **Requirement Types** tab.
3. Select the requirement type you want to remove.
4. Click **Remove**.
5. Click **OK**.

### Working with Requirement Attributes

Use the **Attributes** tab in the **Project** dialog box to add an attribute. You can also use this tab to modify an existing attribute.

The following table shows suggested attributes that can be helpful for defining your requirements in RequisitePro. These attributes are suggestions, not rules. You can use these suggested attributes, which are provided with RequisitePro, or you can define and use any attributes that are appropriate for your project and business.
Working with Requirement Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Use to identify requirements by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Importance to the project. Helps team members prioritize their efforts and use their time more effectively.</td>
</tr>
<tr>
<td>Status</td>
<td>Progress.</td>
</tr>
<tr>
<td></td>
<td>- If a requirement’s status is Proposed, the requirement is currently being discussed by the project team.</td>
</tr>
<tr>
<td></td>
<td>- If a requirement’s status is Approved, the requirement has been discussed and agreed upon.</td>
</tr>
<tr>
<td></td>
<td>- If a requirement’s status is Incorporated, the requirement has been added to the appropriate specification.</td>
</tr>
<tr>
<td>Authors</td>
<td>Individual or team that created or changed the requirement’s text or attributes.</td>
</tr>
<tr>
<td>Responsible Party</td>
<td>Individual or team responsible for ensuring the requirement is satisfied.</td>
</tr>
<tr>
<td>Rationale</td>
<td>Text of or reference to an explanation. For example, the reference might be to a page and line number of a product requirement specification, or to a minute marker on a video tape of an important customer interview.</td>
</tr>
<tr>
<td>Cost</td>
<td>Cost to implement the requirement. The attribute value for this attribute can be logical (high, medium, low) or numerical.</td>
</tr>
</tbody>
</table>

Note: The list of requirement attributes above provides examples. Other common attributes include Difficulty, Stability, Risk, Security, Safety, Release Implemented and Functional Area.

In addition to the attributes mentioned above, RequisitePro maintains system attributes for all requirement, including date, version and relationship to other requirements.

You can create and control attributes according to your needs. Regardless of the attributes you use, RequisitePro offers the flexibility to easily customize your project documents and databases to define, articulate and manage the processes and culture of your organization.

You cannot remove requirement attributes if requirements of the requirement type already exist, or if the requirement type is the default of a document type.
Creating and Modifying Requirement Attributes

Use the Attributes tab in the Project dialog box to describe the characteristics or properties of a requirement type.

1. On the Tool Palette, click the Project menu and choose Properties. The Project dialog box appears.
2. Click the Attributes tab. The attributes for the selected type are displayed in the same sort order as in the Requirements dialog box.

3. To reorder attributes, select the attribute in the Labels list and then click the Move Up or Move Down button.

4. For list-type attributes, to designate a value as the default value, select the attribute in the Label box. In the Values per Attribute box, select the value and click Default.

5. To add an attribute, click Add. The Add Attribute dialog box appears.
6. In the Type list, select a type. The following data types are supported:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Allows</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>List (Single Value)</td>
<td>A set of values from which a single value can be selected. Each List value can be up to 20 characters in length.</td>
<td>High, Medium or Low</td>
</tr>
<tr>
<td>List (Multiple Value)</td>
<td>A set of values from which more than one value can be selected. Each List value can be up to 20 characters in length.</td>
<td>Sue, Bob, John</td>
</tr>
</tbody>
</table>
Working with Requirement Attributes

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Allows</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>A text string of up to 255 characters.</td>
<td>John Smith</td>
</tr>
<tr>
<td>Integer</td>
<td>Whole numbers in the field.</td>
<td>5 or 1500</td>
</tr>
<tr>
<td>Real</td>
<td>Real numbers in the field.</td>
<td>1.345 or 6.7</td>
</tr>
<tr>
<td>Date</td>
<td>A date in the format defined by the user’s Windows setting.</td>
<td>mm/dd/yy</td>
</tr>
<tr>
<td>Time</td>
<td>A time in the format defined by a user’s Windows setting.</td>
<td>10:00 AM</td>
</tr>
</tbody>
</table>

The dialog box changes, depending on the type you select. If you select **List (Single Value)** or **List (Multiple Value)**, the dialog box contains a **List Values** text box. If you select one of the other types, the dialog box contains a **Default Value** text box.

7. In the **Label** text box, type a name.
8. If the data type is a list-type, in the **List Values** text box, type the values.
9. If the data type is an entry-type, enter a default value (optional). If a new requirement is created and a value is not specified for the attribute, RequisitePro uses the default value.
10. To ensure traceability relationships are marked as **Suspect** when attributes are changed, mark the **Change Affects Suspect** check box. When this check box is selected, RequisitePro monitors all requirements (based on this requirement type) and ensures that the status of all relationships labeled **Traced to** and **Traced from** for this requirement is changed to **Traced-Suspect** if the attribute value is changed.
Project Information

11. Click OK. The new or edited attribute appears in the Attributes tab of the Project dialog box.
12. Click OK to close the Project dialog box.

Working with Requirement Attribute Values

You can add and edit the values assigned to a particular list-type attribute. Or, you can remove an attribute value.

Modifying Attribute Values

1. On the Tool Palette, click the Project menu and choose Properties. The Project dialog box appears.
2. Click the Attributes tab.
3. In the Requirement Type list, select the requirement type.
4. In the Labels for Attributes list, select a single or multiple-value list-type attribute.
5. In the Values per Attribute list, select the value that you want to edit.
6. Click Edit. The Attribute Value dialog box appears.

![Attribute Value dialog box]

7. In the Value text box, modify the value.
8. To use the value as the default value, mark the Use as default check box.
9. Click OK. The changes to the attribute values appear in the Attributes tab of the Project dialog box.
10. Click OK to close the Project dialog box.
Removing Attribute Values

To remove attribute values, you must have the project opened exclusively.

1. On the Tool Palette, click the **Project** menu and choose **Properties**. The **Project** dialog box appears.
2. Click the **Attributes** tab.
3. In the **Requirement Type** list, select the requirement type.
4. In the **Labels for Attributes** list, select the list-type attribute.
5. In the **Values per Attribute** list, select the value that you want to remove.
6. Click **Remove**.
   
   If the value is not assigned to any requirements in the project, the value is removed.
   
   If the value is assigned to any requirements in the project, the **Remove Value** dialog box appears:
   
   ![Remove Value dialog box]

   - In the list, select a value to use as a replacement for the removed value.
   - Click **OK**. The value is removed from the **Values per Attribute** list.
7. Click **OK** to close the **Project** dialog box.
Setting Up and Modifying Cross-Project Traceability

Cross-project traceability enables direct traceability relationships between requirements in different RequisitePro projects. This RequisitePro feature eliminates duplication by allowing reuse of requirements among various teams working on related projects. Often a set of requirements is common to multiple projects. These requirements can be created in their own RequisitePro projects and traced to system-specific requirements located in their respective RequisitePro projects.

Projects must be created prior to setting up cross-project traceability. You can configure projects to automatically connect to external projects when a project with externally traced requirements is opened. You can also connect external projects manually.

After you connect an external project, all externally traced requirement types are available for traceability relationships. External requirement types are displayed in the RequisitePro dialog boxes used to create traceability relationships. External requirements are identified with a project prefix set in the General tab of the Project dialog box for the external project.

Marking Requirement Types for Cross-Project Traceability

To allow cross-project traceability for requirements in a project, you must do the following:

- Assign a project prefix.
- Manually mark requirement types in the project as externally available. Only requirements of these types will be available for cross-project traceability.

1. On the Tool Palette, click the Project menu and choose Properties. The Project dialog box appears.
2. If it is not already displayed, click the General tab.
3. If the project does not have a prefix, enter a prefix for the project, up to 8 characters. The prefix must be uppercase.
4. Click the Requirement Types tab.
5. In the Requirement Type list box, select the requirement type to mark for external traceability.
6. Click Edit.
Setting Up and Modifying Cross-Project Traceability

The **Requirement Type** dialog box appears.

7. Mark the **Allow External Traceability** check box.
8. Click **OK**.

   RequisitePro marks the requirement type for cross-project traceability.
9. Repeat steps 5 through 8 for any other requirement types.
10. Click **OK** to close the **Project** dialog box.
Project Information

Connecting Projects

Once the requirement types in the external projects have been marked for external traceability, connect the external projects to the currently open project.

To view external projects, click the Project menu and choose External Projects. The External Projects dialog box appears.

It displays the following:

- **Prefix** - an identifier for the project. It displays for any external requirements in the opened project. The prefix displays before the requirement tag, and is separated from the tag by a period. For example, if a requirement has the tag PR234 and the project has the prefix GLOBAL, then the external requirement has the displays GLOBAL.PR234. The prefix is set in the General tab of the Project dialog box.
- **Name** - the name of the external project.
- **Status** - indicates whether the project is currently connected or disconnected.
- **Location** - indicates the location of the project.
Setting Up and Modifying Cross-Project Traceability

To add a project as an external project:
1. In the External Projects dialog box, click Add. The Add external project dialog box appears.
2. Locate the project and click Open.
3. To automatically open the external project when the current project is opened, click the Connect to the external projects at project open check box.

Note: In this case, when you open the project, one of several conditions apply:
   • If neither project is secured, you are not required to log on to the project.
   • If the project is secured and your user name and password are different than those used to log on to the secured project, the Project Logon dialog box appears. Log on to the project as you normally would. (If your user name and password are the same in both projects, you will not be required to log in multiple times.)
   • If the project is not secured and the external project is secured, the Project Logon dialog box appears. Log on to the project as you normally would.
4. To connect other external projects, repeat the above steps.
5. To remove a project from the External Projects dialog box, select the project and click the Remove button.

Note: If you remove a project with requirements that participate in external traceability, RequisitePro warns you about deleting the references.
   If the external project is not accessible, RequisitePro warns you the current project will be updated and the external project will contain invalid references until it is opened and synchronized.
   If an external project is moved, an error message appears, indicating that the project cannot be found.
6. Select the project from the External Project References list, and click Browse to relocate the project. Locate the project and click Open.

Note: The Browse button is only active when a project has been moved or cannot be located.
Disconnecting Projects

You can disconnect external projects when they are not needed or are unavailable. For example, you may want to disconnect projects when you are working in a distributed mode and the database is unavailable.

If you are not currently working on traceability relationships, disconnecting will increase system performance. A project must be disconnected before you can relocate it.

1. On the Tool Palette, click the Project menu and choose External Projects. The External Projects dialog box appears.
2. Select the project and click Disconnect. This temporarily disconnects the project.
3. To reconnect the project, select the project and click Connect (the Disconnect button automatically changes to a Connect button when you select a disconnected project, and the Connect button automatically changes to a Disconnect button when you select a connected project).

Results of Disconnecting an External Project

When you disconnect an external project:

• Requirements display in the traceability matrix and attribute matrix with a label marking them as disconnected external requirements.
• You cannot create traceability relationships with requirements in the disconnected project.
• You cannot change traceability relationships with requirements in the disconnected project.
• If you delete a requirement or its traceability state changes to Suspect, external requirements relationships are updated with the new state.
• Any changes to requirements in the external project are updated in the disconnected project when the project is opened. You can see these changes, but you cannot update them.
Relocating an External Project

To relocate an external project, you must first disconnect it.

1. On the Tool Palette, click the **Project** menu and choose **External Projects**. The **External Projects** dialog box appears.
2. Select the project, and then click **Disconnect**.
3. In File Manager or Windows Explorer, move the project’s .rqs file to the new location.
4. In the **External Projects** dialog box, in the **External Project References** listing, select the project.
5. Click **Browse**.
6. Click **Open**.
Project Information
Chapter 16

Integration with MS Project

Using RequisitePro and Microsoft Project

The MS Project Integration Wizard manages traceability from requirements in RequisitePro projects to tasks in Microsoft Project schedules. You can use the wizard to:

• Create tasks from requirements and establish traceability relationships from those requirements to the tasks.
• Add or remove traceability from requirements to existing tasks.

After you have established traceability you can:

• Refresh MSPT requirement information within RequisitePro that links to the traced tasks in Microsoft Project.
• Review suspect traceability relationships between requirements and tasks in a RequisitePro Traceability Tree or Traceability Matrix.
• Analyze the impact on the requirements, the tasks, the project, and the schedule as changes occur.

Requirements

Software Requirements

Microsoft Project 95 (version 4.1) or 98 must be installed on your system in order to use the MS Project Integration Wizard. If not, the Start Microsoft Project and Integration Wizard options are disabled on your RequisitePro Tools menu.
Setting the Correct Version of MS Project

If you have both MS Project 98 and MS Project 95 installed on your computer, use the Options command on the Tool Palette Tools menu to specify the version you want to use with RequisitePro.

Security Requirements

In order to initially integrate a RequisitePro project with Microsoft Project using the wizard, you must have RequisitePro administrator permissions.

In order to use the MS Project Integration Wizard in subsequent sessions:

- You must have create/delete permissions for the MSPT requirement type.
- You must have attribute update permissions for all attributes associated with the MSPT requirement type.

MSPT Requirement Types

Requirements and tasks are linked using a special requirement type, the MSPT requirement type. This requirement type is a place holder in a RequisitePro project that represents a task in a schedule. The MSPT requirement type is linked to a task in a schedule. It contains, as requirement attributes, the Microsoft Project file name and a unique ID of the task it represents.

The MSPT requirement type also includes default attributes that are based on task fields in Microsoft Project. These default attributes are Cost, Duration, Finish, Milestone, Priority, Resource Names, and Start.

You can also map Microsoft Project fields to RequisitePro attributes for the MSPT requirement type in the .rqs file of your RequisitePro project. For more information about the MSPT requirement type, see Working with the MSPT Requirement Type on page 16-14.

Starting the Wizard and Adding the MSPT Requirement Type

You can start the MS Project Integration Wizard from within RequisitePro or run it as an independent application. These instructions explain how to start the wizard from within RequisitePro.

Note: Make sure that you have closed any open dialog boxes in Microsoft Project before you use the MS Project Integration Wizard.
To start the MS Project Integration Wizard:

1. On the Tool Palette, click **Tools**. Point to **Microsoft Project** and click **Integration Wizard**. The introduction screen appears.

2. Click **Next**. The **Select Project Files** screen appears.

3. Select a RequisitePro project from list. The list displays all projects in your project catalog.

4. Do one of the following:
   - Enter the name and path of an existing Microsoft Project schedule.
   - Click **Browse** to locate, select, and open an existing schedule in Microsoft Project.
   - Click **New** to create a new schedule. The **Project Info** dialog box appears. When you are finished creating the new schedule, click **OK** in the **Project Info** dialog box. A dialog box appears, prompting you to save the new project. After saving the schedule, the wizard minimizes Microsoft Project, returns to this screen, and adds the new schedule name to the Microsoft Project Schedule text box.

5. Click **Next**. If the project you selected has security enabled, the **Logon** dialog box appears. Log on as you would to a secured RequisitePro project. The wizard checks the project and searches for the MSPT requirement type. If the wizard does not find the MSPT requirement type, the wizard adds it and displays the **MSPT Info** screen. Click **Next**.
Integration with MS Project

The wizard opens the project and schedule and displays the Select an Action screen.

Creating Tasks from Requirements

These instructions assume the wizard is started and the Select An Action screen is displayed. Use this feature to select requirements in RequisitePro in order to create new tasks in Microsoft Project that are linked to the RequisitePro requirements.

Note: The first time the “Select An Action” screen appears after you select a new schedule, only the first option is available. After tasks have been created, the other options become available.
1. Select the option “Select requirements to create tasks, or add and remove traceability to existing tasks.”
2. Click Next. The wizard displays the “Select a Requirement Type” screen.
3. In the Requirement Type list, select a requirement type.
4. Click one of the following:
   • All requirements of selected type.
   • Requirements of this attribute value.
     - In the Attribute list, select the attribute.
     - In the Value box, select a value and an operator.
   • To search for requirements containing specific phrases (for example, the word “shall”), enter the string in the Requirement Text Search box.
     You can use partial strings, but wildcard searches are not supported.
Integration with MS Project

5. Click **Next**. The screen displays the Task Traceability Tree for the requirements that you filtered in the previous screen.

6. Select one or more requirements and select **Create Tasks**.

7. Click **Next**. At the next screen, click **Finish**.

   Note: Each time you make a change to a schedule, a dialog box appears, prompting you to save with or without a baseline. We recommend saving with a baseline for each change. See the Microsoft Project documentation for more information about baselines.

8. Click **Exit** to close the wizard, or click **Another Action** to return to the “Select an Action” screen where you can create more tasks, add or remove traceability, and refresh requirement information from Microsoft Project.

**Adding or Removing Traceability**

These instructions assume the wizard is started and the **Select An Action** screen is displayed and that you have created tasks in Microsoft Project that are linked to requirements in RequisitePro.

You have two options for modifying traceability in the MS Project Integration Wizard. You can:

- select a RequisitePro requirement and link it to a Microsoft Project task, or
- select a Microsoft Project task and link it to a RequisitePro requirement.

Both option are covered in the two procedures below.
Selecting Requirements to Modify Traceability

At the Select An Action screen:

1. Select the option “Select requirements to create tasks, or add and remove traceability to existing tasks.”
2. Click Next. The wizard displays the “Select a Requirement Type” screen.

3. In the Requirement Type list, select a requirement type.
4. Click one of the following:
   - All requirements of selected type.
   - Requirements of this attribute value.
     - In the Attribute list, select the attribute.
     - In the Value box, select a value and an operator.
   - To search for requirements containing specific phrases (for example, the word “shall”), enter the string in the Requirement Text Search box.
     You can use partial strings, but wildcard searches are not supported.
Integration with MS Project

5. Click **Next**. The screen displays the Task Traceability Tree for the requirements that you filtered in the previous screen.

To remove traceability between the selected task and requirement:

1. Select one or more tasks and then click **Remove traceability**, and click **Finish**. The traceability between the selected tasks and requirement is removed. Note that the tasks remain in the Microsoft Project schedule.

2. Click **Exit** to close the wizard, or click **Another Action** to return to the “Select an Action” screen where you can create more tasks, add or remove traceability, and refresh requirement information from Microsoft Project.

To add traceability between the selected requirements and a task:

1. Select a requirement and click **Add Traceability**. Traceability is created for one requirement at a time.

2. Click **Next** to advance to the next screen and select a task.
3. Do one of the following:
   • If you are satisfied with the current task selection, click **Finish**.
   • To change the selection, click **MS Project** to display the schedule and select one or more tasks. Return to the Integration Wizard and click **Refresh Task List** to refresh the task display. Then click **Finish**.
Integration with MS Project

Selecting Tasks to Modify Traceability

At the Select An Action screen:

1. Select the option “Select tasks to add or remove traceability” and click Next. The Select Tasks screen appears.

2. Do one of the following:
   - If you are satisfied with the current task selection, click Next.
   - To modify the selection, click MS Project to display the schedule and select one or more tasks. Return to the Integration Wizard and click the Refresh Task List to refresh the task display. Then click Next.

This screen displays the Task Traceability Tree for the tasks you selected in the previous screen and the requirements from which the tasks are traced.
3. Do one of the following:

- To display the task in the Microsoft Project schedule, select a task and click **Go to Task**. In the schedule, you can view the task or make modifications. When you are finished, return to the Integration Wizard.

- Select a requirement and the **Remove traceability** option. Then click **Finish**. The traceability between the selected task and requirement is removed.

- Select a task and the **Add Traceability** option. Then click **Next**. The Select a Requirement Type screen appears. Continue to the step 4.
Integration with MS Project

4. In the **Requirement Type** list, select a requirement type.

5. Click one of the following:
   - **All requirements of selected type.**
   - **Requirements of this attribute value.**
     - In the **Attribute** list, select the attribute.
     - In the **Value** box, select a value and an operator.
   - To search for requirements containing specific phrases (for example, the word “shall”), enter the string in the **Requirement Text Search** box.
     You can use partial strings, but wildcard searches are not supported.

6. To go to the next screen of the wizard, click **Next**. The screen displays the requirements that you filtered in the previous screen.

7. Select a requirement. To display the requirements without tasks, select the **Show only requirements with no tasks** check box.

8. Click **Finish**.
Refreshing MSPT Requirement Information from Tasks

These instructions assume the Select An Action screen in the MS Project Integration Wizard is displayed and that you have created tasks in Microsoft Project that are linked to MSPT requirements which represent the tasks in RequisitePro. Traceability should be established between your product requirements and the MSPT requirements.

When the values in the Microsoft Project task fields are changed, you need to use the refresh feature in the MS Project Integration Wizard to update the corresponding attribute values in the MSPT requirements. The resulting changes to the MSPT attribute values cause the traceability relationships between your product requirements and the MSPT requirements to be marked as suspect. This suspect condition alerts you of changes in the Microsoft Project schedule.

You can then view the suspect relationships in a Traceability Matrix that includes your product requirements and the MSPT requirements; or you can review the changes to the MSPT attribute values using an Attribute Matrix of the MSPT requirement type.

To refresh the MSPT requirements from the Microsoft Project tasks:

1. At the Select an Action screen, select the option “Refresh MSPT information from MS Project tasks” and click Next.
   - The Update screen displays the list of changes to occur when RequisitePro is updated with a Microsoft Project tasks.
2. To proceed with the integration, click Finish.
Working with the MSPT Requirement Type

Viewing the MSPT Requirement Type

You can view the MSPT requirement type in a view in RequisitePro.

1. In the Views Workplace, click the File menu and select New View, or click the New View icon.

2. Select one of the following views:
   - Select an **Attribute Matrix** and the MSPT requirement type to review the changes to the MSPT attribute values.
   - Select a **Traceability Matrix**. Select the requirement types for your product requirements (in the row requirements) and the MSPT requirements (in the column requirements). The traceability is displayed between the requirement types.
   - Select a **Traceability Tree**. Select the product requirement type and expand the display to view the traceability relationships to the MSPT requirements.

3. Click OK.

Mapping Fields to Attributes for the MSPT Requirement Type

Unlike other requirement types, you cannot add a new attribute to the MSPT requirement type using the Attributes tab on the Project dialog box. You can, however, create attributes for the MSPT requirement type in the .rqs file for the RequisitePro project in which you are working. For example, if the name of the project you are working on is “blueproject,” then you use the blueproject.rqs file to create new attributes for the MSPT requirement type.

If security is enabled, you must have project structure permission to map a field to an attribute for an MSPT requirement type.

**To map fields to attributes:**

1. Refer to Microsoft Project Field IDs on page 16-15 to locate the task field which you want to map to an attribute for the MSPT requirement type.

2. In a text editor, open the .rqs file for the project with which you are working.

3. In the [MSProjectMappings] section of the .rqs file, enter the following: field ID=attribute name
where field ID is the field ID listed in *Microsoft Project Field IDs* on page 16-15 and attribute name is the label you want to give the attribute in RequisitePro.

4. Save the *.rqs* file.

The MS Project Integration Wizard will create an attribute for the MSPT requirement type based on the information entered.

**Microsoft Project Field IDs**

Use the following Microsoft Project field IDs to map attributes for the MSPT requirement type in RequisitePro to corresponding constants in Microsoft Project. Add your entries to the [MSProjectMappings] section in `<project name>.rqs` file using a text editor.

Use the following format:

```
field ID=attribute name
```

where field ID is the numeric constant listed below and the attribute name is the label you want to give the attribute in RequisitePro. Field IDs shown in bold are already provided as default attributes for the MSPT requirement type.

- Actual Cost = 7
- Actual Start = 41
- Baseline Duration = 27
- Baseline Work = 1
- Confirmed = 110
- Contact = 112
- Cost2 = 107
- Created = 93
- Delay = 20
- Duration2 = 104
- Early Finish = 38
- Finish1 = 53
- Finish4 = 62
- Fixed Cost = 8
- Flag10 = 81
- Flag4 = 75
- Flag7 = 78

- Actual Duration = 28
- Actual Work = 2
- Baseline Finish = 44
- Baseline Start = 43
- Baseline Work = 11
- BCWP = 11
- Baseline Cost = 6
- Baseline Start = 43
- Baseline Finish = 44
- Baseline Work = 1
- BCWS = 12
- BCWP = 11
- Baseline Cost = 6
- Baseline Start = 43
- Baseline Finish = 44
- Baseline Work = 1
- BCWS = 12
- Constraint Date = 18
- Constraint Type = 17
- Created = 93
- Critical = 19
- Duration = 29
- Duration1 = 103
- Duration2 = 104
- Duration3 = 105
- Duration Variance = 30
- Early Finish = 38
- Early Start = 37
- Finish = 56
- Finish2 = 56
- Finish3 = 59
- Finish4 = 62
- Finish5 = 65
- Finish Variance = 46
- Fixed Cost = 8
- Fixed (Duration) = 34
- Fixed Cost = 8
- Fixed (Duration) = 34
- Flag1 = 72
- Flag2 = 73
- Flag3 = 74
- Flag4 = 75
- Flag5 = 76
- Flag6 = 77
- Flag7 = 78
- Flag8 = 79
- Flag9 = 80
Integration with MS Project

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Slack</td>
<td>21</td>
</tr>
<tr>
<td>Late Finish</td>
<td>40</td>
</tr>
<tr>
<td>Marked</td>
<td>71</td>
</tr>
<tr>
<td>Notes</td>
<td>15</td>
</tr>
<tr>
<td>Number3</td>
<td>89</td>
</tr>
<tr>
<td>Objects</td>
<td>97</td>
</tr>
<tr>
<td>% Complete</td>
<td>32</td>
</tr>
<tr>
<td>Priority</td>
<td>25</td>
</tr>
<tr>
<td>Remaining Duration</td>
<td>31</td>
</tr>
<tr>
<td>Resource Initials</td>
<td>50</td>
</tr>
<tr>
<td>Resume No Earlier Than</td>
<td>101</td>
</tr>
<tr>
<td>Start</td>
<td>35</td>
</tr>
<tr>
<td>Start3</td>
<td>58</td>
</tr>
<tr>
<td>Start Variance</td>
<td>45</td>
</tr>
<tr>
<td>Successors</td>
<td>48</td>
</tr>
<tr>
<td>Text1</td>
<td>51</td>
</tr>
<tr>
<td>Text9</td>
<td>69</td>
</tr>
<tr>
<td>Unique ID Predecessors</td>
<td>95</td>
</tr>
<tr>
<td>Unique ID Successors</td>
<td>96</td>
</tr>
<tr>
<td>WBS</td>
<td>16</td>
</tr>
<tr>
<td>Hide Bar</td>
<td>109</td>
</tr>
<tr>
<td>Late Start</td>
<td>39</td>
</tr>
<tr>
<td>Milestone</td>
<td>24</td>
</tr>
<tr>
<td>Number1</td>
<td>87</td>
</tr>
<tr>
<td>Number4</td>
<td>90</td>
</tr>
<tr>
<td>Outline Level</td>
<td>85</td>
</tr>
<tr>
<td>Outline Number</td>
<td>102</td>
</tr>
<tr>
<td>% Complete Predecessors</td>
<td>47</td>
</tr>
<tr>
<td>Remaining Cost</td>
<td>10</td>
</tr>
<tr>
<td>Resource Group</td>
<td>113</td>
</tr>
<tr>
<td>Resume</td>
<td>99</td>
</tr>
<tr>
<td>Sheet Notes</td>
<td>94</td>
</tr>
<tr>
<td>Start1</td>
<td>52</td>
</tr>
<tr>
<td>Start4</td>
<td>61</td>
</tr>
<tr>
<td>Stop</td>
<td>100</td>
</tr>
<tr>
<td>Summary</td>
<td>92</td>
</tr>
<tr>
<td>SV</td>
<td>13</td>
</tr>
<tr>
<td>Text10</td>
<td>70</td>
</tr>
<tr>
<td>Text4</td>
<td>60</td>
</tr>
<tr>
<td>Text7</td>
<td>67</td>
</tr>
<tr>
<td>Total Slack</td>
<td>22</td>
</tr>
<tr>
<td>Unique ID</td>
<td>86</td>
</tr>
<tr>
<td>Update Needed</td>
<td>111</td>
</tr>
<tr>
<td>Work</td>
<td>0</td>
</tr>
<tr>
<td>Work Variance</td>
<td>3</td>
</tr>
</tbody>
</table>
Deleting Attributes for MSPT Requirement Types

Before deleting an attribute for an MSPT requirement type, make sure that the attribute is not being used by others. If security is enabled, you must have project structure permission to remove a requirement type.

To delete attributes:

1. Open a RequisitePro project exclusively.
2. On the Tool Palette, click the Project menu and select Properties.
3. Click the Attributes tab.
4. In the Requirement Type list, select MSPT: Microsoft Project Task Requirement Type. The attributes for this requirement type appear in the Label list.
5. Select the attribute to delete and click Remove.
6. Click OK.
Integration with MS Project
Appendix A

Keyboard Shortcuts and Mouse Actions

Dialog Box Shortcuts

You can use keyboard combinations to move to tabs, fields, and buttons in a RequisitePro dialog box. To use a dialog box shortcut, press the Alt key while simultaneously pressing the underlined letter in a dialog tab, field, or button. For example, in the Project, Document, or Requirement dialog box, press Alt-G to open the General tab.

Menu Shortcuts

You can use combinations of keyboard shortcuts to open a menu in the Tool Palette or Views Workplace. To use a menu shortcut, press the Alt key while simultaneously pressing the underlined letter in the menu. For example, to open the Requirement menu, press Alt-R. Once a menu is displayed, you can select a command by pressing the underlined letter in the command.

Selecting Multiple Items in RequisitePro

You can use mouse actions and combinations of keyboard and mouse actions to select more than one item in various RequisitePro lists.

The following are referred to as multiple select actions in RequisitePro documentation:

- **Shift-click**: To click the mouse button while holding down the Shift key.
- **Ctrl-click**: To click the mouse button while holding down the Control key.
- **Drag**: To hold down the right mouse button while moving the mouse and then releasing the button.
Keyboard Shortcuts and Mouse Actions

You can use the actions in the following ways:

- To select adjacent items, use **Shift-click** or **drag**.
- To select nonadjacent items, use **Ctrl-click**.

The anchor is the first item you click when using multiple select actions to select a range of items. In RequisitePro, the term “anchor” is generally used to mean the first cell you click in a view in the Views Workplace. You use the anchor to select a range of cells. For example, if you click the cell in row 1, column 1 of a traceability matrix, that cell becomes the anchor. If you then Shift-click the cell in row 10, column 3 of the matrix, all of the cells in rows 1 through 10, columns 1 through 3, are selected. To reset the anchor, click anywhere outside the range. The cell you click is the new anchor. You can also use an anchor to select a range of items in documents and in certain dialog boxes that support multiple select actions.
Mouse Actions and Shortcuts in the Views Workplace

You can use keyboard shortcuts and mouse actions to quickly move around and select information in the Views Workplace. The keyboard shortcuts and mouse actions differ in each matrix.

The following tables provide specific shortcuts for selecting items in an attribute matrix, a traceability matrix, or a traceability tree.

**Attribute Matrix Mouse Actions and Keyboard Shortcuts**

**Mouse Actions**

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Select the requirement in the row in which you click. (This action clears all selected items and sets the selected row as the anchor. Clicking in cell also changes the selected column to the column in which you clicked.) | Click row label  
OR  
Click cell |
| Select the requirements between the anchor row and the row in which you Shift-click. (This action clears any rows that are not in the range.) | Shift-click row label  
OR  
Shift-click cell in selected column |
| Set the selected row as the anchor, while keeping previously selected items selected. OR Clear a previously selected row while keeping others selected. | Ctrl-click row label |
| Switch the column selection to the column in which you click. (Clicking in cell also selects the row in which you clicked.) | Click column label  
OR  
Ctrl-click column label  
OR  
Ctrl-click in cell |
| Select a range of requirements (This action clears any rows that are not in the range.) | drag |
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the right one column.</td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Right arrow</td>
</tr>
<tr>
<td>Move to the left one column.</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Left arrow</td>
</tr>
<tr>
<td>Move down one row. (This action clears all selected</td>
<td>Enter</td>
</tr>
<tr>
<td>items and sets the selected row as the anchor.)</td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move up one row. (This action clears all selected</td>
<td>Shift-Enter</td>
</tr>
<tr>
<td>items and sets the selected row as the anchor.)</td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Up arrow</td>
</tr>
<tr>
<td>Activate the field for data entry, in the currently</td>
<td>Space bar</td>
</tr>
<tr>
<td>selected cell.</td>
<td></td>
</tr>
<tr>
<td>Deactivate the field for data entry, in the currently</td>
<td>Esc</td>
</tr>
<tr>
<td>selected cell.</td>
<td></td>
</tr>
<tr>
<td>Move to the top of the view and select the first</td>
<td>Home</td>
</tr>
<tr>
<td>row. (This action sets the first row as the anchor</td>
<td></td>
</tr>
<tr>
<td>and clears all other selected items.)</td>
<td></td>
</tr>
<tr>
<td>Move to the top of the view and select all items</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>between the anchor row and the first row of the view.</td>
<td></td>
</tr>
<tr>
<td>(This action clears all other selected items.)</td>
<td></td>
</tr>
<tr>
<td>Move to the top of the view, without clearing</td>
<td>Ctrl-Home</td>
</tr>
<tr>
<td>selected items.</td>
<td></td>
</tr>
<tr>
<td>Move to the bottom of the view and select the last</td>
<td>End</td>
</tr>
<tr>
<td>row. (This action sets the last row as the anchor</td>
<td></td>
</tr>
<tr>
<td>and clears all other selected items.)</td>
<td></td>
</tr>
<tr>
<td>If you want to</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Move to the bottom of the view and select all items between the anchor row and the last row of the view. (This action clears all other selected items.)</td>
<td>Shift-End</td>
</tr>
<tr>
<td>Move to the bottom of the view, without clearing selected actions.</td>
<td>Ctrl-End</td>
</tr>
<tr>
<td>Move up one page in the view, while changing the anchor. (This action selects the row that is in the same vertical position as the previously-selected row was when its page was displayed, or selects the first row if the view is positioned on the top page. The newly-selected row is the new anchor.)</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move up one page in the view, without changing the anchor. (This action selects all rows between the anchor and the row that is in the same vertical position as the anchor was when its page was displayed, or selects all rows from top to anchor if the view is positioned at the top of the page.)</td>
<td>Shift-Page Up</td>
</tr>
<tr>
<td>Move up one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Up</td>
</tr>
<tr>
<td>Move the view one page left. (This action selects the column that is in the same horizontal position as the previously-selected column was when its page was displayed, or selects the first column if the view is positioned on the far left page.)</td>
<td>Alt-Page Up</td>
</tr>
<tr>
<td>Move down one page in the view, while changing the anchor. (This action selects the row that is in the same vertical position as the previously-selected row was when its page was displayed, or selects the last row if the view is positioned on the bottom page. The newly-selected row is the new anchor.)</td>
<td>Page Down</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts and Mouse Actions

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move down one page in the view, without changing the anchor.</td>
<td>Shift-Page Down</td>
</tr>
<tr>
<td>(This action selects all rows between the anchor and the row that is in the same vertical position as the anchor was when its page was displayed, or selects all rows from the bottom to the anchor if the view is positioned at the bottom of the page.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Down</td>
</tr>
<tr>
<td>Move the view one page right.</td>
<td>Alt-Page Down</td>
</tr>
<tr>
<td>(This action selects the column that is in the same horizontal position as the previously-selected column was when its page was displayed, or selects the last column if the view is positioned on the far right page.)</td>
<td></td>
</tr>
<tr>
<td>Expand the selected row requirement to show its children in the view.</td>
<td>+</td>
</tr>
<tr>
<td>Collapse the selected row requirement to hide its children in the view.</td>
<td>-</td>
</tr>
<tr>
<td>Select every row in the view.</td>
<td>Ctrl-A</td>
</tr>
</tbody>
</table>
## Traceability Matrix Mouse Actions and Keyboard Shortcuts

### Mouse Actions

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a cell.</td>
<td>Click cell</td>
</tr>
<tr>
<td>(This action clears all other selected cells.)</td>
<td></td>
</tr>
<tr>
<td>Select all cells in the rectangle formed by the anchor cell and the clicked cell.</td>
<td>Shift-click cell</td>
</tr>
<tr>
<td>Set the cell as the anchor, while keeping previously selected cells selected.</td>
<td>Ctrl-click cell</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Clear a previously selected cell while keeping others selected.</td>
<td></td>
</tr>
<tr>
<td>Select the cell in the clicked row and the anchor column.</td>
<td>Click row label</td>
</tr>
<tr>
<td>(This action clears all other selected cells and sets the selected cell as the anchor.)</td>
<td></td>
</tr>
<tr>
<td>Select the cells in all rows between the clicked row and the anchor row, in all selected columns.</td>
<td>Shift-click row label</td>
</tr>
<tr>
<td>(This action clears any rows and columns that are not in the range.)</td>
<td></td>
</tr>
<tr>
<td>Select all cells that intersect with selected columns, without clearing previously selected cells.</td>
<td>Ctrl-click row label</td>
</tr>
<tr>
<td>Select the cell in the clicked column and all selected rows.</td>
<td>Click column label</td>
</tr>
<tr>
<td>Select the cells in all columns between the clicked column and the anchor column, in all selected rows.</td>
<td>Shift-click column label</td>
</tr>
<tr>
<td>Select all cells that intersect with selected rows, without clearing previously selected cells.</td>
<td>Ctrl-click column label</td>
</tr>
</tbody>
</table>
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the right one column.</td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Right arrow</td>
</tr>
<tr>
<td>Move to the left one column.</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Left arrow</td>
</tr>
<tr>
<td>Move down one row.</td>
<td>Enter</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move up one row.</td>
<td>Shift-Enter</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>Up arrow</td>
</tr>
<tr>
<td>Display a shortcut menu for the currently selected cells.</td>
<td>Space bar</td>
</tr>
<tr>
<td>Close the shortcut menu for the currently selected cells.</td>
<td>Esc</td>
</tr>
<tr>
<td>Move to the top of the view and select all cells in the selected columns in the top row. (This action clears all other selected rows and sets the top row as the anchor.)</td>
<td>Home</td>
</tr>
<tr>
<td>Move to the top of the view, without changing the anchor. (This action selects all cells in selected columns between the top row to the anchor row.)</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>Move to the top of the view, without changing the selection or the anchor.</td>
<td>Ctrl-Home</td>
</tr>
<tr>
<td>Move to the bottom of the view and select all cells in the selected columns in the last row. (This action clears all other selected rows and sets the last row as the anchor.)</td>
<td>End</td>
</tr>
</tbody>
</table>
### Mouse Actions and Shortcuts in the Views Workplace

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the bottom of the view, without changing the anchor.</td>
<td>Shift-End</td>
</tr>
<tr>
<td>(This action selects all cells in selected columns between the bottom row to</td>
<td></td>
</tr>
<tr>
<td>the anchor row.)</td>
<td></td>
</tr>
<tr>
<td>Move to the bottom of the view, without changing the selection or the anchor.</td>
<td>Ctrl-End</td>
</tr>
<tr>
<td>Move up one page in the view, while changing the anchor.</td>
<td>Page Up</td>
</tr>
<tr>
<td>(This action selects the selected columns and the row that is in the same</td>
<td></td>
</tr>
<tr>
<td>vertical position as the previously-selected row, or selects the top row if</td>
<td></td>
</tr>
<tr>
<td>the view is already on the top page. The newly-selected row is the new</td>
<td></td>
</tr>
<tr>
<td>anchor.)</td>
<td></td>
</tr>
<tr>
<td>Move up one page in the view, without changing the anchor.</td>
<td>Shift-Page Up</td>
</tr>
<tr>
<td>(This action selects all rows between the anchor and the row that is in the</td>
<td></td>
</tr>
<tr>
<td>same vertical position as the anchor was when its page was displayed.)</td>
<td></td>
</tr>
<tr>
<td>Moves up one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Up</td>
</tr>
<tr>
<td>Move the view one page left, while changing the anchor.</td>
<td>Alt-Page Up</td>
</tr>
<tr>
<td>(This action selects the selected rows and the column that is in the same</td>
<td></td>
</tr>
<tr>
<td>horizontal position as the previously-selected column was when its page was</td>
<td></td>
</tr>
<tr>
<td>displayed, or selects the first column if the view is positioned on the far</td>
<td></td>
</tr>
<tr>
<td>left page.)</td>
<td></td>
</tr>
</tbody>
</table>
# Keyboard Shortcuts and Mouse Actions

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the view one page left, without changing the anchor.</td>
<td>Alt-Shift-Page Up</td>
</tr>
<tr>
<td>(This action selects the cells in selected rows and the columns between the anchor column and the column that is in the same horizontal position as the anchor column was when its page was displayed, or selects the first column if the view is already on the far left page.)</td>
<td></td>
</tr>
<tr>
<td>Move left one page in the view, without changing the selection or the anchor.</td>
<td>Alt-Ctrl-Page Up</td>
</tr>
<tr>
<td>Move the view down one page, while changing the anchor.</td>
<td>Page Down</td>
</tr>
<tr>
<td>(This action selects the selected columns and the row that is in the same vertical position as the previously-selected row was when its page was displayed, or selects the last row if the view is already on the bottom page. The newly-selected row is the new anchor.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page, without changing the anchor.</td>
<td>Shift-Page Down</td>
</tr>
<tr>
<td>(This action selects all rows between the anchor and the row that is in the same vertical position as the anchor was when its page was displayed.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Down</td>
</tr>
<tr>
<td>Move the view one page right, while changing the anchor.</td>
<td>Alt-Page Down</td>
</tr>
<tr>
<td>(This action selects the selected rows and the column that is in the same horizontal position as the previously-selected column was when its page was displayed, or selects the last column if the view is already on the far right page.)</td>
<td></td>
</tr>
</tbody>
</table>
Mouse Actions and Shortcuts in the Views Workplace

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the view one page right without changing the anchor.</td>
<td>Alt-Shift-Page Down</td>
</tr>
<tr>
<td>(This action selects the selected rows and the columns between the anchor</td>
<td></td>
</tr>
<tr>
<td>column and the column that is in the same horizontal position as the anchor</td>
<td></td>
</tr>
<tr>
<td>was when its page was displayed, or selects the last column if the view is</td>
<td></td>
</tr>
<tr>
<td>already on the far right page.)</td>
<td></td>
</tr>
<tr>
<td>Moves right one page in the view, without changing the selection or the</td>
<td>Alt-Ctrl-Page Down</td>
</tr>
<tr>
<td>anchor.</td>
<td></td>
</tr>
<tr>
<td>Expand the selected requirement to show its relationships. Preserve the</td>
<td>+</td>
</tr>
<tr>
<td>previous row selection.</td>
<td></td>
</tr>
<tr>
<td>Collapse the selected requirement to hide its relationships.</td>
<td>-</td>
</tr>
<tr>
<td>Select every cell in the view.</td>
<td>Ctrl-A</td>
</tr>
</tbody>
</table>
# Traceability Tree Mouse Actions and Keyboard Shortcuts

## Mouse Actions

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the clicked item.</td>
<td>Click row</td>
</tr>
<tr>
<td>(This action clears all selects items and sets the selected row as the anchor.)</td>
<td></td>
</tr>
<tr>
<td>Select the items between the anchor row and the row in which you click.</td>
<td>Shift-click row</td>
</tr>
<tr>
<td>(This action clears any rows that are not in the range.)</td>
<td></td>
</tr>
<tr>
<td>Set the selected row as the anchor, while keeping previously highlighted text selected.</td>
<td>Ctrl-click row</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Clear a previously selected row while keeping others selected.</td>
<td></td>
</tr>
<tr>
<td>Copy a selected row's requirement to a new position</td>
<td>Ctrl-click row, then drag</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Right-click, then drag, and select <strong>Copy here</strong> from context menu</td>
<td></td>
</tr>
<tr>
<td>Move a selected row's requirement</td>
<td>Alt-click row, then drag</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Right-click, then drag, and select <strong>Move here</strong> from context menu</td>
<td></td>
</tr>
</tbody>
</table>

## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move down one row</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move up one row</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Display a shortcut menu for the currently selected requirements.</td>
<td>Space bar</td>
</tr>
<tr>
<td>Close the shortcut menu for the currently selected requirements.</td>
<td>Esc</td>
</tr>
</tbody>
</table>
Mouse Actions and Shortcuts in the Views Workplace

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the top of the view and select the first row.</td>
<td>Home</td>
</tr>
<tr>
<td>(This action sets the first row as the anchor and clears all other selected items.)</td>
<td></td>
</tr>
<tr>
<td>Move to the top of the view, without changing the anchor.</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>(This action selects all items between the anchor row and the first row of the view.)</td>
<td></td>
</tr>
<tr>
<td>Move up one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Home</td>
</tr>
<tr>
<td>Move to the bottom of the view and select the last row.</td>
<td>End</td>
</tr>
<tr>
<td>(This action sets the last row as the anchor and clears all other selected items.)</td>
<td></td>
</tr>
<tr>
<td>Move to the bottom of the view, without changing the anchor.</td>
<td>Shift-End</td>
</tr>
<tr>
<td>(This action selects all items between the anchor row and the last row of the view.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-End</td>
</tr>
<tr>
<td>Move up one page in the view, while changing the anchor.</td>
<td>Page Up</td>
</tr>
<tr>
<td>(This action selects the row that is in the same vertical position as the previously-selected row was when its page was displayed, or selects the top row if the view is positioned on the top page. The newly-selected row is the new anchor.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page in the view, while changing the anchor.</td>
<td>Page Down</td>
</tr>
<tr>
<td>(This action selects the row that is in the same vertical position as the previously-selected row was when its page was displayed, or selects the last row if the view is positioned on the bottom page. The newly-selected row is the new anchor.)</td>
<td></td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts and Mouse Actions

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move up one page in the view, without changing the anchor.</td>
<td>Shift-Page Up</td>
</tr>
<tr>
<td>(This action selects all rows between the anchor and the row that is in the same vertical position as the anchor was when its page was displayed, or selects all rows from the top to the anchor if the view is positioned at the top of the page.)</td>
<td></td>
</tr>
<tr>
<td>Move down one page in the view, without changing the anchor.</td>
<td>Shift-Page Down</td>
</tr>
<tr>
<td>(This action selects all rows between the anchor and the row that is in the same vertical position as the anchor was when its page was displayed, or selects all rows from the bottom to the anchor if the view is positioned at the bottom of the page.)</td>
<td></td>
</tr>
<tr>
<td>Move up one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Up</td>
</tr>
<tr>
<td>Move down one page in the view, without changing the selection or the anchor.</td>
<td>Ctrl-Page Down</td>
</tr>
<tr>
<td>Expand the item to show its relationships.</td>
<td>+</td>
</tr>
<tr>
<td>Collapse the item to hide its relationships.</td>
<td>-</td>
</tr>
<tr>
<td>Highlight every item in the view.</td>
<td>Ctrl-A</td>
</tr>
</tbody>
</table>
You can use the Options command on the Tool Palette Tools menu to configure the appearance and behavior of RequisitePro.

1. On the Tool Palette, click the Tools menu and then click Options.
   The Options dialog box appears.

2. Type or mark the following options as needed:
   - **Username**: Type your RequisitePro user name. This is used as your default logon name for all RequisitePro projects.
   - **Show Buttons**: Mark this check box to display the Tool Palette buttons.
   - **Show Status**: Mark this check box to display the status line on the Tool Palette. This displays project and document status as you work in RequisitePro.
   - **Show Tool Tips**: Mark this check box to display a button definition when you hold the pointer over a button on a RequisitePro toolbar.
   - **Always on Top**: Mark this check box to display the Tool Palette and open dialog boxes in the foreground of your screen, regardless of how many applications you have open.
   - **Prompt for save**: Mark this check box if you want RequisitePro to prompt you to save changes to display options and view properties when you close an unsaved view. Changes to requirements and other data within the view are not affected.
   - **Double-click to go to document**: Mark this check box for the ability to double-click on a requirement in a view to access it in a requirements document. If this check box is cleared, double-clicking expands and collapses the requirement hierarchy.
Customizing RequisitePro

- **Warn on remove**: Mark this check box if you want Requisite Pro to warn you when you remove requirement traceability.

- **Changes logged in history**: Mark this check box to display changes to requirement traceability on the revision history list in the requirement properties dialog box.

- **Microsoft Word: Version**: Click the down arrow to select your preferred version of Microsoft Word when you have more than one version installed. The option “<Use Default>” uses the current version of the application, which is recorded in the Windows registry.

- **Save as RTF**: Mark this check box to save all RequisitePro documents as RTF files.

- **Microsoft Project: Version**: Click the down arrow to select your preferred version of Microsoft Project when you have more than one version installed. The option “<Use Default>” uses the current version of the application, which is recorded in the Windows registry.

- **Outline Path**: Defines a secondary location for accessing document type outlines. If RequisitePro is installed locally on your PC, the default path is ...RequisitePro\outlines. Use this option to define an alternate location for outlines, for example, a directory on the server for shared outlines.

- **PVCS Archive**: Defines the main directory for PVCS archiving in RequisitePro. A subdirectory is created within this directory for each project you archive.

- **PVCS DLL**: Defines the full path for the location of the PVCS dynamic-link library. This is helpful when PVCS is installed in a non-default location.

- **ClearCase View**: Defines the directory for ClearCase archiving in RequisitePro. This needs to be a shared view for all RequisitePro users.

- **Working Path**: Displays the working directory for RequisitePro. Write permission must be enabled for this directory in order for RequisitePro to create new projects and write temporary files.

3. Click **OK**.
Customizing Tool Palette Menus

The Add-in option on the Tool Palette Tools menu allows you to add your own customized menu items to any RequisitePro 4.0 Tool Palette menu. These menu options can be used to start external applications, such as e-mail or the Windows Notepad, directly from RequisitePro. In addition, you can configure an option to open an individual file with the application of your choice.

You can add either a project-wide menu item for use by all members of the project team or a menu item that appears only when you open RequisitePro on your PC. The Add-in option prompts you to specify an external menu file that defines your customized menu options.

To add custom menu items:

1. On the Tool Palette, click the Tools menu and select Add-ins. The Add-ins dialog box appears.
2. Click the Add button to add a customized menu option. The Add-in dialog box appears.
3. Type a name for the menu option. This name identifies the menu file on your add-ins list.
4. Click the Browse button. The Select a RequisitePro Menu File dialog box appears.
5. Select a file type to display: All Files, Menu Files, or Text Files.
6. Navigate to a menu file and click Open.
7. Leave the Active check box as marked.
8. Mark one of the following:
   • Local to apply the menu items to your Tool Palette only.
   • Project to apply the menu items to the Tool Palette of all users who access the project.
9. Click OK to close the Add-in dialog box.
10. Click OK to close the Add-ins dialog box.

The options defined in the menu file are added to the specified Tool Palette menu.
Creating A Menu File

Using any text editor, you can create a file to add menu options to any RequisitePro Tool Palette menu. The entries will appear on the RequisitePro menu in the order in which you specify them.

As you add menu entries, you will specify:

- Keywords that determine items on the menu (a submenu, a menu option, a separator)
- Menu actions that execute an application or open a specific external file, such as a readme file.

Pay close attention to the syntax rules that apply to your entries to the menu file. For example, the syntax of the menu specifications includes opening and closing braces {...}.

Note: Rational Rose users may be familiar with creating menu specification files for extending the Rose Tools menu. RequisitePro menu files use the same syntax with a subset of the Rose functions.
Menu File Template

Create your menu file in a text editor, based on the following template. Save your file with a .TXT extension or a .MNU extension to help locate the file easily in your file structure.

\[
\text{Menu} \ <\text{RequisitePro menu name}> \\
\{ \\
\text{Separator} \\
\text{Option} \ <\text{menu item}> \\
\{ \\
\text{Exec} \ <\text{command line}> \\
\text{Status} \ <\text{status text}> \\
\} \\
\text{Menu} \ <\text{submenu name}> \\
\{ \\
\text{Option} \ <\text{menu item}> \\
\{ \\
\text{Exec} \ <\text{command line}> \\
\text{Status} \ <\text{status text}> \\
\} \\
\text{Option} \ <\text{menu item}> \\
\{ \\
\text{Exec} \ <\text{command line}> \\
\text{Status} \ <\text{status text}> \\
\} \\
\} \\
\}
\]

Key Words

Use the following table to define the key words to copy into the menu file:

<table>
<thead>
<tr>
<th>Keywords and Variables</th>
<th>Definitions and Valid Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>keyword to specify the Tool Palette menu or submenu to which you want add the menu items</td>
</tr>
<tr>
<td>Separator</td>
<td>keyword to place a separator in the menu</td>
</tr>
<tr>
<td>Option</td>
<td>keyword to specify the name of the item as it will appear on the menu</td>
</tr>
<tr>
<td>Exec</td>
<td>keyword to identify the command line to be run when the menu item is chosen</td>
</tr>
</tbody>
</table>
### Customizing RequisitePro

<table>
<thead>
<tr>
<th>Status</th>
<th>keyword to identify the text for the status line of the Tool Palette</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;RequisitePro menu name&gt;</code></td>
<td>Project, Document, Requirement, Tools, Window, or Help</td>
</tr>
<tr>
<td><code>&lt;menu item&gt;</code></td>
<td>user-defined text for an item on the menu or submenu</td>
</tr>
<tr>
<td><code>&lt;submenu name&gt;</code></td>
<td>user-defined text identifying the name of the submenu</td>
</tr>
<tr>
<td><code>&lt;command line&gt;</code></td>
<td>user-defined text identifying the commands to execute when the menu item is chosen</td>
</tr>
<tr>
<td><code>&lt;status line&gt;</code></td>
<td>user-defined text identifying the text for the status line of the Tool Palette</td>
</tr>
</tbody>
</table>

### Notes

1. Menu names, submenu names, option names, and statuses need double quotes if they include more than one word.
2. Separators can be in menus or submenus.
3. Can include more than one menu item in a file.
4. Add an ampersand (&) directly before a character in the menu name to create a underlined letter signifying an access key in the menu option.
5. You can create a maximum of five levels of submenus (indented one below another).
Creating A Menu File

Sample Menu File

The following example shows a simple menu definition file. After you create a menu file, reference using the Add-ins option on the Tool Palette Tools menu. This feature allows you to add customized menu options to the RequisitePro menus.

The following menu file instructs RequisitePro to add the options “Open readme file” and “Open Windows Notepad” to the Tool Palette Window menu.

![Sample Menu File](image-url)
Customizing RequisitePro
G L O S S A R Y

RequisitePro Terms

The terms that follow are used throughout the RequisitePro User’s Guide. Most are specific to RequisitePro.

**Active document**: The current document in the Word Workplace which has processing focus. The Word Workplace is the Microsoft Word implementation within RequisitePro where you view, create, and modify requirement documents. You can have many documents open at one time; however, only one of these documents is active.

**Active view**: The current view in the Views Workplace which has processing focus. You can have many views open at one time; however, only one of these views is active. See also Views Workplace.

**Add-in command**: An option on the Tool Palette Tools menu that allows you to add your own customized menu options to any Tool Palette menu. These menu options can be used to start external applications, such as e-mail or the Windows Notepad, directly from RequisitePro. In addition, you can configure an option to open an individual file with the application of your choice.

**Administrators group**: A group of users with full permissions to work in a project. They can change a project structure, create and modify data, and set and maintain security permissions. You can add and remove users from this group, but you cannot modify Administrators group permissions and you cannot delete the group.

**Attribute**: Descriptive information that provides important details about a requirement or discussion. See also Requirement attribute.

**Attribute label**: The name of the requirement attribute, such as risk, priority or author.

**Attribute Matrix**: A spreadsheet-like table View that displays requirements in rows and the attributes that describe the requirements in columns. You can add or change values in the attribute fields. Also referred to as Requirement attribute matrix.
Attribute type: A set of descriptive and operational information associated with a requirement attribute when the attribute is created. Attribute values can be list-type or entry-type. For list-type attributes, you select a textual attribute value from a drop-down list in an attribute matrix. For entry-type attributes, you key in a value, such as a number, text string, date, or time.

Attribute value: Information assigned to the attribute. Attribute values can be text or numbers. For example, the value of priority can be Low, Medium or High.

Author: The user responsible for creating or modifying a document or requirement.

Bookmark: A marker inserted at a specific point in a document to which the user may wish to return for later reference. In Microsoft Word, a bookmark is a location or selection of text named for reference purposes. Bookmarks are implemented in RequisitePro requirements documents to designate requirement text.

Catalog: A list of project files accessible in RequisitePro. The catalog shows the logical name of projects in RequisitePro, as well as their locations and file names. You can add and remove closed projects in your catalog at any time.

Change description: Textual information that specifies the justification or reasoning behind the changes associated with a given revision of a project, document, or requirement. See also Version information.

Change-managed relationship: A connection between two requirements that implies dependency or a logical relationship. RequisitePro tracks two types of change-managed relationships: hierarchical relationships and traceability relationships. Changes to the connection can cause a “suspect” condition in the relationship. See also Suspect relationship.

Child requirement: A requirement that participates in a hierarchical relationship with a parent requirement. Parent requirements are upper level, more general requirements; child requirements are lower-level, more specific requirements. A child can have only one parent requirement. See also Hierarchy, Parent requirement.

Circular traceability relationship: A relationship between a requirement and itself, or an indirect relationship that leads back to a previously traced-from node. Traceability relationships cannot have circular references. RequisitePro checks for circular references each time you establish a traceability relationship. RequisitePro also checks for circularity when you create an external relationship.
ClearCase: See Rational ClearCase.

CMM: The Software Engineering Institute’s Capability Maturity Model, a framework for effective software process developed at Carnegie-Mellon. CMM for Software describes increasing levels of process maturity, from an ad-hoc, immature process to a mature, disciplined one.

Collapse indicator: See Expand/collapse indicator.

Concurrency: A condition in which two or more users can access the same project at the same time. See also Exclusive access.

Cross-project traceability: A RequisitePro feature that lets you establish traceability relationships between requirements that reside in different projects. See also External traceability.

CSV file: A comma-separated value text file, commonly used to exchange files between database systems that use different formats. Sometimes called comma-delimited files, CSV files can be imported into RequisitePro.

Current project: The project that is open, or active. A user can have only one RequisitePro project open at a time. Also referred to as the active project or the open project.

Database: A collection of data stored in a repository. By using specific commands, a database can be searched and sorted for the retrieval of specific information. RequisitePro stores your projects in databases. See also Project database.

Database-based requirement: A requirement that currently resides only in the database. The requirement may have been created in the database, or most recently moved to the database from a document.

.def file: A file, located in the RequisitePro outlines directory, that specifies information about a particular outline used by RequisitePro.

Deleted Users group: A security group of users who have been deleted from other groups, have no permissions, and cannot log on to RequisitePro. This group is maintained by the project manager for project history.

Dialog box: An interactive window displayed on the screen that solicits a response from the user.

Directory: A list of files and subdirectories. A directory is an organization of files (or folders) grouped for the user’s convenience. The topmost directory is called the root directory. The directories within a directory are called subdirectories.
Discussion: A RequisitePro feature that lets you address comments, issues, and questions to a group of discussion participants. Discussions can be associated with one or more specific requirements, or refer to the project in general. Discussions can take place in e-mail or within RequisitePro.

Discussion item: A discussion item is either the initial discussion topic or a response. A response can be either to the initial discussion text or to another response.

.doc: A DOS file name extension for Word documents. You cannot use the .doc file name extension as a file name extension for requirements document types.

Document: Any Word document, whether it is part of the project or outside the project. See also Requirements document.

Document-based requirement: A requirement that currently resides in a requirements document. The requirement may have been created in the document, or most recently moved to the document from the database or another requirements document.

Document properties: A specific item of information about a requirements document. Requirements documents have such attributes associated with them as author, date and time of last revision, file name, and so on.

Document type: A set of descriptive and operational information associated with a requirements document. The document type serves as a template for each requirements document created. The document type defines a requirement document’s properties and styles. All documents of the same document type share the same file extension (for example, .prd for a product requirement type).

Document version: A revision of the document, identified in the document properties revision history. A new version is created when a document is changed and saved. See Revision.

dot: A DOS file name extension for Word template files. You cannot use the .dot file name extension as a file name extension for requirements document types.

Drop-down menu: A list that appears below a menu bar or field when the user clicks the down arrow. The menu remains open without further action until the user closes it or chooses a menu item.

Entry-type attributes: Entry-type attributes are numeric, text, time, or date values that are keyed in by a user. See also Attribute types, Attribute values. Compare List-type attributes.
Exclusive access: A condition by which access to a project and its documents is available only to the user who opens the project. Exclusive access is required to change a variety of project characteristics. You can set the access when you open a project from the project catalog. See also Concurrency.

Expand/collapse indicator: A small box displayed in one of the following locations: next to a requirement in a view, indicating that the requirement has one or more child requirements; or next to a discussion item in the Discussions dialog box, indicating that the discussion item has responses. The box contains a + or a -, indicating whether or not the requirement or discussion is displayed in an expanded or collapsed state.

Extension: See File name extension.

External project: A project containing requirements used to establish traceability relationships with requirements in a currently open project.

External requirement: A requirement residing in an external project. You can create traceability relationships between requirements in different projects.

External traceability: An established traceability relationship between requirements in different projects. See also Traceability.

File name extension: A Windows file name extension (for example, .prd). File name extensions are used in RequisitePro to indicate document type. If long file names are supported by your system, RequisitePro allows a maximum of 64 characters for the file name extension.

Filtering: A process by which you can change the amount of information displayed in a view in the Views Workplace. For example, instead of displaying all requirements, you might apply a filter such that only requirements having a high priority are displayed. See also Sorting, Queried view.

Graphic: Electronic line art or bitmapped artwork. You can use graphic formats such as Enhanced Metafile (.emf), Joint Photographic Experts Group (.jpg), Portable Network Graphics (.png), Windows Bitmap (.bmp, .rle, .dib), and Windows Metafile (.wmf) in your RequisitePro requirements documents.

Group: A list of users, defined in security, and organized by the operations they have privileges to perform. For example, members of the Administrators group can create group accounts and add users to groups.

Hidden text: A Word feature used to hide text within a document. Hidden text is delineated with a dotted underline. In RequisitePro, a requirement within a document begins with a requirement tag formatted in hidden text style. You can hide the tags for improved readability.
**Hierarchical level**: The level of a requirement in a hierarchical relationship. Parent requirements are upper level, more general requirements. Child requirements are lower-level, more specific requirements.

**Hierarchical relationship**: A parent-child relationship between two requirements of the same requirement type. Use hierarchical relationships to subdivide a general requirement into more explicit requirements. Parent requirements are upper level, more general requirements; child requirements are lower-level, more specific requirements. Each child requirement can only have one parent, but a requirement can be both a parent and a child.

**Hierarchical requirement**: A requirement that participates in a hierarchical relationship with other requirements of the same requirement type. The requirement can be either a parent, a child, or a parent and a child.

**Hierarchy**: A type of organization that decomposes into more specific units, each of which is “owned” by the higher-level unit immediately above it. See also **Hierarchical level**, **Hierarchical relationship**, **Hierarchical requirement**.

**Icon**: A graphical representation of a RequisitePro command or process. Most RequisitePro icons are on the toolbars in the Tool Palette and Views Workplace.

**IEEE** ("I triple E") Institute of Electronics and Electrical Engineers, the hardware and software standards body, sets standards for such measurable items as acceptability criteria, performance benchmarks, and configuration management.

**ISO 9000** ("eye-so") International Organization for Standardization’s set of industry specific standards. The ISO works to establish global standards for communications and information exchange. The ISO 9000 standards are a set of documents that can be used for quality assurance purposes.

**Keyword**: Words that are used to help specify and define requirements. Many organizations use words such as “shall,” “must,” or “will” in their requirements, making it easier to separate a requirement from surrounding text in the document. Keywords are a part of the definition of a requirement type. You enter keywords in the Requirement Must Contain field in the Requirement Type dialog box. See also **Requirement type**.

**Label**: A string of up to 20 characters used to attach user-defined information to a document’s revision history, as well as projects and requirements. Use it for any information that has meaning to you or your organization. A label is created on the Revision tab when a document is first created and cannot be edited later.
Leaf tag: The last number in a requirement’s tag number. For example, the leaf tag number for Requirement PRD201.7.9 is 9. See also Root tag.

Licensed user: A RequisitePro user. Each user that is associated with a license of RequisitePro is a licensed RequisitePro user. See also User.

List-type attributes: Attribute values selected from a predefined drop-down list in an Attribute Matrix or Requirement dialog box. See also Attribute types, Attribute values. Compare Entry-type attributes.

Matrix: An arrangement of rows and columns used for organizing related items in the Views Workplace. See Attribute matrix, Traceability matrix.

MDI: Multiple Document Interface. MDI is a Windows presentation style that allows one window to physically contain and manage the display of several other windows. This is the style of presentation used by the RequisitePro Word Workplace and Views Workplace.

Menu: A list of options from which a user can make a selection in order to perform a desired action. In RequisitePro, menus are available from the menu bar found above the buttons on the Tool Palette and in a View window.

Menu file: A text file you can create with any text editor to add menu options to any RequisitePro Tool Palette menu. The key words and menu actions appear on the RequisitePro menu in the order in which you specify them.

Multiple value list: An attribute type that supports one-to-many associations. Used to assign a requirement more than one value for a specific attribute.

Offline author: A user who takes a document offline.

Offline authoring: A RequisitePro 4.0 feature that lets users read and modify a requirements document in Microsoft Word outside of RequisitePro (i.e., offline). When you take a document offline, RequisitePro creates a copy of the document in the directory you specify. The original is still stored in RequisitePro, but it is changed to a read-only document. Other users can view the document in RequisitePro, but they cannot edit it until you bring it back online.

OLE: Object linking and embedding. An object can be created in one application, such as an image file created in a paint program, and then linked to a RequisitePro requirements document. If the OLE object is modified in its original application, the changes are automatically reflected in any files linked to it.

Open project: See Current project.
**Outline**: A reference document or template used to create requirements documents in RequisitePro (using Microsoft Word). An outline can include formats, page layout information, attributes, attribute definitions and system defaults. An outline is useful for maintaining consistency across documents of the same type. See also Template, Document type.

**Parent requirement**: A requirement that participates in a hierarchical relationship with one or more child requirements. A parent can reside at the root level, or it can be nested in the hierarchy with a parent of its own. In all cases parents reside above their children in the hierarchy. Parent requirements are commonly upper level, more general requirements, while child requirements are lower-level, more specific requirements. See also Child requirement, Hierarchy.

**Parse**: To break information into component parts so that a program can act upon it. Used by the Import Wizard to separate requirements in a document.

**Peer requirement**: A requirement that is at the same hierarchical level as another requirement. For example, two requirements are peer requirements when they are children of the same parent. In addition, all requirements at the root level are peer requirements of one another.

**Pending tag number**: A tag number for a newly created requirement in a document that has not yet been committed to the database. The requirement maintains the pending tag number until the requirements document is saved. See also Requirement tag.

**Permissions**: The RequisitePro privileges granted to a group of RequisitePro users. If you are a RequisitePro administrator or a member of a group with project security permissions, you can assign permissions to groups. Also referred to as privileges or rights. See also Security.

**Project**: A requirements database and its related documents.

**Project catalog**: An individual user’s list of project files. See Catalog.

**Project database**: RequisitePro’s requirements database, where all the requirements for a project are stored. Each RequisitePro project has its own database. In the project database, requirements can be added, modified, or deleted. When requirements are changed in a document, the changes are updated in the database. See also Database.
**Project directory**: A unique directory that contains related information for a particular project. (Requirement documents for the project may be stored in another directory.) The project directory is defined when a new project is created. The project directory is not used for RequisiteEnterprise projects that use an Oracle or SQL Server database. See also *Directory*.

**Project prefix**: An eight character prefix identifier of an external requirement that is appended to the tag and displayed in the current project when creating cross-project traceability.

**Project properties**: The characteristics that make up a project, such as document types, requirement types, requirement attributes, the date a project was created, the user who created it, and the file location where the project is stored.

**Project summary report**: A report that displays a project’s entire structure, including requirement types and their attributes (with multiple value lists as appropriate), document types, and document details.

**PVCS Version Manager**: A version control product by Intersolv. Use with RequistitePro’s Archive command to store backup copies of projects. Alternately, projects can be archived using Microsoft Visual SourceSafe, Rational ClearCase, or RequisitePro’s Archive command.

**Queried view**: Any view to which a filter or a sort (i.e., a *query*) has been applied. See also *Filtering, Sorting, View*.

**Query**: A method for filter and sorting requirements in views by limiting the values of one or more attributes or by limiting traceability, and specifying the order in which the filtered requirements display. For example, you might create a query such that only requirements having a high or medium priority are displayed. Within that filter, you might sort requirements first by priority, and then by cost.

**Rational ClearCase**: A version control product by Rational. Use with RequistitePro’s Archive command to store backup copies of projects. Alternately, projects can be archived using Microsoft Visual SourceSafe, Intersolv PVCS Version Manager, or RequisitePro’s Archive command.

**Read-only access**: An option by which a project or document is restricted to viewing only, and cannot be modified by viewers.

**Renumbering**: The process of assigning new numbers to requirements. The renumber feature is useful for eliminating “holes” in a numbering scheme, which can result when requirements are deleted.
**RequisitePro Terms**

**Reparenting:** The act of assigning a new parent to a child requirement participating in a hierarchical relationship. When a requirement is reparented, its entire subtree is also moved to the new parent. Reparented requirements are renumbered as if they were newly created for the new parent. See also *Child requirement, Parent requirement, Hierarchy.*

**Repository:** A collection of data. See *Database.*

**Requirement:** A condition or capability to which the system being built must conform.

**Requirement attribute:** A descriptive field of information associated with a requirement. RequisitePro requirement attributes are either system attributes (defined by RequisitePro) or user-defined (defined by the project owner). See *Attribute.*

**Requirement attribute label:** The name of the requirement attribute, such as risk, priority, or author. See *Attribute label.*

**Requirement attribute matrix:** See *Attribute matrix.*

**Requirement attribute type:** See *Attribute type.*

**Requirement attribute value:** See *Attribute value.*

**Requirement location:** The location where a requirement was created or the location to which it was last moved. The location can be either a specific requirements document or the project database.

**Requirement tag:** The unique identifier of each requirement in a project. A requirement tag is composed of a tag prefix and a unique value, such as PR100.1.2. The tag prefix is always the requirement type, as defined in Project Properties. The numerical value is generated by RequisitePro. The tag prefix can contain a maximum of 20 characters. See also *Leaf tag, Root tag, Pending tag number.*

**Requirement type:** A set of descriptive and operational information associated with a requirement when the requirement is created. A requirement type serves as a template for all requirements of the same type and is useful for classifying and grouping similar requirements in a project. Each requirement type can its own set of user-defined attributes. See also *Requirement attribute.*

**Requirement version:** A requirements attribute that shows the version of the requirement. As a requirement evolves, it is helpful to identify the version numbers (and history) of requirements changes.
Requirements document: A document created in Word or RequisitePro that captures requirements and is used to communicate product development efforts. Each requirements document addresses a particular requirement type. A requirements document differs from a Word document in that you can access requirement attributes and other information directly from within the requirements document. Also referred to as a document or a RequisitePro document.

Requirements management: A systematic approach to eliciting, organizing, documenting, and managing the changing requirements of a software application.

RequisitePro document: A Word document that is part of a RequisitePro project. Most Word functionality is available within RequisitePro documents.

Response: An answer to a discussion item. You can respond to the initial discussion topic or to other, previous responses. In RequisitePro, the terms “response” and “discussion response” are used interchangeably.

Revision: A distinct version of a project, document, or requirement. A revision is identified by a unique internal revision number, generated by RequisitePro.

Revision number: The number identifying a revision. Revision numbers are automatically incremented each time a user changes and saves a project, document, or requirement.

Root requirement: A requirement that resides at the top level of a requirements hierarchy. A root requirement cannot have a parent requirement.

.rqs file: A text file that stores RequisitePro project-specific information and points to the project database.

Security: Prevention of system use, potential harm, or data loss by unauthorized individuals. In RequisitePro, users are given specific privileges or rights that determine the amount or kind of access they have within a project. See also Permissions.

Sorting: The process of establishing a specific order for the information in a RequisitePro View. You can sort requirements using one or many requirement attributes. For example, you might sort requirements first by priority (high, medium, or low). Then, within priority, you might sub-sort by unique ID number. See also Filtering, Queried view.

Suspect relationship: A state applied to a traceability or hierarchical relationship when one of the requirements is changed. A suspect relationship indicates that, because of the modification to the requirement, the relationship...
may need modification as well. A relationship between requirements becomes questionable, or suspect, if any of the requirements are modified. See also Change-managed relationship, Traceability matrix.

**Tag**: The unique identifier for each requirement in a project. See Requirement tag.

**Tag prefix**: The prefix for a requirement type. The prefix can be up to 20 characters. A tag is a unique identifier assigned to each requirement you create. The tag prefix is defined as a part of the requirement type.

**Template**: A reference file used to create new Word documents. A template can include formats, page layout information, attributes, and attribute definition. See also Word template, Outline.

**Tip revision**: The most recent version of an archived project, or, if the project is open, the current version.

**Tool Palette**: The main interface for accessing and working with RequisitePro projects. A menu bar and buttons on the Tool Palette provide access to project information, requirements information, and views. See also Menu.

**Trace to/trace from relationship**: A bidirectional dependency relationship between two requirements. The trace to/trace from state is displayed in a traceability matrix or traceability tree when you create a relationship between two requirements. There can only be one traceability relationship between any two requirements.

The difference between calling the relationship trace to and trace from is perspective. For example, if you created a traceability relationship in which a test requirement (B) is traced from a software requirement (A), both of the statements below are true: A is traced to B, and B is traced from A.

**Traceability**: A link or definable relationship between two requirements.

**Traceability matrix**: A view that displays the interrelationships between requirements of the same or different types. This matrix can be used to create, modify, and delete traceability relationships and suspect relationships. See also View.

**Traceability relationship**: See Trace to/trace from relationship.

**Traceability tree**: A view that displays all internal and external requirements traced to or from a requirement (depending on the direction of the tree). Also referred to as a Tree view. See also View.

**Tree view**: See Traceability tree.

**Type**: See Requirement type.
RequisitePro Terms

Use case: A sequence of transactions that a system performs, yielding an observable result of value (a work output) to someone or something outside the system that interacts with the system.

User information: A RequisitePro user’s user name, password, and e-mail address. If you are a member of a group with project security permissions, you can edit another user’s information. In addition, a user can edit his or her own user information.

Users group: A security group that can, by default, read documents and requirements, create views, and participate in discussions. Administrators can modify Users group permissions.

Version information: Unique, identifying information associated with a project, document, or requirement each time it is modified. The internally generated revision number, combined with information about the author, date, time, and reason for modification, constitute version information. See also Revision.

View: A window in the Views Workplace that displays requirements, the attributes assigned to requirements, and the relationships between requirements. See also Attribute matrix, Traceability matrix, Traceability tree.

Views Workplace: An area in RequisitePro where you analyze and print requirements information. The workplace displays and manages three types of views: Attribute Matrix, Traceability Matrix, and Traceability Tree.

Visual SourceSafe: A version control product by Microsoft. Use with RequisitePro’s Archive command to store backup copies of projects. Alternately, projects can be archived using Intersolv PVCS Version Manager, Rational ClearCase, or RequisitePro’s Archive command.

Wildcard character: A keyboard character that can be used in a query to represent one or many characters. For example, the asterisk (*) represents one or more characters. For example, the file specification *.txt uses the asterisk wildcard to mean “any combination of file name and extension.”

Word: Microsoft Word, the word processor used to specify and manage requirements and requirements specifications in RequisitePro.

Word document: A document created in Microsoft Word or RequisitePro that is saved in Word format. See also RequisitePro document.

Word Template: A reference document (.dot) used to create new Word documents. Also referred to as an outline. A template can include formats, styles, page layout information, etc.
**Word Workplace:** A Microsoft Word window within RequisitePro where you view, create, and modify requirements documents. RequisitePro uses the Word functionality to provide powerful features for viewing, editing, and formatting documents. You can open several documents at a time, apply character styles, and insert objects into your documents. The Word Workplace includes a RequisitePro menu for managing RequisitePro requirements and documents from within Word. Also referred to as *Word window.*
Index

A
access
  exclusive 3-6, 14-1
  read-only 14-1
  user 14-1
adding
  discussions 6-4
  document types 15-1
  projects
    to ClearCase 14-8
    to PVCS Version Manager 14-10
    to the catalog 3-3
    to Visual SourceSafe 14-14
  requirement attributes 15-6
  requirement types 15-4
  users to a security group 13-4
adjusting
  column width in views 4-17
  row height in views 4-16
administrators group 13-2
alphabetizing
  discussions 6-14
annotating change 8-11
answering
  discussions 6-8
archive command 14-7
archiving
  projects 14-6
    using ClearCase 14-8
    using PVCS Version Manager 14-10
    using the archive command 14-7
    using Visual SourceSafe 14-14
arranging
  icons 4-19
  views 4-18
assigning
  attribute permissions 13-10
  attribute value permissions 13-12
document type permissions 13-8
  group permissions 13-6
  new parents to a single requirement 9-3
  new parents to multiple requirements 9-6
  new parents to requirements 9-3
  requirement type permissions 13-9
associating
  requirements with new types 8-13
attribute matrix 2-5, 4-4, 5-2
  attribute labels 4-5
  definition 2-5, 4-1
  displaying properties 4-20
  graphics and OLE objects 4-5
  keyboard shortcuts A-4
  modifying attribute values in 8-12
  mouse actions A-3
  querying in the 5-2
  requirements 4-4
  text panes 4-5
attribute pane 4-8
attribute values
  modifying 8-12
attributes tab
  project dialog box 15-6
  requirement dialog box 8-12
attributes, see requirement attributes
auto suspect mode 9-8, 10-8

B
backups
  creating using the archive command 14-7
  creating using Visual SourceSafe 14-14
  storing 14-6
bookmarks 11-4
building queries 5-3
C

cascade view 4-18

catalog 2-3, 3-3
  adding projects 3-3
  removing projects 3-4

c change affects suspect (option) 15-9

c change description dialog box 8-11

c change history 1-12

c change management 2-2

c change-managed relationships 2-9, 2-10

c changing, see modifying

c checking
  whether a document is offline 7-10

c checking in projects
  ClearCase 14-8
  PVCS Version Manager 14-11
  Visual SourceSafe 14-15

c checking out projects
  ClearCase 14-9
  PVCS Version Manager 14-11
  Visual SourceSafe 14-16

c child requirements 9-1

ClearCase
  adding projects to 14-8
  archiving projects using 14-8
  canceling modifications made to checked-out projects 14-9
  checking projects into 14-8
  checking projects out of 14-9
  setting configurations for using 14-8
  undoing checked-out projects 14-9
  viewing non-tip revisions in 14-10

c clearing
  suspect relationships 9-9
  suspect traceability 10-8

ClearCase
  cloner projects 12-9

c closing
  discussions 6-20
  documents 3-8, 7-5
  non-project documents 7-8
  projects 3-8
  RequisitePro 3-2
  views 4-12

collapse all 4-10

collapsing 4-10

c column width in views 4-17

configuring
  ClearCase 14-8
  configuring RequisitePro B-1

c connecting projects for cross-project traceability 15-14

controlling user access 14-1

c conventions (in RequisitePro)
  file extensions xv
  typographical xv

converting earlier versions of projects 12-10

copying requirements 8-15

c creating
  backups using the archive command 14-7
  cascade view 4-18
  discussions 6-4
  discussions within the requirement dialog box 6-19
  document types 15-1
  documents 7-1
  menu files B-4
  MS Project tasks from requirements 16-4
  multiple requirements in a document 8-4
  outlines 14-3
  secondary directory 14-3
  projects 12-1
    with a blank database 12-1
    with a template 12-9
    with project wizard 12-4
  queries 5-3
  requirement attributes 15-6
  requirement information in a discussion 6-17
  requirement types 15-4

requirements
  in a database 8-7
  in a document 8-2
  in offline documents 7-10
  using fast create 8-3

security groups 13-3

tile view 4-19
Index

traceability
  in attribute matrix 10-3
  in requirements document 10-2
  in traceability matrix 10-5
  in traceability tree 10-6
  in views workplace 10-3
  in Word workplace 10-1
views 4-9
cross-functional teams 1-9
cross-project traceability 15-12
  connecting projects 15-14
  disconnecting projects 15-16
  displaying 5-9
  displaying in exported views 5-10
  marking requirement types 15-12
  overview 15-12
  results 5-8
  reviewing project 5-8
views 5-9
CSV files 11-14
  copying header 11-16
  defining header 11-15
  exporting views as 11-25
  importing 11-17
customizing
  menus B-3
  RequisitePro B-1
  tool palette menus B-3
  views 4-16
cutting requirements 8-15

D
data types for requirement attributes 15-8
database 2-3, 12-2
  copying requirements in 8-16
  cutting requirements in 8-16
  searching 5-6
default view properties 4-21
deleted users group 13-2
deleting, see also removing
discussions 6-20
  hierarchical requirements 9-7
  queries 5-5
  requirements 8-18
    in offline documents 7-11
  security groups 13-4
  users from a security group 13-5
views 4-15
dialog box shortcuts A-1
directories
  outlines 14-3
  setting for ClearCase 14-8
disabling security 13-2
disconnecting projects from external traceability 15-16
discussion groups 6-1
discussion items 6-1
discussions 6-1
  attributes 6-14
  closing 6-20
  configuring e-mail for 6-2
  creating 6-4
  creating requirement information for 6-17
  deleting 6-20
  displaying 6-11
  filtering 6-12
  icon 6-1, 6-6
  locating 6-11
  modifying 6-14
  modifying requirement information in 6-17
  notifying participants about 6-6
  participants 6-1
  participants information 6-15
  printing 6-14
  properties 6-6
  reading 6-7
  responding to 6-1, 6-8
    in RequisitePro 6-8
    using e-mail 6-9
  setting up projects for 6-2
  sorting 6-14
  viewing 6-1, 6-7, 6-12, 6-14
discussions tab 6-19
displaying, see also viewing
  cross-project traceability 5-9
Index

- discussions 6-11
- suspect relationships 9-8
- suspect traceability 10-8
- view properties 4-20
- document types 2-7
  - adding 15-1
  - compared to requirement types 2-7
  - creating 15-1
  - definition 2-7, 15-1
  - editing 15-3
  - permissions 13-8
  - removing 15-3
- document types tab 15-1, 15-2
- documents 7-1
  - changing location 7-6, 7-8
  - closing 3-8, 7-5
  - closing Microsoft Word 7-8
  - closing non-project documents 7-8
  - creating 7-1
  - definition 2-6
  - importing from Microsoft Word 11-6
  - locking 14-2
  - Microsoft Word 7-7, 7-8
  - modifying information 7-7
  - offline 7-8, 7-9
  - opening 3-4, 7-3
  - protecting for revisions 14-2
  - reviewing changes 7-5
  - saving 7-2, 7-5
  - searching 5-7
  - taking offline 7-9
  - unlocking 14-2
- documents tab 15-1
- duplicating views 4-13

E
- editing
  - attribute values 15-10
  - document types 15-3
- e-mail
  - changing 3-9
  - configuring for discussions 6-2
  - entering addresses in project security 6-2
  - modifying 3-9
  - notifying participants about discussions 6-6
  - Rational e-mail reader 6-3
  - responding to discussions using 6-9
  - enabling security 13-2, 14-1
  - ending
    - discussions 6-20
    - Excel 11-1, 11-14, 11-26
    - exclusive access 3-6, 14-1
    - exiting, see also closing
      - RequisitePro 3-2
    - expanding 4-10
    - exporting 11-25
      - cross-project traceability 5-10
      - requirements as Word document 11-26

F
- file extensions xv
- filtering
  - discussions 6-12
  - requirements 5-2
  - filtering and sorting 5-1
  - see also querying, queries
- find requirement command 5-7
- finding
  - discussions in projects 6-11

G
- general tab
  - project dialog box 15-12
  - requirement dialog box 8-2
- go to 5-6
- go to command 5-8

H
- hidden text 8-1
- hierarchical relationships 2-9, 4-3, 9-1
  - creating child requirements 9-1
  - in documents 9-2
Index

in the database 9-1
creating peer requirements 9-3
deleting 9-7
parent requirements 9-3
suspect relationships 9-8

I
icons, arranging 4-19
import logs 11-2
import wizard
  using to export requirements 11-25
  exporting as Word document 11-26
  exporting CSV files 11-25
  using to import CSV files 11-17
  using to import Word files 11-5
importing
  converting documents to Word 11-3
  converting individual documents to Word 11-4
CSV files 11-14, 11-17
  copying CSV file header 11-16
  define new requirements option 11-21
  defining CSV file header 11-15
  preparing files 11-15
  requirement numbers 11-14
  update attributes of existing requirements option 11-23
  from another RequisitePro project 11-2
log file 11-2
Microsoft Word documents and requirements 11-5
  document only option 11-13
  requirements and document option 11-8
  requirements only import option 11-12
  saving and removing bookmarks 11-4

K
key words 8-4
keyboard shortcuts A-1

L
locating, see also finding
locking project documents 14-2
log file 11-2
logging into RequisitePro 3-8
logging into Visual SourceSafe 14-14

M
macros
  enabling when taking documents offline 7-10
managing
  change 2-2
  Microsoft Word documents 7-8
  projects 14-1
master documents 7-15
menu shortcuts A-1
menus
  creating menu files B-4
  customizing B-3
Microsoft Access 11-1, 11-14, 11-26, 12-2
Microsoft Project 16-1
Microsoft Word
  closing 7-8
  converting all documents when importing 11-3
  converting individual documents when importing 11-4
  exporting a view as 11-26
  master documents 7-15
  using to modify offline documents 7-10
  working with documents 7-7
modifying
  attribute values 8-12
    in an attribute matrix 8-12
  discussion attributes 6-14
  discussion participants 6-15
  discussion properties 6-6
  discussions within the requirement dialog box 6-19
  document information 7-7
  e-mail 3-9
Index

location of documents 7-6
offline documents 7-10
parent requirements 9-3
passwords 3-8
project information 15-1
queries 5-5
requirement information in a discussion 6-17
requirements 8-11
user name 3-8
mouse actions A-1
moving
documents 7-6
requirements 8-15, 8-17
users to another security group 13-6
MS Project Integration Wizard 16-1
MSPT 16-2
multi-dimensional attributes 1-11

N
navigating
in the attribute matrix A-4
in the traceability matrix A-8
in the traceability tree A-12
non-tip revisions
in ClearCase 14-10
in PVCS Version Manager 14-12
in Visual SourceSafe 14-16

O
offline authoring 7-8
bringing documents back online 7-12
without saving offline changes 7-13
creating requirements in offline documents 7-10
deleting requirements in offline documents 7-11
determining whether a document is offline 7-10
enabling Word macros when using 7-10
modifying offline documents 7-10
obtaining information about offline documents 7-10
overview 7-8
reading offline documents 7-14
saving offline changes 7-12
taking documents offline 7-9
Word master documents 7-15
OLE objects 8-18
opening
documents 3-4, 7-3
projects 3-4
exclusive access 3-6, 14-1
views 4-12
options command 14-3
Oracle 11-1, 11-14, 11-26, 12-2, 12-3, 14-6
ordering
discussions 6-14
outlines 14-3
creating 14-3
creating secondary location 14-3

P
parent-child relationships 2-9, 4-3
see also hierarchical relationships 2-9
parsing, definition 11-9
participants
notifying about discussions 6-6
responding to discussions 6-8
passwords
changing 3-8
editing 13-5
limitations 13-4
modifying 3-8
new 13-4
peer requirements 9-3
permissions
attribute permissions 13-10
attribute values 13-12
document type 13-8
group 13-6
requirement type 13-9
printing
discussions 6-14
project summaries 14-5
reports 14-5
views 4-14

project components
  viewing in PVCS Version Manager 14-13
  viewing in Visual SourceSafe 14-17

project conversion wizard 12-10

project database 2-3

project dialog box 11-2
  attributes tab 15-6
  document types tab 15-1, 15-2
  documents tab 15-1
  general tab 15-12
  requirement types tab 15-4
  revision tab 12-3

project management 14-1

project managers xiv

project security
  adding users to a group 13-4
  administrators group 13-2
  assigning permissions 13-6
  creating groups 13-3
  deleted users group 13-2
  deleting groups 13-4
  deleting users from a group 13-5
  editing passwords 13-5
  editing user name 13-5
  enabling 14-1
  entering e-mail addresses 6-2
  groups and users 13-2
  moving users 13-6
  permissions 13-6
  users group 13-2

project summaries, printing 14-5

project version control 2-3

project wizard 12-4

projects 2-2
  adding
    to ClearCase 14-8
    to PVCS Version Manager 14-10
    to the catalog 3-3
    to Visual SourceSafe 14-14

archiving 14-6
checking into
  ClearCase 14-8
  PVCS Version Manager 14-11
  Visual SourceSafe 14-15
checking out of
  ClearCase 14-9
  PVCS Version Manager 14-11
  Visual SourceSafe 14-16
cloning 12-9
closing 3-8
components 14-13, 14-17
connecting for cross-project traceability 15-14
converting earlier versions 12-10
creating 12-1
  with a blank database 12-1
  with a template 12-9
  with project wizard 12-4
cross-project traceability 5-8
definition 2-2
deleting from Visual SourceSafe 14-17
disconnecting from external traceability 15-16
discussions 6-1
groups and users 13-2
integrating 16-1
locating discussions in 6-11
managing 14-1
modifying information 15-1
opening 3-4
removing
  from PVCS Version Manager 14-13
  from the catalog 3-4
  from Visual SourceSafe 14-17
removing revision information 14-18
revision information 12-3
security 13-1
setting up user access 14-1
storing backup copies 14-6
properties for views 4-20
protecting documents for revisions 14-2
PVCS Version Manager
Index

adding projects to 14-10
checking projects into 14-11
checking projects out of 14-11
removing projects 14-13
unlocking checked-out projects 14-13
updating projects 14-12
using to archive projects 14-10
viewing non-tip revisions in 14-12
viewing project components 14-13

Q
queried views 5-1
queries 4-5
building 5-3
creating 5-3
deleting 5-5
modifying 5-5
query now 4-2, 5-1
refresh all 4-2, 5-1
saved in views 4-10
traced to/traced from 5-2
query command 5-2
query now 4-2, 5-1
query, definition 5-1
querying 5-1
traced to/traced from 5-2

R
reading
discussions 6-7
offline documents 7-14
read-only access 14-1
read-only documents 7-14
rebuilding damaged tags 8-19
recommended reading 1-15
references 1-15
refresh all 4-2, 5-1
refresh command 5-2
removing, see also deleting
attribute values 15-11
bookmarks 11-4
document types 15-3
documents 14-19
projects
from PVCS Version Manager 14-13
from the catalog 3-4
from Visual SourceSafe 14-17
queries 5-5
requirement types 15-6
requirements 14-19
revision information for a project 14-18
renaming views 4-13
renumbering requirements 8-20, 14-4
replying
to discussions 6-8
requirement attributes 2-8
adding 15-6
creating 15-6
data types 15-8
editing values 15-10
modifying values 8-12
permissions 13-10
removing values 15-11
viewing in an attribute matrix 4-5
requirement dialog box
attributes tab 8-12
discussions tab 6-19
general tab 8-2
hierarchy tab 4-3
revision tab 8-10
traceability tab 10-1, 10-2
requirement numbers 11-14
requirement tags
rebuilding 8-19
viewing in an attribute matrix 4-4
requirement types 1-9, 2-8
adding 15-4
compared to document types 2-7
creating 15-4
definition 2-8, 15-4
marking for cross-project traceability 15-12
MSPT 16-2
new 8-13
overview 1-1
permissions 13-9
removing 15-6
requirements 2-2, 8-1
assigning new parents 9-3
to a single requirement 9-3
to multiple requirements 9-6
associating with new types 8-13
multiple requirements 8-14
single requirements 8-13
attribute values 8-2
can’t create 8-7
changing parents 9-3
color, refreshing 8-19
copying 8-15
from database 8-16
creating
child requirements 9-1
in a database 8-7
in a document 8-2
in offline documents 7-10
multiple 8-4
peer requirements 9-3
using fast create 8-3
cutting 8-15
from database 8-16
definition 1-2, 2-2, 8-1
deleting 8-18
in offline documents 7-11
description 8-2
discussion information 6-19
exporting 11-25, 11-26
fast create 8-3
filtering and sorting 5-1
find requirement command 5-7
go to 5-8
hidden text 8-1
hierarchical relationships 9-1
key words 8-4
locating discussions associated with 6-11
modifying information 8-11
moving 8-15, 8-17
numbering when imported 11-14
parent-child relationships 9-1
querying 5-1
rebuilding tags 8-19
recording changes 8-11
refreshing color and style 8-19
renumbering 8-20, 14-4
revising 8-9
revision information 8-10
searching for 5-5
sorting 5-2
style, refreshing 8-19
suspect relationships 9-8, 10-8
text delimiters 8-4
traceability relationships 10-1
troubleshooting 8-7
unmarking 8-18
Word style 8-4
requirements authors xiv
requirements contributors xiv
requirements documents, see documents
requirements management 1-2, 1-3, 1-12
fundamentals 1-1
problems 1-4
skills 1-5-1-8
requirements menu 10-3
requirements only import option 11-12
requirements viewers xiv
RequisiteEnterprise 2-3, 12-2, 12-3, 14-6
RequisitePro format 11-2
resizing
tree pane 4-8
views 4-18
responding to discussions 6-8
using e-mail 6-9
using RequisitePro 6-8
reviewing
changes in a document 7-5
revising requirements 8-9
revision information 12-3
removing 14-18
revision tab
project dialog box 12-3
requirement dialog box 8-10
Index

revisions
  in ClearCase 14-8
  in PVCS Version Manager 14-11
  in Visual SourceSafe 14-14
  protect for revisions 14-2
row height in views 4-16

S
saving
  bookmarks 11-4
  documents 7-2, 7-5
  requirements document as Word file 7-7
  view properties 4-21
  views 4-10
searching
  active view 5-7
  database 5-6
  documents 5-7
  find requirement command 5-7
  for requirements 5-5
  go to command 5-6
  views 5-7
security 13-1
  disabling 13-2
  enabling 13-2
  groups and users 13-2
security groups
  adding users 13-4
  creating 13-3
  deleting 13-4
  deleting users 13-5
  moving users 13-6
selecting
  items in a traceability matrix A-7
  items in a traceability tree A-12
  items in an attribute matrix A-3
selecting multiple items A-1
setting up project security 14-1
shortcuts A-1
  dialog box A-1
  menu A-1
SoDA 14-5

sorting
  discussions 6-14
  requirements 5-2
  sorting and filtering 5-1
  see also querying, queries
SQL Server 11-1, 11-14, 11-26, 12-2, 12-3, 14-6
suspect relationships 2-11, 4-6, 4-8, 9-8, 10-8
  change affects suspect option 15-9
  clearing 9-9, 10-8
  displaying 9-8, 10-8

T
tags, rebuilding 8-19
terminating
  discussions 6-20
terms Glossary-1
text delimiters 8-4
text pane 4-8
tile view 4-19
tip revisions
  using with ClearCase 14-8
  viewing non-tip revisions
    in ClearCase 14-10
    in PVCS Version Manager 14-12
    in Visual SourceSafe 14-16
  viewing project components
    Visual SourceSafe 14-17
tool palette 2-4, 3-1
  customizing menus B-3
  discussions icon 6-1, 6-6
menus B-3
traceability 1-10, 2-10, 4-3, 10-1
  clearing suspect relationships 10-8
  creating
    in attribute matrix 10-3
    in requirements document 10-2
    in traceability matrix 10-5
    in traceability tree 10-6
    in views workplace 10-3
    in Word workplace 10-1
    using requirements menu 10-3
Index

cross-project 15-12
  direct and indirect 2-11
  in MS Project 16-6
  overview 10-1
  suspect relationships 10-8
traceability matrix 2-5, 4-5, 5-2
  cells 4-6
  definition 2-5, 4-1
  displaying properties 4-21
  keyboard shortcuts  A-8
  mouse actions  A-7
  querying in the 5-2
  text panes 4-6
traceability tab 10-2
traceability tree 2-5, 4-7, 5-3
  attribute pane 4-8
  definition 2-5, 4-1
  displaying properties 4-20
  keyboard shortcuts  A-12
  mouse actions  A-12
  querying in the 5-3
  text pane 4-8
traced from 4-5
traced to 4-5
traced to/traced from 2-10
tree pane 4-7
troubleshooting
  failed multiple select actions 10-7
  when creating requirements 8-7

U
undoing checked-out projects
  ClearCase 14-9
unlocking
  checked-out projects using PVCS Version Manager 14-13
  project documents 14-2
unmarking
  requirements 8-18
updating projects
  using PVCS Version Manager 14-12
user name
  changing 3-8
  editing 13-5
  modifying 3-8
  restrictions 13-4
users group 13-2

V
view properties
  displaying 4-20
  saving as default 4-21
viewing, see also displaying
  discussion attributes 6-14
  discussion participants 6-15
  discussion properties 6-6
  discussions 6-1, 6-7, 6-12, 6-14
  non-tip revisions
    in ClearCase 14-10
    in PVCS Version Manager 14-12
    in Visual SourceSafe 14-16
offline documents 7-14
project components
  PVCS Version Manager 14-13
  Visual SourceSafe 14-17
views 2-5, 4-1
  arranging 4-18
  arranging icons 4-19
  attribute matrix 2-5
  cascade 4-18
  closing 4-12
  collapse all 4-10
  column width 4-17
  creating 4-9
  cross-project traceability 5-9
  customizing 4-16
  definitions 4-1
  deleting 4-15
  displaying properties 4-20
  duplicating 4-13
  expand all 4-10
  exported 5-10
  exporting as Word document 11-26

Index-11
Index

navigating 4-2
opening 4-12
printing 4-14
properties command 4-20
query now 4-2
refresh all 4-2
renaming 4-13
resizing 4-18
row height 4-16
saving 4-10
searching 5-7
tile 4-19
traceability matrix 2-5
traceability tree 2-5
views workplace 2-5
Visual SourceSafe
  adding projects to 14-14
  archiving projects using 14-14
  checking projects into 14-15
  checking projects out of 14-16
  deleting projects in 14-17
  logging into 14-14
  viewing non-tip revisions in 14-16
  viewing project components in 14-17

W

wizards
  Import Wizard 11-1
  MS Project Integration Wizard 16-1
  Project Conversion Wizard 12-10
  Project Wizard 12-4
Word format 11-3
Word style 8-4
Word workplace 2-4
Word, see Microsoft Word

Index-12